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1. Getting Started
Book’em! has many capabilities that you may not discover on your own; this is one manual that you
should read from cover to cover. We have tried to make it concise and readable. Every effort has been made
to explain the critical distinctions that are essential to full and effective use of Book’em!’s power.
However, we know that you want to get started using the Program right away. We recommend that you
read the following sections before making any actual entries: "Installation" on page 10, "The Integrity of
your Data" on page 26, "In-Common Features" on page 77, and "Backups" on page 193. Especially
"Backups" on page 193.
Notes on this User Guide
This user guide, just like Book’em! was designed for both Windows and Macintosh computer platforms. Throughout
the next 200 or so pages you will see screen shots representing both platforms. The functionality in all screens is the
same, there are only slight visual differences between the two platforms.
Whenever possible, any differences that do exist between the platforms are explained. One example of this is the use
of key strokes in addition to mouse actions or other commands. In each circumstance we have tried to identify the
proper key stroke for each platform. These differences are represented by a “/” symbol. For example, to open the
Customers database from the Home screen you can type “Command/Control 2”. This means that Macintosh users
need to hold the Command key while tapping the #2 key. Windows users need to do the same, only using the Control
key. This format remains consistent throughout the user guide.
As a simple guideline for the platform equivalents are: Macintosh “Command” key = Windows “Control” key and the
Macintosh “Option” key = Windows “Alt.” key. Keyboard shortcuts are discussed in detail in "Keyboard Shortcuts" on
page 196.
All screen shots within this User Guide contain fictional data. All credit card/telephone numbers, names, addresses,
companies, financial data, etc. used have been created for the sole purpose of providing an example of features.

Basic Computer Skills
The more familiar you are with how your computer works, the easier it will be to learn Book’em! You should know
how to copy, name and move files. You should know how to select text, place the insertion point, and cut, copy and
paste. If you’re unfamiliar with menus, popup menus, clicking, double-clicking, open and save dialogs, etc., please
keep a good beginner’s manual handy in case you get confused.
A very significant factor in the speed at which the program runs is the amount of memory available. Our minimum
memory recommendations are as follows (keep in mind that in the case of memory, more is better):
Macintosh: MacOS 7.5.3 or later, 12 MB application memory.
Windows 95/98: Pentium 90 or greater. 32 MB RAM minimum. Windows NT: 64 MB RAM minimum.
Both Platforms: 13” (640x480) or larger color monitor.
Windows Note: It is important for Windows users to make two changes to the way folders and files are viewed on
their computers. With any folder open, select View from the menu and select Folder Options. On the General Tab
click Custom and then the Settings button, select Open Each folder in its own window, then click OK. Now click on
the View Tab, open the Hidden Files folder and select Show All Files. Now make sure that Hide file extensions for
known file types is NOT selected. Apply your changes and then close this window, you are ready to go!

Getting Started

Installation
Windows
If you have a CD-ROM, insert the CD-ROM into the drive. Close all other window programs.
Double-click the ‘My Computer’ icon on the desktop. All of your available drives are shown.

Double-click the icon of your CD-ROM drive.

Double-click on the appropriate folder (Single User or Client_Server) and double-click the installer.
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Installation
The Installer we’ll begin and you will arrive at the following screen

We recommend that you install into the default locations determined by the Installer.
Just click Next, and Book’em! will be installed on your computer. It will appear in the Start Menu, but we recommend
that you create a shortcut for Book’em!exe on your desktop and open it from there. If the Windows Taskbar is set to
“Autohide” you won’t lose that valuable screen real estate.
If you download a demo from the internet, simply double-click the.EXE file you downloaded.

Macintosh
Close any open programs. Insert the Book’em Installer CD-ROM, double-click on the Book’em! CD-ROM on your
desktop. Double-click on the appropriate folder (Single User or Client_Server) and double-click the installer.The
Installer will begin. Click install.
If you downloaded a copy off of the internet, just click on the installer icon to begin the installation.
Mac users must pay attention to the amount of memory allocated to Book’em! This is set at the bottom of the
Finder’s Get Info window. Highlight the icon for Book’em! and choose Get Info from the File menu. Check the
amount of memory available by choosing About this Macintosh from the Apple menu and noting the “Largest
Unused Block”.
Book’em needs at least 8mb (8000K) on a Power Macintosh. Also, you must leave at least 500K free for printing and
other System functions. If you don’t understand any of this, please call Outside Technology for support.
If your computer doesn’t have enough RAM, at least be consoled that you live in an era of relatively cheap memory.

4D Server Installation
If you have purchased 4D Server and will run Book’em! in a multi-user environment, you will need to have a
computer dedicated as a server. Please do not use the server as a workstation, as this would seriously degrade
performance and increase the likelihood of data-damaging crashes.
Choose a hard drive large enough to accommodate future datafile needs, drive speed is also important. Remove all
extensions and control panels that are not necessary.
The network type depends on the number of computers and the network traffic.
Install 4D Server and the complete Book’em! Folder on the server computer and place the 4D Server application in
the Book’em! Folder. Besides the Book’em! CD-ROM you also received a 4D Server CD-ROM from ACI US. Do
Book’em! User Guide 11
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not use the 4D Server disk! A correctly configured version of 4D Server and 4D Client is installed by the Book’em!
disk.
Macintosh: Allocate as much memory as possible to 4D Server, but be sure to leave at least 5000K available after
Server and the System have loaded.
Install 4D Client (from the Book’em! CD-ROM) on each of the client computers. The client machines should have
enough RAM to allocate between 8 and 18 mb to 4D Client and also run any other software that will have to run
concurrently. Book’em! does not need to be installed on the client computers.
Double-click 4D Server on the Server computer and select Book’em! from the open file dialog. You will need to enter
the 4D Server serial number from the yellow card the first time you start 4D Server. The first time it is opened, and
after program upgrades, the datafile will need to be selected from the Open Datafile Dialog, shown below.

Starting the Program
On Macintosh, just double-click Book’em! (or 4D Client). If you like, create an alias for the desktop or Apple Menu,
but don’t move the actual file out of the Book’em! folder.
On Windows, open Book’em! from the Programs section of the Start Menu. Or, create a shortcut on the desktop to
C:\Book’em!_3\Book’em!.exe (single user) or C:\Book’em!Server\Book’em.4DC (server) or
C:\Book’em!Client\4D_Client (client).With all versions and on all computers, the Book’em folder must remain
intact, don’t move anything out.
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The Demo Data

The Demo Data
Book’em! comes supplied with sample data for you to explore and experiment with before you start to enter
your real data.
Opening the Datafile
When you open Book’em! for the first time, or if you move it’s location (remember, moving any Book’em! files is
NOT recommended) on your hard drive, you may be asked to open a datafile

Select book’em!.4DD (Windows) or Book’em!.data (Macintosh) and click ‘Open.
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Log-In
To enter the database, select the user name within the Log-In screen, enter the password, and click OK.
The demo datafile has 2 sample users entered. Dave has no password. Just select and click OK, or double-click the
name. Administrator has the password “admin”. The administrator has some extra privileges, such as the ability to add
users, set system preferences, run a full data dump, rebuild indexes, etc. When you create your real datafile, you may
create the users you need.

Book’em! opens to the ‘Home screen,’ the Home Screen.

Trip types (“Master Events”) are shown to the left. When a Master is clicked, all upcoming occurrences of this
Master are shown in the center. When an event is selected the ‘New Reservation’ button is activated. When an event
is double-clicked the event record is opened in its own window.
One-time (non-recurring) events may be entered through the commands in the Events menu.
The detailed descriptions of all the functions found at the Home screen may be found throughout this User Guide,
particularly in "Window System" on page 36, and "Events and Reservations" starting on page 40.
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The Demo Data
A Quick Tutorial
To help you get started, let’s create a few trips and take a reservation.
Creating Weekly Schedules
Select ‘Create Weekly Schedules” from the Events menu.

Click the triangle to the right of the box marked ‘Choose Event Master’ and select River Trip.
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Now click the triangle to the right of the box marked ‘Choose Day(s)’ and select All Days.

The selected days appear in the window.
Now let’s suppose that you offer a special price on Wednesday River Trips. Instead of $175, you offer them at $150
and the start time is a little later. Select the Wednesday trip with the mouse and click the ‘Edit’ button.
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The Edit window opens.Use the TAB key to move from field to field.

TAB to Cost and enter 150.
TAB to Start Time and enter 11a and 3p for End Time. (See "Time Fields" on page 34 for tips on time entries).
Click the Save button.
Now enter the date range that you want to create trips for in the boxes at the bottom. See "Date Fields" on page 34
for info on entering dates.

After you TAB out of the End Date field the ‘Schedule’ button is activated. Click it. When the trips have been
created, click ‘Save.’
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When you return to the Home screen and select River Trip, you will see all occurrences listed.

There are several other methods for creating events. See "Schedule by Calendar" on page 44 and "One-Time Events"
on page 49. Events may also be added at the main Calendar by selecting the date and then selecting the trip from the
popup (see "The Calendar" on page 157).
Taking a Reservation
There are numerous ways to take a reservation, as described in Chapter 3, "Events and Reservations" starting on page
40. For this tutorial, select a trip at the Home screen and click the ‘New Reservation’ button. Enter the number of
people in the party.

Understanding the next window is very important to efficient program use.

If the OK button is clicked with “New” in the prompt, a new customer record will be created. If any letters are
entered, Book’em! will find all records in the Customers table that begin with the entry.
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The Demo Data
Thus, typing “John”

will find all whose last names begin with John:

There are only a few names in the demo data, but even with many thousand this search is fast and effective. Because
it is so important to avoid creating duplicate records for the same person, it is recommended that the search be done
unless you are absolutely certain that no record already exists. If the search is run and the person is not found, click the
Cancel button and you will return to the “Enter Name” prompt so that you may try another spelling or create a new
record.
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For the tutorial, let’s book Randy Johnson into our River Trip

The selected record opens so that any changes may be made. Click the ‘Confirm Reservation’ button and Book’em!
creates an invoice. The Customer record screen is described in detail on page 84.

If a tax rate is set in Preferences (File Menu at the Home screen) it will be calculated, but deselecting the Tax
checkbox here will remove it from this invoice. The invoice is described in detail on page 121.
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The Demo Data
Randy’s going to rent a wetsuit for this trip, so click the ‘New Item’ button.

Select Wetsuit Rental’ and click OK. The item is added to the invoice. Item sales may be anything: food, equipment,
lodging, etc. See page 118 for detailed information on the Equipment and Sale Items feature.
Randy has paid a deposit on the reservation. Click the ‘Payment’ button to enter it.

Enter 100 in the Payment field. The demo data is set to default to Check as payment type, but you may set the default
yourself in the Preferences screen (details on page 31). The Payment Date field may be changed to indicate the actual
date of payment. Payments are described in detail on several pages, see the index for specific entries.
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Click ‘Enter’ and the payment is reflected on the invoice.

Click the ‘Save’ button.
If more people than are accounted for are in the party (remember, the first prompt asked for the size of the party)
Book’em! will ask if you’d like to enter others.

Using the ‘Add Others’ dialog will create a new, separate invoice for that person. Another reservation could have been
added to Randy’s invoice by clicking the ‘New Reservation’ button on the invoice, or simply changing the ‘Qty’ field
on his reservation’s line to 2 (or whatever is needed) if you do not want to create records in the Customers table for the
other people. Checking “Carryover Last Address’ will copy information from the previous customer record to the next
entry.

Further Exploration
While you still have the demo data loaded, poke around a bit. Read parts of the User Guide and test some features
that are important to your business. Check out Receivables (look for the money that Randy Johnson owes you, but
remember it’s not past due unless it’s past the due date marked on the invoice) and Transactions (find the money he
paid).
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Starting a Real Datafile
When you’re through experimenting with the practice data, select ‘Create Real Datafile’ from the
Financial menu at the Home screen. All records will be deleted and you will be able to start using
Book’em! to run your business. Don’t attempt to keep your real data in the practice datafile.
Because the demo data needs to be current at whatever date a new user tries the program, if the records are
old all dates are updated. This will not be reversible.
Your Business’ Info
When you first open Book’em! using your new data file the Return Address window will open.

Book’em! will use this information to build headers and footers on your print layouts. Entries are automatically
capitalized, phone fields automatically format; use the TAB key on your keyboard to get from field to field.
Entering anything other than “USA”, “US”, “Canada” or nothing at all in the country field will remove the formatting
in the phone and zip code fields. This is designed to allow Book’em! to accommodate international addresses and
phone numbers.
The best format to use for a logo is EPS with a PICT header. EPS images without a PICT header cannot be pasted
into Book’em!. You may experiment with different graphic formats--but most often best results are obtained when a
professional graphic designer provides you with the graphics file. Simply cut and paste the graphic file into the logo
window. Often a 72 dpi graphic sized to approximately 6.5” x 6.5” pasted into the logo window works well. Book’em
will automatically scale the graphic to the appropriate size for your letterhead, etc.
Return address info may also be entered or modified later by selecting Edit Return Address from the File menu at the
Home screen.
In the next screen enter the sales tax rate for your state and county. You can specify (or leave at 0) a rate for rentals,
sale items or reservations.
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User Name
The previous dialogs should be seen only when starting the program for the first time. A similar screen to this log-in
screen, however, will need to be entered on every startup:

The Log In name is saved with reservations and payments as they are entered to help resolve questions that may arise
in the future. A password is optional for all users except administrators. If one user takes over for another in the
middle of a session without restarting the program, the name may be changed by selecting Change User Name from
the File menu at the Home screen. Use a password that will be easily remembered. Check Administrator if this
person should have some extra privileges, such as the ability to add users, set system preferences, run a full data dump,
rebuild indexes, etc.
See "The Calendar" starting on page 157, for information on the two Calendar formats.
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Administrative Functions
Under the File menu at the Home Screen is the “Administration” option. This option is only available for users set-up
as Administrators. It is within Administration that we can setup new users, change passwords for current users, and
change how the Calendar screen (see "The Calendar" on page 157 for Calender details) is viewed.

As you can see from the above picture, you are given the option of creating a new user, modifying a current entry, or
deleting a user entirely. To modify the administrative level of the user or change the way they view the Calendar,
highlight a user from the list and click “Modify”.

It is here that you can change the users log-in name, the password they use and indicate whether reservations and
events or appointments are emphasized. At first, try both settings and see which Calendar layout you prefer (see "The
Calendar" on page 157).
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For password administration select a name and then click on Password Setup.

Here you are able to require passwords for non-administrative users (Administrative level users are always required to
enter passwords), set the minimum length and choose how many incorrect password a user can enter before the
program automatically quits.

Book’em! Files
The Program requires several files to operate, among them a Structure File, called Book’em! (Macintosh) or
Book’em!.EXE (Windows), which contains all of the files, fields, layouts and programming necessary to manage your
data; and a Data File, called Book’em!.data on Macintosh and BKMDATA.4DD on Windows, which contains all of
the records you enter. Make aliases or shortcuts to the structure for the desktop, but keep all files in the same folder,
just as the Installer leaves them.
The Datafile is your data! It contains (or will contain) all of your business records. You must establish and maintain a
regular pattern of backups. Read the section "Backups" on page 193 for suggestions.
It is very dangerous to keep more than one datafile on the computer that runs Book’em! If there is confusion over which Data
File has been in use, loss of data could result. When you backup, make sure that the name has been changed in some way and
whenever possible save the backup on removable media (Zip, Jaz, CD-R, etc.).

The Integrity of your Data
Duplicate Records
Duplicate records cause more harm than a simple waste of disk space. Inaccuracies can occur in several areas. If the
same customer is entered twice, their trip and mailing histories will be fragmented. And you’ll waste money on
duplicated mailings. The best ways to avoid dupes is to:
• Spell accurately.
• Develop office routines that prevent such errors.
• Search the database before entering any new customer if there’s any chance they may have been
previously entered.
• Use the Find Duplicates button available on the customer entry screens.
• Reconcile dupes immediately if you notice any. Check both duplicate records for schedules,
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payments, etc., to be sure important data is not lost.
• Use the ‘Find Duplicates’ function from the File Menu at the Customers’ list. See “Find Duplicates” on
page 150.

Critical Entries
Try to get into the habit of making critical entries immediately. When reservations are taken, payments received,
address changes required, etc., do it now! If you fall behind it may be difficult to catch up.

Deletions
Book’em! relates many records to keep track of things. The information you see on a single screen may be drawn from
several related records.
When a record is deleted the connecting chain may be broken, and important pieces of information may be lost.
There are ‘Delete’ buttons available in many records, but it is recommended that they be used only when a record had
no business history.
Records in the Customers Table may be marked ‘No Mail,’ the Staff table allows a record to be marked ‘Inactive,’ and
Recurring Events may be tagged ‘Not Currently Offered.’ That is the recommended approach.
An event may not be deleted if any reservations exist for it. The Delete button will not operate until all reservations
have been cancelled or rescheduled.
You cannot delete a Customer record that has any financial history attached. Instead of deletion, use the No Mail
function (see page 83).
Whenever possible you should avoid deleting payments. Instead, enter an additional payment, refund, or charge to
reconcile erroneous payments. See "Payments" on page 58 for more information.

Setting Preferences
The Preferences Dialog, available from the File Menu at the Home screen, allows you to set the program
up so it best fills your needs. Nothing is actually saved until the ‘Save’ button is clicked. Clicking the cancel
button will cause all preferences to revert to the last saved version. Clicking either ‘Save’ or ‘Cancel’ will
exit the Preferences dialog.
It is important to note that different preferences will affect different levels of the program. For example,
many preferences are saved only for a particular user, others for a particular computer, and still others
affect all computers on a network. Within each preference description you will find an indication of the
scope of its effect.
Administrative and non-administrative users will have access to different Preferences screens. Below is a
visual example of the one non-administrative preferences screen. Details of specific functions are outlined
in the following sections, but the remainder of the screens shown represent the multiple screens for
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administrative users only.

General

• Beep on Alert. If this item is selected, Book’em! will play the currently selected system beep sound
when it needs to give you feedback or ask you a question.
• AutoSort is on at Startup. Check here to automatically sort records viewed following any database
searches.
• Efficient Memory Mode. See "Efficient Memory Mode" on page 39 for details.
• Minimize Record Locking. Checking here cause the program to not allow leaving one record open
and then going to another record. See"Locked Records" on page 39 for more information.
• Control-Click Windows menu. Check here to activate the Active Windows Menu by holding down the
control key while clicking the mouse button anywhere within the Book’em window (MacOS) or rightclicking (Windows).
• Sort Clients by Company. This gives you the option to sort customers by their company name
instead of last name. Searches will take significantly more time with this option on.
• Bring Past Undone Tasks Forward. Click here to bring all past undone appointments (in the
Calendar window) except ‘Meetings’ forward to the current day.
• Clarify List Selection. By turning this option on, you will enable a dialog box that will open when you
perform a function on any list screen. The dialog will ask to clarify the selection you wish it to act on.
• Table Reference. Click on this button to change how Customers, Event Leaders, and Destinations
are labeled within Book’em!.
• Date Print Formats. Click here to change the format in which the date prints for short dates, long
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dates and within the Header field (within the text editor for merging letters).
• Set Label Writer Driver. This will you to set a default label printer for single (one-at-a-time) labels.
• Show Calendar/Address Book/One-Time Events at Startup. Book’em! opens the Home screen
when it starts up. If you would like the Calendar, One-Time Events List and/or Address Book to also be
opened at program startup, check the appropriate box(es).
• Home Screen Picture. Choose between seven different cool photos to replace the pelican on the
Home screen. Or add your own custom graphic:
WINDOWS:
Acceptable formats are .jpg, .gif, .pct, .pic, .bmp, .wmf, or .emf.The file must be named MyPicture plus the extension,
i.e. MyPicture.bmp or MyPicture.jpg. For single-user, place the file in the C:\Book'em!_3 directory. For
client/server, place the file into the C:\Book'em! Client directory on each client computer.
MACINTOSH:
Acceptable formats are JPEG, PICT, GIF.The file must be named MyPicture and may include a valid extension, i.e.
MyPicture.pct or MyPicture.jpg. For single-user, place the file in the Book'em! folder. For client/server, place the file
into the 4D Client folder on each client computer.
GENERAL INFO:
The ideal size is width: 360 pixels, height: 302.The visible image area is the lower right area. (The total area is the
right 2/3 of the home screen, everything to the right of the recurring events list.)
Open File: Preferences and select Custom from the Home Picture popup menu.
• Interface. Choose Macintosh or Windows. You may switch the visual interface from a Macintosh Style
to Windows style or vice-versa regardless of the platform you use. This will affect tabbing capabilities as
Windows allow you to tab to buttons (as well as fields) and Macintosh does not.
• Double Click Speed. Click here to determine how quickly you have to double-click to open a
selection. Two seconds works best for most people.

Reservations

• Click on Recurring. When a recurring master is selected at the Home screen, all future occurrences
are shown. If this number is greater than zero, events from this number of days past are also shown.
They are marked ‘Past’ in the Available column to prevent confusion. This preference also affects what is
contained in the ‘Current’ selection in the One-Time Events List.
• Show Active Dates in Color. When this checked, dates on the Calendar pages with events or
appointments will be colored. All days without events or appointments will be white.
• Default Size of Party. When creating a new reservation, this is the default number in the first request.
Use the number that is most common in your business.
• Expect Others. This will cause an automatic dialog asking if you want to add others to the
reservation. It will continue to ask until you click cancel.
• Others in Party Default to Carryover Address. Frequently people reserving together will have the
same address. When taking a reservation for a party of 2 or more, a checkbox is available to copy over
information from the previous customer’s record to the next entry. Selecting this preference checks that
box by default.
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• Carryover Addresses Default to No Mail. If you generally choose to send only one copy of any
mailing to a household, any others added should be marked “No Mail.” If this preference is selected, any
additional members in a reserving party will be marked No Mail if the Carryover Address checkbox is
marked. If you carryover an address but end up changing it while entering, remember to deselect the No
Mail option.
• Check Status when Closing Event Window. If this preference is selected, Book’em! will check
reservations to see if there are enough designated payers when the Done button in an Event screen is
clicked. This check can be performed manually by clicking the “Verify” button in an Event window.
• AutoSpool Reservations. This selection will cause names and addresses of new reservations to be
sent to the Label Spool, unless they are marked No Mail. You may also choose how they are sorted.
• Rosters. Choose between keeping parties together or sorting by name (alphabetically) on printed
rosters. Also choose whether or not credit card numbers will be printed on the rosters.
• Set Policy Info. Click this button to enter the spiel that customers are to receive when making a
reservation. This might include your refund/cancellation policy, limit of liability, payment options, what to
bring, etc. The user may view this text while making a reservation, to ensure that nothing is forgotten.
During the reservations process the user may mark a checkbox to indicate that the customer has been
fully informed.

Invoices

• Set Invoice Date. Choose the default date you want listed on the Invoice as the Invoice Date. You can
always change this date within the invoice as well.
• Set Invoice Due Date. Choose the default due date for the invoice. Either the Invoice Date plus the
number of days you specify, or the event date plus the number of days you specify.
• Default Payment Type. Indicate the payment type you would like the payment screen to default to.
Choose check, Creditcard, Gift Certificate, or Cash.
• Zero-Dollar Items Printed on Invoice. Check here if you want items with no dollar value to print on
Invoice.
• Tax District Window. Edit, add, or delete your tax district values here. Highlight the item you wish to
change and click modify or delete. Once a district is open you will define a “home” district that will be the
default tax rate.
• Set Invoice Footer. Click this button to edit the message printed at the bottom of the Invoice. “Thanks
for your business! Please make checks payable to Outside Technology” would be an example.
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Payroll

Use the first option if your payroll period occurs every ‘x’ number of days. For example, if you do payroll every Friday,
enter 7.
If pay periods end on specific month days use the second option. You may enter from one to four month days. If a pay
period ends on the last day of the month enter 31. Entries of 29 or 30 are not allowed.
Please do not select either of these options without also entering the appropriate numbers.
The first time you run payroll you’ll be asked to enter the start date of the period. Book’em! will calculate the end date
based on your entry here. From then on, Book’em! will remember the appropriate dates and will know, when you
initiate payroll, whether a new period has been entered.
If you modify these preferences the initial start date will need to be reset when running the next payroll.
• Include in Pay Period of. If an event lasts only one day Book’em! will use that date to determine
which pay period to include it in. But if an event lasts more than one day, Book’em! needs to know
whether you use the first or last day of the event to determine the pay period. This needs to be set
before employees may be assigned to events. It may be overridden in individual cases, please see page
64 for details.
• Sort Payroll Report By. Use either the Staff Last Name (alphabetical) or the payroll number to sort.
• Show Payroll Amount. Check here to show the amount each employee will be paid for the event they
are scheduled to work. This information will show up on event rosters as well as within the event window.

Data Entry

• Automatic Capitalization. Keep this checked and all fields will be properly capitalized when the user
tabs out of them. Make all entries in lowercase characters only. Autocap will recognize such entries as
O’Brien, McDonald, d’Artignon, PO Box, etc., but ignore some, such as MacDonald, to avoid the
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possibility of formatting International MacHine Tool Co. Autocap may be defeated for an individual field
by holding down the Command/Control key while TABbing out of it.
• Default Area Code. Enter the telephone Area Code that most of your customers have and Book’em!
will add it every time a 7-digit number is entered in a phone field.
• Add Until Cancel. When choosing ‘New Record’ or Command/Control-N at a list screen, you may
choose to a) add one record and return to the list or continue adding new records until cancelling and b)
return to the list or the Home screen. If you want to use Rapid Entry Mode (see page 83), Add Until
Cancel should be selected

Networking
Book’em! is fully multi-user and is designed to be used in a network environment, but it requires 4D Server to be able
to run in this fashion.
Please inquire as to the availability and price of 4D Server. The single-user version cannot be accessed by more than
one computer at a time.
Every effort has been made to prevent the Data File from being opened by more than one user at a time because
serious damage to the data would result from such access.
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2. The Shape of the Program

Architecture
The Program consists of many TABLES. “Customers” is a Table. “Events” is a Table. “Staff ” is a Table.
Each Table may contain an unlimited number of RECORDS.
Each Record stores its information in FIELDS, discrete little chunks of data.
You enter and access all of this information through layouts or SCREENS.
Record Screens
Basics
A Record Screen is where you enter and view data for one item. This may be a customer, event, company, location,
etc.
Each individual piece of information for the record - First Name, Phone, Start Date, Category, etc. - is stored in a
separate field. This allows you to search for a particular criterion, say clients with a last event later than 1/1/99, or a
“built” set of criteria, like employees with a year-to-date payroll greater than $1,000 who live in San Francisco. It
allows you to sort the records any way you choose and to perform comparative analysis. It also allows Book’em! to
make connections between tables.
Move from field to field with the TAB key on your keyboard or by clicking in the appropriate field with your mouse.
If the field already has something in it and it is highlighted, typing anything will replace the old contents. Also, you
may enter a particular field by clicking in it with the mouse. If the insertion point is flashing within a text area, what
you type is inserted at that point. It is important to note that if you tab into a new field it will be highlighted and any
text you input will replace the previous text. If you click with the mouse into a new field and begin to enter text, it will
be added to the previous text (unless you highlight the entire field and delete its contents).
If a field in a record directly relates to another table the record must exist in the other table. For example, if the
Recurring Event Master’s location does not have a record yet you’ll be asked if you’d like to enter it. You may not
assign a location without having a record for it in the Locations table.
Save and Cancel
Every Record Screen contains a Save (or Done) button and a Cancel button. Both buttons will exit the layout.
If you want the information you entered to be saved permanently, click Save (or Done). Typing Enter on the keyboard
will save the screen as well.
If you hopelessly messed a record up, click the Cancel button or type Command/Control-”.”(period) to exit the
record and NOT save changes. If you were modifying an existing record it will revert to its state before you opened it.
If you were creating a new record it will not be saved at all.
Tab Order
Open a record screen and repeatedly hit the TAB key. If there’s nothing entered in the active field the insertion point
will flash in it. If there is something it will be highlighted. The path that’s followed while tabbing is the TAB Order.
Every record screen has its own TAB order.
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Date Fields
Book’em! uses a four digit year, U.S. date formatting, which is Month/Day/Year (i.e. 4/8/2000). Please be sure that
your computer is set to this format. It may be set in the ‘Date and Time’ Control Panel, accessed from the Apple
Menu (Macintosh), or ‘Date and Time’ accessed by going to the ‘Start Menu’ and then to ‘Settings, Control Panel,
Regional Settings’ (Windows).
To enter a date, TAB into the field. The field is highlighted. Type the number of the month, followed by a separator,
then the day, followed by a separator, then the year (four digits). The separator may be a slash (/), period, comma, or
other non-numeric character. Leading zeroes need not be entered.
To modify one part of an existing date, say to change 9/12/2000 to 9/18/2000, double-click the part to be modified
(be sure it is highlighted) and type in the new value.
Time Fields
You may enter 24 hour time, or 12 hour time, with a ‘p’ appended to afternoon times. Any separator may be used.
Thus, typing either 14,45 or 2.45p will enter 2:45 PM. Null times (no entry) are shown as 12:00 AM.

List Screens

List Screens
List screens are available for customers, staff, contacts, receivables, transactions, payroll, and the label
spool. Records displayed on a list screen may be selected, opened, and added or removed to create a new
selection. The selection you create within a list screen will determine the records (and therefore the
usefulness and accuracy) of your searches and reports.
Basics
When you first open them, list screens display the Current selection of records for the table you’re in.
The title bar of a list screen displays the number of records in the current selection and in the table. For example,
“Customers: 212 of 47255” in the title bar means we’re in the Customers table, there are 47,255 records for customers
in the database, and the current selection contains 212 records.
Selection Methods
The Current selection may be changed by a search or by direct selection.
For instructions on searching using the Search Editor, see page 139. Many tables also have popup menus in the footer
area of their List Screens. The Customers table has the most extensive set of search popups, and help with using them
may be found on page 91.
To select multiple records directly, hold down the Shift key and click for continuous selection, or Command/Control
to add individual records. Direct selection is indicated by the line turning black. Command/Control-A will select all
records. Command/Control-G will show all records if the selection is reduced.
Current Selection: When you first open to a list, you will see the Current selection. If this selection represents all of
the records you are requesting and want to search or report on, you are finished establishing your selection now.
Base Selection: If you need to fine tune your selection of records, or perform other searches but want to return to or
add records to your first selection, establish a Base selection. Using the methods above, establish the Current
selection. Select the Create Base Selection command from the Tools menu. Consider the base selection to be a bucket
of sorts in which you can now add, remove, search and report on records. If at any point you need to return to your
original base selection, choose Use Base Selection from the Tools menu. When you close the list screen your base
selection will be lost. If you think of the base selection as a bucket (the first contents of which are the records of the
first current selection when you Created the Base Selection), any selections you now create can be added or removed
from the bucket. Let’s use an example to clarify the concept of Base and Current selections.
Let’s imagine that you want to establish a list of all customers that found you via your web site (Source =Web Site)
and who are interested in bird watching tours (Interest = Bird Watching). From the Home Screen select Customers,
click the All button on the Quick Search Dialog. A list screen of all your customers appears. This is your Current
selection. On the middle footer popup, select Source. On the right footer popup select Web Site. A list of all
customers that found you via your web site appears. This is your new current selection. Choose Create Base Selection
from the Tools menu, this is now your Base selection.
Now that you have a Base selection, you can search or perform any of the described actions (see below) on these
records only. Now you can add to, remove or modify this Base selection. From the middle footer popup, choose
Interest, and from the right footer popup, choose Bird Watching. A new current selection list will appear, showing
customers that found you via your web site and that are interested in bird watching tours. This does not replace your
base selection, simply choose Use Base Selection from the Tool menu at any time to return to the list showing
customers that found you via the web site.
Add to Base Selection: Now we will add those customers interested in bird watching to our base selection of
customers that found us via the web site. Choose Add to Base Selection, now we have a list of all customers that
found you via the web site and those interested in bird watching. We have created a new base selection.
Remove from Base Selection: Let’s imagine you want a selection of customers that found you via your web site but
you want to exclude those interested in bird watching. Follow the above steps to create a base selection. Then choose
Bird Watching from the Interest popup. A selection of customer interested in bird watching appears. Choose Remove
from Base Selection from the Tools menu. Now a list showing all customers that found you via the web site except
those interested in bird watching will be listed. You have created a new base selection.
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Replace Base Selection: To create a new Base selection, simply choose Replace Base Selection from the Tools menu
with the records you wish to use listed in the Current Selection.
Many of the menu commands available at the List Screens allow you to perform an action or apply a value to multiple
records at once. Among these commands are Apply Keyword, Send Letter, Print, Search & Replace, Change Case,
Spool Labels, Export, Add to Mail List, etc. These commands will be applied to the entire current selection unless you
have made direct selection within the list. In that case the command is applied to only the direct selection. The exception
to this rule is Delete, which is only applied to direct selections.
If all of the records from the table are in the current selection, Book’em! will ask you to confirm the selection. This is
to prevent errors.
Some of the commands discussed above may take time to execute if there are many records in the current selection. A
progress thermometer will give you an idea of how long the operation will take. Once the thermometer appears you
may work in other parts of the program (see Navigation, below); Book’em! will continue the operation in the
background.
The Popup
“Built searches” look for records that fit a compound set of criteria. In the section "Searching" on page 137, you’ll
learn how to build your own.
The popup menu at the bottom of most list screens contains some useful pre-built searches and sorts. At the bottom
of the customers’ list, for example, there are three popups. The one in the center lists all of your event types and
determines what is in the popup on the right. From the left popup choose any of your listed mailings to see all of the
people who have received that mailing. See page 91 for detailed information on using these menus.
The Receivables list allows sorting by date, customer, or event. The Transactions table has a popup with prebuilt date
ranges.
Experiment with these popups; the more records you have the more useful they are.

Launchers and Dialogs
You’ll encounter many screens which are neither primary Record Screens nor List Screens. They may inform you or
ask you a question or allow you to make a selection. One will allow you to set up fields for import or export and others
will let you set up your own printed reports and labels. The Home Screen, the Calendar, the One-Time Events List,
and the Reservation Finder are Launchers. There are hundreds of Dialogs, including the Import/Export window, the
Address Book, the messaging system, Find Duplicates, the Search & Sort Editors, and others.

Window System
Many databases allow only one window open at a time. From the ‘jump screen’ you access different parts of the
program, returning to the jump screen to get someplace else. In some complicated programs it can take considerable
time to get from one area to another.
But this system is too cumbersome for the Event Organizing business. At any given time there will probably be
several events getting the most play. When the caller on the phone wants to reserve a seat, it is counterproductive to
have to save your work in, say, Receivables, exit to the jump screen, find the event the caller is interested in, and wait
for it to open.
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Navigation
Book’em! is designed to allow several events to remain open at once, along with other parts of the program. This
feature lets you keep open the events currently getting the most action, so you can get to them quickly when the
phone rings without disturbing other work you may be in the middle of.
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This screen capture shows 5 events open, plus the Address Book and the Calendar. To go directly to any open
window, select it from the floating Windows Menu.
Floating Windows Menu

Or, if you can see it, just click in any window to activate it.The selected window comes immediately to the front.
Floating Windows Menu

Each open window functions as its own mini-application, called a “Process”. When you create reservations, enter
payments, access the waiting list, or any other activity from within an event window, the activity remains within that
process. The customer list opens in it’s own process and all activity generated from it occurs within its window. Most
menu commands from the Home screen create a new process in its own window. The One-Time Events List, the
Reservation Finder, and the Calendar, are also used to launch new processes.
Event Windows
Unless you’re running in Memory Efficient Mode, event windows will tile downwards as you open them. (In Memory
Efficient Mode only one event window is open.) You may set the starting position by setting an event window where
you want it and choosing Set Window Position from the File menu.

Performance Issues
Every open window uses memory and takes up computer time. Having lots of windows open at once may tend to
slow the program down.
Most windows have a small box in the upper-left-hand corner called the ‘Close Box.’ By clicking the close box
(keyboard equivalent: Command/Control-W) the window is hidden from view and any processing is paused, but the
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information in the window stays in memory and can be opened instantly by selecting it from the floating Windows
menu. The data in the window will be just as you left it, with no drain on general speed.
Every item listed in the Windows menu represents an active process, hidden or not.
If you try to close the window of a record that is open for entry or modification, Book’em! will ask you to save or
cancel before the window can be closed. See Locked Records, below, for an explanation.
The first screen that appears when a new process is created is the root layout of the process. Clicking the Done button
on a root layout will cause the process to end, closing the window and removing it from the Windows menu. The
memory that the process was using is now free.
Therefore, the best strategy is to leave your frequently used windows active and hidden (Command/Control-W) and
to use the Done buttons on windows that you’re finished with and probably won’t need again. If you have a fast
computer with lots of memory these issues are less important.
Efficient Memory Mode
If you have limited memory on your computer (and are unwilling to add more) you might try to operate in ‘Memory
Efficient Mode’ and see if program performance is improved. This means that there is only one event window, and
each time an event is selected from a Launcher, the window will contain only the last selected event. The only other
difference is that the Reservation Finder (see page 67) will automatically close after a selection.
You may turn this mode on/off in Preferences (page 27) regardless of the amount of memory allocated.
Locked Records
There are several reasons why you should try to return to each window’s opening screen. First, it will be less
confusing. Second, it ensures that all records are properly saved.
But most importantly, it prevents record locking.
Like all databases, Book’em! cannot allow more than one user or window to modify the same record simultaneously. If
a record is open for modification by one window or user it cannot be modified by any other. This means actually open
for modification; simply being selected on a list will not lock a record. For example, if you open a customer’s record
through the Customers database and then try to reserve a seat for that customer through an event window, you’ll see
the following message:.

If you see this message, press Command/Control-Period to cancel, choose whatever process has the record locked
from the Windows menu, save or cancel the customer’s record, then return to the event and continue with the
reservation.
It is better to not leave records open for modification.
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3. Events and Reservations
Book’em! handles events through what may be considered a hierarchical template system. The system’s
goals are speed, flexibility, and logical organization.
Recurring Event Masters are the first level and are described by a name, a location or departure point, a
cost, a size (number of reservations), a duration, and start and end times.
Using the Recurring Master definition, individual events may be created simply by clicking a date on a
calendar. Any of the characteristics may then be modified, although the event will always be found
through the Master it was created by. If the Master is changed later it will not affect event records that
already exist. Likewise, as reservations are made for events, specific defaults carried over from the Master
may be changed for each customer.
You may also track one-time events, covered later in this chapter.

Recurring Event Masters
Book’em!’s ‘Home Screen’ is the Event Selector. It is the hub from which you may create and access recurring events
individual occurrences of events, and enter all other areas of the Program. When you open Book’em! for the first time
the Home screen is empty.

Click the Add Master button (Command/Control-E). Enter the basic info for an event. Use the TAB key to get from
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field to field. Name the event as you would like it to appear in printed material, reports, etc.

The following is brief overview of the edit event window. For more detailed instructions see page 104.
Location is where the event takes place, User days (page 107) are also calculated by Location. Departure is the
location where the event leaves from, this is the location that will be used for confirmation letters (see page 73 for
more information on letters), maps and directions (see "Locations" on page 109 for more info.). For example, the
Location for the event might be San Francisco, the Departure Location would be Lombard St. (the starting place for
the event).
If the size, cost, or duration of this event varies, use the most frequently used information as you can always change
this from within specific events. You may choose to create more than one master for this event type if it has two or
three frequent definitions. If you do this, use different names.
Add as many recurring masters as you like, but choose events that will happen more than a couple of times. If they are
not frequently occurring, avoid clutter on your Home screen and add the event as a one-time event instead, see "OneTime Events" on page 49 for more information.
Check the “Not Currently Offered” if the event was used in the past but is no longer. This will retain event history,
but reduce the clutter in the Recurring Events window at the Home Screen.
Book’em! automatically counts “User Days”, the number of reservations (people) per location/per day in any given
date range. Read more about User Days on page 107. If you do not want user days counted for this event, click on the
check box.
It is within this screen that you can set which mail merged Confirmation Letter you would like to be set as the
default. You can always change this within a specific event or even for a specific printing but set up the default here.
For more on mail merge letters see "Confirmation Letters" on page 73.
The Difficulty Thermometer is a tool designed match a customer’s ability with the difficulty of the event. The
customer record has a Skill Level thermometer and using the two together gives you a customizable system of
matching customers with appropriate events.
Clicking on the Destinations button will launch a window that will take you into the Destinations database. This is
where you add hotels, restaurants or other specific places your event will visit. For more information on the
Destinations database see page 100.
The Description button is a place to store brief event highlights, descriptions and details. Think of it as a place for
event ”crib notes”.
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Entering Locations
Following is a brief introduction to the Locations table within Book’em! For a complete description, see page 109.
It is important to note that there are two Locations for each event. One is the simply the Location; where the event
takes place. User Days (page 107) are tracked by this Location. The second is the Departure Location; where the
event departs from or begins, this is the location that will be used for confirmation letters (see page 73 for more
information on letters) and maps and directions (see "Locations" on page 109 for more info.).
For example, the Location for the event might be San Francisco, the Departure Location would be Lombard Street
(the starting place for the event). The more specific and accurate your Locations are, the more ability you will have to
create useful searches and reports.
When creating your locations records, consider that locations are used to track User Days (see page 107). Because of
the relationship between User Days and Locations, it is recommended that you are as specific as possible when adding
and assigning locations. For example, if all of your events take place on the Snake River, but you need User Days
totals that give you greater detail than “Snake River”, be more specific with your locations. I.e. “Snake River - South
Run”, “Snake River - North Run”, etc.
When a new location is entered you’ll be asked to create it. In this screen you’ll be able to enter directions to the
departure point and paste in a map.

The map and directions may be included in the confirmations that are printed for customers reserving space in events.
When creating your locations records, consider that locations are used to track User Days as well (see page 107).
The map should be in PICT format, dimensions roughly 51/2” wide by 41/2” tall, and in a resolution compatible with
your printer, usually 300 dpi for a Laserwriter and 360 dpi for an inkjet. You may find that half your printer’s
resolution (150 for a Laser, 180 for an inkjet) is adequate for printed maps. This resolution uses 75% less disk space.
If the PICT header of an EPS file is pasted, the EPS graphic will be printed if your printer is equipped with
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PostScript.

If you don’t have a scanner, Outside Technology can scan your maps and graphics for you and optimize them for
Book’em! (additional service charge), or you may have a local service bureau do it. You can always go back and finish
this later, but the location record will still need to be saved even if no map or directions are available.
The name of a location may be changed globally by changing the name field within the Locations Database. For
detailed information see "Locations" on page 109.
Modifying Recurring Masters
A Recurring Master may be modified by selecting it from the list and then clicking the Edit Master button. When
you are finished with your changes Book’em! will ask if you’d like to have the changes applied to existing future
occurrences. Only events which had the old default value will be updated. For example, if there were 20 upcoming events
of this type and two of them had a different location, changing the location of the master would change the location
of only 18 occurrences. If the cost is modified, any existing reservations will retain the cost that was originally set.
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Scheduling Events
There are many different ways within Book’em! to schedule events. We’ll start by describing how to
schedule an event for a single day or occurance.We’ll then explore the two tools Book’em! uses to automate
the scheduling of many occurrences of events with just a few easy steps.
Add Event
Click on this button from the Home screen to create a single occurrence from a master event. Simply enter the event
start and end dates in the date fields and click Save. The event will appear on the Home screen and on the Calendar.
Create New Event
This popup menu is located in the bottom left (event view) or bottom center (appointment view) of the Calendar
window (page 157). Just click on the day (on the Calendar) you wish to create an event occurrence on and click on the
Create New Event popup menu. A list of Recurring Master events will appear, select the event you wish to schedule.
The Edit Event window (page 48) will open, allowing you to make any necessary changes to this occurrence. Click
Save and the event is added to the Calendar and Home screen.

Schedule by Calendar
From the Home screen, pull down the “Event’ menu and click on Schedule By Calendar.

For each occurrence of this event to be scheduled, first click the date, then the button below the Events list (or use the
Return key). Multiples may be entered for the same day by clicking the button more than once.
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When you are finished scheduling, click the Done button. The Home screen now lists all of the new occurances.

Recurring Masters

Events
Info Box

As you can see, each event is listed by date and shows the size and availability. As these events fill with reservations
this list becomes more informative.

If an event type is clicked from the list of recurring masters on the left, the Info Box on the far upper right shows the
general characteristics of the master. If a specific event is clicked the Info Box shows details of that event. The buttons
are activated only if the associated action is possible based on your selection. For example, the New Reservation
button will be dimmed unless a specific event date is selected.
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Creating Weekly Schedules
Select ‘Create Weekly Schedules” from the Events menu.

Click the triangle to the right of the box marked ‘Choose Event Master’ and select River Trip.
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Now click the triangle to the right of the box marked ‘Choose Day(s)’ and select All Days.

The selected days appear in the window.
Now let’s suppose that you offer a special price on Wednesday River Trips. Instead of $175, you offer them at $150
and the start time is a little later. Select the Wednesday trip with the mouse and click the ‘Edit’ button.
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The Edit window opens.Use the TAB key to move from field to field.

TAB to Cost and enter 150.
TAB to Start Time and enter 11a and 3p for End Time. (See "Time Fields" on page 34 for tips on time entries).
Click the Save button.
Now enter the date range that you want to create trips for in the boxes at the bottom.
See "Date Fields" on page 34 for info on entering dates.

After you TAB out of the End Date field the ‘Schedule’ button is activated. Click it. When the trips have been
created, click ‘Save.’
Modifying Event Definitions
If any single event needs to be modified from the default created by the Master, select it from the list in the center of
the Home screen screen and click the ‘Edit Event’ button. If all recurring events of a Master need to edited, select the
Recurring Master from the list on the left and click the “Edit Master” button.
Any characteristic may be changed for any event, including the name, location, cost, size, dates and times, but it will
still be categorized under the Master it was created with. It is your judgement call as to how much variance is
permitted within a Master.
You can also modify an event from within the specific event window. From the Event window click on the blue event
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title bar, this will take you to the Edit Event window (see page 48 for more information).
Rescheduling an Event Reservation
If an event needs to be rescheduled, simply select it and click Edit Event. Change the date(s) and/or time(s). Any
existing reservations stay with the event.

One-Time Events
Some events may be specially arranged by clients, tailored to their own needs. They may not neatly fit into any of your
Recurring Masters. To avoid cluttering the list of Masters, use the One-Time Events option. The only difference
between one-time and recurring events is the way they are accessed. The reservation process is exactly the same.
One-Time events are accessed from the Events menu at the Home screen, or Command/Control - O. You have the
option of having the One-Time Events List open automatically every time Book’em! starts up.
You may also create a One-Time event from the Quote Estimator. This is a powerful tool for determining pricing,
discounts, food, lodging, staff, and profit totals for a custom event. For detailed information on this tool see "Event
Quote Estimator" on page 87.
Set this option in Preferences (page 27).

The time in the lower-left is the last time the information on the list was updated. This is of concern only if there are
other users taking reservations. The list is updated when the window is brought to the front, or by selecting the time
frame from the popup menu that’s next to the time indicator.
Use the ‘New Event’ button to add an event. Give it a distinctive name that you’ll recognize; if it’s a trip
commissioned by a customer, you may give the event the customer’s name (keep in mind this is the name that will
appear on customer’s confirmation letters, etc.). If an existing event is selected from the list the New Event button
becomes ‘Edit Event.’ This button will allow you to modify basic characteristics of the event, such as name, date, cost,
location, etc.
The event’s reservation screen may be opened by double-clicking the event or by selecting the event and clicking the
Select button. You may take reservations without opening that screen by selecting the event and clicking the ‘New
Reservation’ button.
On the other hand, if you organize a special event that may happen once or infrequently, but it is an important event
and when it’s over you’d like to be able to easily find everyone who attended, create a Master for it and use the ‘Not
Currently Offered’ checkbox in the Recurring Master record to have it not show on the list after the event is over.
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Taking Reservations
Three of the four ‘Event Launchers’ (the Home screen, the One-Time Events List, and the Calendar) contain New
Reservations buttons. The button is activated when one event is selected from the list. You may also open the event by
double-clicking it from the list, and initiating the reservations process from here.

To reserve a spot for a customer, click on the New Reservation button over the Reservations list, or type Command/
Control-N. Enter the number of people in the party.

p

If there is more than one user currently logged on, a hold is immediately placed for this number of reservations for
this event and will be maintained until this reservation process is concluded.
You are requested to enter the last name.

If there is a chance the customer may already be in the database, enter the first few characters of, or their entire last
name. You may try different spellings if you think they may already be in the database under an incorrect spelling.
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Remember, it is very important to avoid duplicate entries.

This a a critical point in reducing duplicate records within your database. Having duplicate customer records can
dramatically affect your ability to track customer history, accurately view transactions, manage customer accounts, and
more... Be sure your staff are searching thoroughly in for existing customers before creating a new record! See "Find
Duplicates" on page 150 for more information on duplicate records.
Enter more letters to narrow the search and find fewer people. Entering ‘cars’ will find all carsons, carswells, and
everyone else whose last name begins with cars. If no records in the Customers table match your entry the request will
reappear with the ‘New’ default.
Another valuable duplicate search tool is use the name + zip query. Enter the partial (or full) last name in addition to
the person’s zip code. This search works very well if you are unsure of the spelling of the persons name (or it is a very
common name), but want a smaller selection of names to be found. Instead of searching on and receiving a list of 400
Jones’s to choose from, enter jones + zip and receive a much narrowed selection.

Regardless of how you format this search, if the program locates any records matching the search information it will
display a list of possible records. From this list you may select and reserve a customer, create a new record, try your
search again, or cancel the reservation process.
If the customer does not exist in the database, leave ‘New’ (or enter it) in the box and click OK to enter a new record.
See Adding a New Customer, below. To view a selection list of all entered customers, delete the word “New” and click
OK (this may take awhile if you have thousands of customers in your database).

Adding a New Customer
This may be done while making a reservation, or by selecting All Customers from the People menu at the Home
screen. Leave the word “New” in the request and click OK.
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Enter all of the customers personal information; this will be his/her main record.

We’ll dig deeper into the Customer Record later in this manual (see page 83), but here is an overview. To the left of
the First Name field is the Salutation popup menu. This determines how mail merge letters fill in the “Dear...”
variable. If no salutation is selected the letter will be addressed “Dear John,”. If a salutation is selected, the letter will
be addressed “Dear Mr. Smith,”.
Capitalization is automatic unless you’ve deselected it in the Preferences screen.
When you get to the City field, if the customer’s city is one you’ll be likely to enter again, enter a 2-character
abbreviation that will be easy to associate with the city. You’ll be prompted for the city and state. From now on,
entering those 2 characters will look up this information. The list of city abbreviations may be edited and printed by
selecting List Editor from the File menu at the Home Screen, for more information see "The List Editor" on page
149.
If you’ve entered a default area code in the Preferences screen (and it represents the customer’s area code), enter just
the 7-character phone number. It is not necessary to type separators or formatting characters, just the numbers.
Likewise, spaces need not be typed in the credit card field. Some businesses require a credit card or prepayment to
hold a reservation. If you enter the customer’s credit card number and expiration date, the Event screen’s reservation
list will show a checkmark in the ‘CC’ column. If Book’em!’s database does not recognize the card number the ‘CC’
column will show a question mark.
Click on the small “More” button on the middle-right to enter even more customer information, go to page 83 to
learn more about these additional customer record screens.
You probably have some standard info that anyone making a reservation needs to be aware of, such as your refund/
cancellation policy. Click the Fully Informed check box to indicate that this person has been told the policy. You may
enter the policy in the Preferences screen ("Setting Preferences" on page 27 (click the ‘Set Policy’ button within
Reservations tab), so that any user may click the READ button for quick reference. If Fully Informed is checked, the
Event screen’s reservations list will show a checkmark in the ‘TP’ (Told Policy) column.
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Confirming the Reservation
Click the Confirm Reservation button. Book’em! creates an invoice for the customer’s reservation

We’ll start with this overview of the invoice, for detailed descriptions see page 121.
The default cost for the event is entered in the Cost Per field, but it may be modified for any individual reservation.
If the customer will be paying for more than one seat, enter that number. If you would like to have detailed
information on the additional customers, click the “New Reservation Button” and enter their information here. This
will create another reservation within this party, and will set the stage for the original customer to pay for the new
customer’s reservation (see "Kingpins and Stooges" on page 54). For Book’em! to maintain correct financial records it
is important that all reservations have a responsible payer.
If the “Expect Others” checkbox is selected in the Reservations section of Preferences, the Quantity will be one; if
Expect Others is not your preference, the quantity will be equal to the number of people in the party. When you save
the invoice, if the quantity is less than the number in the party, Book’em!will ask if you want to add the others.
The Discount popup menu will list available discounts if you have created any in the Discount Editor. This is opened
from the Financial menu at the Home screen. See page 128 for information on the Discount Editor.
Click the “New Item” button to add sale items for sale to the invoice. You can also add items that need to be brought
along on an event that are not for sale.You can set both of these up by choosing “Equipment & Sale Items” from the
Databases menu at the Home screen. See page 118 for more information.
If there is a prepayment, you can enter here through the invoice. For more information on entering payments
see"Payments" on page 58. Click “Save” on the invoice.
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Kingpins and Stooges
If the reservation is for more than one person and all in the party are not accounted for in the Quantity field in the
invoice, when you are finished confirming you’ll be asked if you’d like to enter the other people in the party.

All of these others in the party will be kept with the maker but will have their own invoices. The maker is known as
the Kingpin and all others in the party are Stooges. Stooges will have their own invoices if added this way. You can
add a Stooge to the Kingpin’s invoice by clicking the “New Reservation” button within an invoice (see page 121).
If the ‘Carryover Last Address’ checkbox is selected, the previous person’s last name, address and phone information is
carried over. This prevents having to type in the information twice if two people from the same household are
reserving.
Book’em! does not insist that all people in a party are individually listed. If you only want to list the person making
the reservation, unmark the Expect Others checkbox in Preferences (page 27). In any case, you may override the
setting in individual cases by manually adjusting the Quantity field in the reservations line of the invoice.
Add to Party
If you select a Kingpin from the Reservations list in an event window, the “Add to Party’ button becomes enabled and
you may add a Stooge with their own invoice. If there is more than one user logged on to the database, a hold for one
seat is placed for the event as soon as the Add to Party button is clicked.
If you want to add a reservation to an existing invoice, open the invoice and click the New Reservation button.

Hotels & Room Assignments
Assigning while Making the Reservation
Before a customer can be assigned to a hotel, a record must exist for the hotel. For information on creating a hotel
record see page 100.
If an event has a hotel assigned to it (and the event has an overnight stay), the “Room Assignment” screen will
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automatically open.

For parties of one, Book’em! assumes a single room, so the Room Assignment screen will not open automatically.
In order to assign hotel rooms, all reservations must have names listed or the hotel assignment screen will treat the
group as a party of one. It is assumed that only people within the same party will wish to room with each other, you
are not able to put people from different parties within the same room.
Assigning from the Event Record
Select a Kingpin from the customers list in an event window and the ‘Hotel Button’ becomes enabled. Click the
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button. The Hotel Room Assignment window will open.

This picture shows a fully assigned party of three using one double room and one single room. Names shown in
boldface are Room Kingpins and those not in bold below them are assigned to the Kingpin’s rooms. To change room
assignments, click on the person you wish to change. This will activate the ‘Toggle’ button, by clicking on the toggle
button you assign different rooms (double clicking the selected name will work the same as clicking the toggle
button). For example, by selecting Norton Ellis and clicking the ‘Toggle’ button (or with a double click) you can
change the assignment from one double and one single room, to one triple room. You can also add a specific bed type
to the assignment by clicking on the ‘Select Bed Type(s)’ Button, this will give you a blank field to type in “double,
king” etc. This preference will print on the ‘Room Roster’ (see page 70).
Click the ‘?’ Button for a list of available keyboard shortcuts available here.
Click Save to save changes and return to the event window.
You can always reenter this screen and change room assignments by clicking on the ‘Hotel’ button from the event
window.
The Rooming Lists may be printed by selecting Room Lists (Command/Control-3) from the Report menu at the
event’s window. See “Room List” on page 174.

The Waiting List
Adding to the Waitlist
If the number of reservations you are making exceeds the specified limit for the event, you are alerted and given three
options.

You may override the limit and overbook the event if you choose. You may cancel. Or you may add the customer to
the waiting list. If you either overbook or waitlist, proceed at this point as if you were making a standard reservation.
That is, make sure the customer’s record does not already exist before creating a new one.
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After creating or selecting the customer’s record, the Add to Waitlist screen appears.

The waitlist notes are not saved with the customer’s record. They are only to let you know any information you’ll need
to know when filling from the list. If the customer will accept an alternate event, click the ‘Flexible’ checkbox.
You may not enter Stooges to a waitlisted customer. This must be done when they are actually booked.
Filling from the Waitlist
From the window of the event you want to fill from, click the ‘Wait List’ button. The list shows all those who are
waitlisted for this specific event.

Clicking on a name on the list will show specific information pertaining to the event and the waitlist record. Click
once on the customer’s name in the right-half info box to obtain the customer’s address and phone(s). Command/
Control-click the customer’s name to open their main record.
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To see people who may be waitlisted for other events, use the ‘Search’ popup menu.

Clicking the ‘Confirm Reservation’ will cause the normal reservations process to occur and will remove the customer
from the wait list.

Payments
Payments may be entered through the invoice at the time the reservation is made, or by selecting the customer from
the reservations list within the event window and clicking the ‘Payment’ button, or from within the invoice at any
time.

The notes field in this window is saved with the payment and will be visible within the Transactions table. This note
is NOT saved to the customer’s main record.
Make sure the payment type is selected before the ‘Enter Payment’ button is clicked.
Another way to enter payments is to select ‘Receivables’ from the Financial menu at the Home screen. When the list
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opens, customers who owe money on any invoice are shown. The list is sorted by customer’s last name.

Payments may be entered by double-clicking a line on the list or clicking the ‘Payment’ button. The total is not
recalculated until the list is reopened or the ‘ReCalc’ button is pressed. Sort the receivables by clicking the popup
menu on the left or check the ‘Past Due’ box to view only past due (not all) invoices.

Rescheduling
Occasionally a customer will need to change their reservation. Select them from the reservations list and click the
‘Reschedule’ button. A list of upcoming events of the same type is shown. If the reschedule is to a different type of
event, click the ‘All Upcoming’ button. Select the event the customer would like to switch to and click ‘Reschedule’.

If there are others in the party, you’ll be asked if you’d like to move them as well.
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After clicking ‘Reschedule’ you will get the following message, be sure to take note.

All data, including payments, are transferred to the new event.
If the entire event and all customers needs to be reschedule, simply change the event date to the new date. All
reservations and data will be moved to the new date. See page 104 for info on editing events.

Cancellations
If a customer cancels a reservation, select them from the list (within the event window) and click ‘Cancel Res’. If a
payment has been made and there are no Stooges, you need to deal with that money here:

The Notes field on this screen is saved in the transactions table if money is refunded. (If no money is refunded a
transactions record is not created.) These notes are NOT saved in the customer’s record.

60 Book’em! User Guide

Taking Reservations
If there are stooges involved, you will need to take care of the money here:

This cancellation window gives you the opportunity to select who exactly within the party is cancelling and tell
Book’em! what to do with any payments that had been made. By selecting the name and clicking the ‘Cancelling’
button (or double clicking the selected name) you can clarify who is cancelling and assign a cancellation charge,
refund or credit to each individual.
Note: This is your opportunity to address payments made for this reservation, do so now or forever make your life
more complicated!

The To Do List

To-Do List Button

You may keep and print a To-Do list for the event, this is a good place for notes or tasks to staff. To add an item to the
list, click the To-Do button in the left, upper region of the event’s window.
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If this is the first entry for this event, the entry layout appears.

If there are already reminders entered, the To-Do list appears.

Double-click an item to view or modify. Use the ‘Print’ button (or Command/Control-P) from the event’s main
window and select the To-Do List to print it.
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Event Notes/Reservation Notes
General notes for the event may be saved by clicking the Event Notes button in the upper right of the Events
window. The event notes will print on the To-Do List. If there are notes for an event, the button has a checkmark in
it.
Individual notes for any person reserved to the event may be entered by selecting them from the reservations list and
clicking the Reservation Notes button below the list. These notes print on the rosters only. When there is a
Reservation Note the ‘Note’ box will have a check mark in it (Macintosh) or ‘Note” will be in bold type (Windows).

Event Notes

Reservation or
“Roster” Notes
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Assigning Staff
You can assign staff to an event by clicking the ‘Staff ’ button in the lower left of the event window. Staff already
assigned to the event will appear in the window below the staff button.
In order to assign staff, they have to already exist within the leader database. Employees are entered into the database
by selecting Staff (or Guides, or whatever you call event leaders) from the Databases menu at the Home screen (to
change what you call event leaders see"Setting Preferences" on page 27). Click the ‘New” button (lower left) to create
a new leader record. More information on creating and modifying staff records may be found beginning on page 95.
Before you can assign an employee to an event the payroll preferences need to be set, please see "Payroll" on page 31.
Clicking on the ‘Staff ” button in the event window calls up a list of all available instructors. If the instructor is already
scheduled for something on this date a checkmark appears to the left of their name. Clicking on a name will show the

address and phone information for the employee and detail any events they may already be scheduled for that occur
during the time period of the current event. It will also show any certifications the leader may posses and the status of
the certification (current or expired). Select the name you want to assign and enter their pay amount, which may be a
flat rate and/or a percentage of the trip’s gross. Default per-day pay rates may be set in the employee’s record. Click on
the ‘Job’ popup menu to assign a title to each assigned staff. To learn how to change these job titles see "The List
Editor" on page 149. Click ‘Select’ to make the assignment. Repeat until done, then click ‘Save’. Your staff selections,
along with their job titles will now appear in the bottom left of the event window.

You can also choose to have the pay amount for each assigned staff member listed next to their job title within the
event window. You can turn this feature on and off in Preferences under Payroll, see"Setting Preferences" on page 27
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Viewing Reservations Info
From the Home Screen, by clicking on the name of the recurring master it’s easy to see all of the events upcoming,
and how much space is available in each.
Event information is updated on the Home screen whenever it is brought to the front. In other words you can never
overbook an event just because another user is taking a reservation. You will always have the most current trip
information.

Book’em! has four Event Launchers: the Home Screen, the One-Time Event List (see page 49), the Reservation
Finder (see page 67), and the Calendar (see page 157). You may select and open event records from any of these
screens.
Double-clicking on an event from any of the Event Launchers opens the record and shows all the event’s details.

The reservations list shows the customers’ names and how many spots they’ve reserved. The list is sorted in the order
in which the reservations were entered into the database. By clicking on the Alphabetical Customer List popup
menu, you can view a Alphabetized list of customers, select a name on the popup and it will be selected within the
event window.
Kingpins are shown with the number in their party in the left column; Stooges are indented under their Kingpins.
Some things never change.
Click once on a reservation to enable the Invoice, Reschedule, Add to Party, Cancel Reservation, Enter Payment, and
Reservation Note buttons. Click once on a Staff person to enable the Remove button.
The Info Box at left shows the booking and financial status of the event. The amount showed for Receivable is based
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on the actual existing reservations, not the potential size limit of the event.
Get Info
With a Kingpin or Stooge selected in the event window, click Command/Control “I” to get snapshot of reservation
information.

Reservations Indicators
The check marks after the names indicate whether they’ve been told the policies (TP), that their credit card number
is on file (CC), whether their map sheet/info letter has been printed (PR), and payment status (PD). Payment in full
is indicated by a √ mark, partial payment by a -, overpayment by a +. If money is owed and no payments have been
made, the indicator is ‘0.’ If there is no mark in this column the reservation is either paid for by someone else or there
is no charge.
The TP (Told Policy) column indicator is checked if the ‘Fully Informed’ checkbox was marked when the reservation
was taken see "Taking Reservations" on page 50 for more information. You may mark a line here in the Event window
by highlighting the line, then Command/Control-clicking the TP column header. This will toggle the checkmark; if
it was marked before it will unmark it.
The PR column is automatically marked when you print a map sheet or letter for the reservation. You may manually
mark or unmark this column by the same steps as the TP column, described in the previous paragraph.
The CC column is checked if a credit card number is entered in the customer’s record. The PD column indicates
payment status. Neither of these columns may be manually set.
Send Selection
There are many tools available at the Customers List Screen which can act on a selection of records. Use the Send
Selection button to open the Customers List and make the people with reservations for this event the current
selection. If the Customers List was not previously open, a new Base Selection is created. Hold down the Command/
Control key while clicking the Send Selection button to add these people to any selection that may already exist for
the Customers Table. See "List Screens" on page 35 for more information.
If the Customers Table currently has an individual record open for modification the selection cannot be sent. You will
be alerted to this.
Verify
Click the Verify button to have the program quickly check to see that all customers have a payer assigned to them and
that the transactions are in order. If they are not, you will receive a message indicating that there is an error. If
everything is in order, the program will tell you everything is O.K.
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Finding Reservations
The Reservation Finder screen is one of the most powerful and flexible tools within Book’em! In addition to finding
reservations, this screen is the easiest way to enter new customers not making a reservation for an event. From
anywhere in Book’em!, Command/Control-F opens the Reservation Finder.

Simply enter the customer’s name and TAB. The name must start with the last name but may be either a partial name
or Last Name, then First Name. For example, ‘cowz’ will find Cowznofski and anyone else whose last name begins
with those letters. ‘Smith J’ will find all Smiths whose first name begins with J. Be sure to leave one space with no
comma between the last and first.
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Typing Command/Control-F from a customer’s record will open the Reservation Finder with the customer selected.

Clicking on customer will select that record and list all events they have reservations for as well as current account
information.
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Double-clicking on the event will open its window and select the customer’s reservation.
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Printing
For more information on printing reports, rosters, lists etc. please also see "Built-in Reports" on page 169.
Rosters
Open the event you want to print a roster for and click the Print button, or Command/Control-P. The Print Event
Window appears.

See the following page for detailed information on Rosters.
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The Checkbox Roster
Shows all customers reserved for this event, grouped into parties. It shows how much they’ve paid and how much they
owe. There are areas to enter payments taken at the event, and checkboxes to indicate payment types. This is a handy
way for the event guide or instructor to log money taken in.
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The Simple Roster
Shows a single line for each person registered, grouped into parties, along with their payment status.

Both Rosters list any information from the Detail area of the customer record that has been entered (see "Entering
Personal Information" on page 84). In addition, both will show any Reservation Notes that have been entered (see
"Event Notes/Reservation Notes" on page 63).
You may also print both roster formats by selecting them from the Report menu when the event is the front-most
window or in bulk for multiple events by choosing Print from the File menu at the Home screen (see page 169).
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Getting Info to Customers
Click the Confirmation Letter(s) checkbox in the Print Event Window.

To enable the Print button, at least one format and one customer must be selected.
The Map and Directions checkboxes are dimmed if there is no map or directions entered for this event. See "Entering
Locations" on page 42 for more details.
You can choose to send the names and addresses to the Label Spool or printing the labels now by checking the
appropriate box.
Only customers for whom a confirmation has not yet been printed are shown by default. If you need to send another
copy to someone that was already printed click the ‘Show All’ button. Multiple customers may be selected by several
methods:
• Click a name and drag to highlight a contiguous selection.
• Click one name, then hold down the Shift key and click another to select all in between the two names.
• Hold down the Command/Control key to select multiple customers individually.

Confirmation Letters
You may send personalized mail merge letters to customers regarding their event. You may create and save a letter for
each of your recurring masters, and also set a program default which will be used if no letter is saved for the event
being printed. You may use this mail merge function to print more than confirmation letters for the event. This
function works well for any mail merge letter you need to send a customer that in some way is connected to the event.
You can send mail merge letters not relating directly to an event from the Customer record, see "Mail Merge" on page
153 (and below) for complete instructions and examples.
Click the ‘Edit’ button with “Default Confirmation Letter Selected”. The word processor opens. If no letter has been
saved for this event type, the window is blank. This will be your system default letter. See "Mail Merge" on page 153
for a full description of how to create, modify and save letters.
Select font characteristics and choose ‘Heading’ from the Merge Items menu. This will print as today’s date and a
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complete address header.

Press the Return key once or twice and select Dear... from the Mail Merge menu. How this line will print depends on
how you have set the Salutation Popup in the customer’s record. See “Entering Personal Information” on page 84.
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For the default letter, make the letter body general enough to apply to most of your events. You may select any field
from the Merge Items menu to refer to specifics.

If you intend to print letters and maps on one page the letter writer window approximates how much space is
available. For multiple page letters use as much space as you need.
When you are finished, click the ‘Save’ button. This letter can be modified or replaced at any time by clicking ‘Edit,’
making your changes, then clicking ‘Save.’
You may also write a letter specific to an event (or Recurring Master Event). To edit the letter for all Recurring
Events, click Edit Master from the Home Screen. Choose the appropriate letter and edit if necessary. By clicking the
‘Save’ button on the Edit Event window will cause this letter to be the default to print for all occurrences of this event.
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Here is an example of a confirmation letter, map, and directions printed on one page:
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4. Databases

In-Common Features
This section covers some general hints and tips for data entry in Book’em!
The Databases menu at the Home Screen gives direct access to records in many of Book’em!’s data tables. In
these areas you may add, modify, and delete records, import and export, create reports and graphs, send
mail merge letters, and manage mass mailings.
All of the tables available through the Databases Menu at the Home
Screen operate similarly in several important ways. Familiarity
with these in-common characteristics will make your work in any of
these tables easy.
When any item from the Databases menu is selected, the QuickSearch
window opens. This allows you to tell Book’em! what record(s) you want to
find, or that you want to create a new record.

The available fields to search on are different for each table. The “Starts With” search is generally the best search
option to use. If the field you want to search is not available within the QuickSearch, click the “Search Editor” button
for access to all fields and multiple criteria. When you use the Search Editor, any settings you have made in the
QuickSearch are ignored. Learn more about "The Search Editor" on page 139.
If you do not care that the list be sorted, and you suspect the number of records found will be large turn AutoSort off.
The “New Record” button will let you create new records. Every time you save a record, a new blank will be created.
When you are finished adding records, cancel the next blank record. The “add-until-cancel” feature may be turned off,

Databases
see "Setting Preferences" on page 27.
The “All Records” button will open all records within that database. For example, if you go to the Databases menu
and select Customers and then click the “All Records” button, a list of all records in the Customer database will be
shown.
Checking the “Mail List Only” box will cause the search to only display records with complete addresses and record
without the “No Mail” selection within their record.

List Screens
After selecting your search criteria and clicking “OK” (or Enter on your keyboard), Book’em! will take you to the List
Screen (unless you clicked “New Record”, in which case you will go to the “New Record Screen”).Please see the next
section for more information on New Record Screens.
1
Window

Title

Footer

Popups
The
List screens are the starting point for many powerful tools that we will get into later in the user guide. At this
point we will describe the anatomy of the list screen and then move on. Please see "List Screens" on page 35, for
details on list screens.
The window title of the List screen tells you how many records are in selection and how many records are in the table.
In the example there are 21,335 total Customer records and 111 in the current selection. Performing a search will
change the selection.
You may also make a direct selection by single-clicking records with the mouse. Hold down the Shift key and click
any two records for a contiguous selection. Hold down the Command/Control key and click to toggle selection of any
single record on or off. You can open a record from the List screen by double-clicking your selection.
There are “Footer Popups” menus in the footer area of most List screens that change the current selection. The Staff,
Companies, and Destinations lists have only Keyword popups. The Customers list is quite a bit more complex, for
details see page 35.
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The four Arrow buttons in every Record Screen allow moving between individual records in the current selection
without returning to the List screen. From left to right, First Record, Previous Record, Next Record, Last Record.
From the keyboard use Command/Control-Up Arrow, Command/Control-Left Arrow, Command/Control-Right
Arrow, Command/Control-Down Arrow. Remember that the selection of records is based on your search criteria and
may include only the one record you are in, making these buttons unavailable.
The Date Stamp button pastes the current time, date and user into the Notes field, if you want to keep track of when
the Note was written and by whom.

Clicking the Save button will exit the layout and save all changes. Clicking Cancel will exit the layout
and not save changes. Clicking Delete will permanently delete the record and cannot be undone.
Deleting records is discouraged even if you know you will never see this person again. Book’em! keeps
track of your business history and missing records create holes in that history.

Keywords
Every business is different. No off-the-rack database can be expected to have everything built in.
Some businesses keep a programmer on payroll so that when their software needs a field to track whether a person is,
say, a travel agent, a field can be added. Some software leaves some ‘custom’ fields so the user can decide what to track.
Both of these solutions have problems. The first is very expensive. The second is finite, and chances are there will be
either too few or too many custom fields.
Book’em! uses a keywords system which is simple, powerful, and able to track a large customer table by any criteria
that may be needed.
You may create as many keywords as you need. And any record may be assigned any number of keywords. A selection
of records based on keywords may be searched instantly.
Creating New Keywords
There are two ways to create a new keyword.You may click the “+” button in the Keywords Area of a record.

TAB once and the cursor is flashing in the lower entry box. Type in the keyword and click ‘Enter’.
A new keyword has been created and assigned to this customer. Remember that the main record needs to be saved for
the keyword to be saved.
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Or, you may select one or more records from the List Screen and choose ‘Apply Keyword’ from the File menu.

Click the ‘New’ button to add. Repeat if necessary. You will not need to actually apply a keyword to save all your
entries; even if Cancel is clicked here new keywords are saved.
Applying Keywords
A keyword may be applied to a record anytime. If you are within the record or in the reservations process, click the “+”
button. The first keyword dialog appears. If the keyword to be applied is on the list, either type the first letter or
letters, or click it on the list. When the keyword appears in the lower box, click Enter. If the keyword is not on the
list, TAB once and type it in. In some records the list of keywords is not shown due to lack of space, but they may still
be applied by using the “+” button.
To apply keywords in bulk, go to the List screen of the table you wish to apply the keyword to. Select the records and
choose Apply Keyword from the file menu. See "Importing" on page 144 for apply keywords while importing.
Searching by Keyword
From the Customers List screen, select Keywords from the center popup.
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All of the keywords that you have entered for this table now appear in the right popup.

Selecting an item from the popup will show all customers who are tagged with the keyword. If the Shift key is pressed
while choosing a keyword, only customers within the current selection who are tagged will be found. Holding down
the Alt. key (Windows) or Option (Macintosh) searches for people who do not meet the selected criterion.
The example shown above uses the Customer List. Other databases will look slightly different but perform
identically. For more information on the specific databases, locate the database in the Table of Contents (or use the
index) and go to that chapter for detailed information.

Making Appointments
Book’em! provides appointment handling as a contact management and sales tool. It should not be used to track things
that could be handled through the Events table. For example, if you offer private lessons, individual consulting, etc.,
either create a recurring event master of that type, or enter them as one-time events. The Appointments table does
not make the relational connections with the entire program that the Events table does.
You can make appointments for Customers, Staff, Contacts, Companies, within their record or the through the
Calendar screen. You can also make General (unconnected to a person) appointments through the Calender Screen,
see"The Calendar" on page 157 for more details. In all record screens, click on this symbol to create an appointment
.

Book’em! User Guide 81

Databases
Click the Appointments button (it looks like a small calendar) to set an appointment for the person.

Fill in the date, start and end times (optional). Select the priority of the appointment (different priorities will show up
as different colors in the Calendar display). Select the user you would like to have the appointment appear for. You
can select a specific user (the appointment will appear on the Calendar only when this user logs on) or select “All” (the
appointment will appear for all users). Add any notes you may want to see when you access the appointment. Save the
appointment. Make sure you also save the main record for the person. The appointment will appear on the Calendar
after the record has been properly saved.
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Customers
The Customers table includes Prospects as well. A person does not need to have done an event to be listed
here.
Everything you do while in a customer’s record will be saved only if the main record is saved. You can
add new mailings, write letters, apply keywords, etc., but if you click Cancel to leave the layout it will all
be lost!
Please see "In-Common Features" on page 77 for instructions and tips regarding basic data entry
technique for this table.
New Customers & The Customer Record
New customer records may be created at the main customer list, while taking a reservation, through the QuickSearch
dialog, or through the Reservation Finder. To enter a new record for a customer or prospect without taking a
reservation, popup the Databases menu at the Home screen and select Customers (keyboard shortcut Command/
Control-2). Click the ‘New’ button. Book’em! creates a new record and automatically assigns a client ID which is
displayed in the top right hand corner of the address box.
One of the fastest and most efficient ways to enter a new customer not making a reservation is to use the Reservation
Finder see "Finding Reservations" on page 67 for more information.

Rapid Entry of Multiple Customers
If you have a number of people that you need to enter but still want to search the database to be sure they’re not
already entered (remember how important it is to avoid duplicate records), follow these steps:
•
•
•
•

Have the ‘Add until Cancel’ preference set to Add Until Cancel. See “Setting Preferences” on page 27.
Open the Customers List Screen with any selection of records.
Select ‘Records’ from the New menu, or press Command/Control-N on the keyboard.
When you are finished, click cancel on the next blank record.

OR
• Press Command/Control-F to open the Reservation Finder, or select ‘Find Reservation’ from the File
menu.
• Use the Reservation Finder to search for duplicates. See “Finding Reservations” on page 67. You may
want to try some possible misspellings just to be sure
• If you don’t find the record, click the New Customer button, fill it in, and click Save.
• Immediately after clicking Save you may click back on the Reservation Finder and begin searching for
the next name on your list.
If you want to add keywords, notes, etc., to anybody who is found in the search, double-click the name on the list to
open their record.
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Entering Personal Information

Salutation
Popup

Client ID #
Appointment

Scheduler

Date
Stamp

Enter all personal information in the appropriate fields (press TAB to jump to the next field). Use the politically
correct popup menu to the left of first name to select the appropriate salutation.
Book’em! uses the salutation popup to determine how mail merge letters are addressed. If the popup is set to Mr., a
letter to John Smith will begin “Dear Mr. Smith,”. If the popup is not set, the letter will begin “Dear John,”. Do not
simply enter Mr. John in the First Name field, or the letter will begin “Dear Mr. John,”.

Most of the time the second Address line is not needed, so the TAB order jumps from the first Address field to City.
If you need to use the second one, just click in it, or use Option-TAB after entering the first address line.
You may use the Source field to note the way you obtained this person’s information. This could be a travel agent,
response to an advertisement, personal referral, purchased mailing list, etc. You can either choose the source from the
popup menu or enter a new source into the field. If you add a new item to the source field, the program will ask if you
want to add the item to the source list, click yes, if you would like it to be a part of the source list, no if you want it to
only be available to this record. You can make changes to the source list by going to the List Editor (page 149).
The Notes field (like all notes fields in Book’em!) can store up to 32,000 characters.
Click on the field name “Phone 1” or “Phone 2” to make a phone log entry. This log appears in the Customer Contact

84 Book’em! User Guide

Customers
History see "Contact History" on page 90.

No Mail!
There are many reasons why you may wish to maintain a record for a customer, yet keep them off the mail list.
First, there may be several people from the same household who are active in your events. Keeping a record for each
of them will allow you to track individual participation, notes, and payments, yet you may wish to send only one copy
of mailings to the household.
Second, someone may request to be off the mail list. You may still want to track their history. If a person requests that
their name not be included on mailing lists that you sell or loan, but does want to receive mail from your business,
create a keyword like ‘No Sell Mail list’ or some such, and remember to exclude people with that keyword from listfor-sale exports. The Keyword System is described in "Keywords" on page 79.
After a mass mailing you are likely to get a quantity back as undeliverable. Some of these people may have moved, but
have event histories. It is advised that you keep these records marked as ‘No Mail’. When they call to book a
reservation their address can be updated. For tools regarding mailing returns see "Postal Return Handler" on page 93.
None of the three mail commands (Send Letter, Spool Label, Apply Mailing) will be executed for customers marked
‘No Mail,’ unless the Command/Control key is held down during execution. Therefore, it is not necessary to exclude
No-Mails from a selection before doing a mailing unless you are exporting the records to a mailing service; no-mail
records can be exported.
Skill Level
The Skill Level thermometer can be used to gauge the skill level, physical fitness, adrenaline requirements -whatever is a useful gauge for your company. Click on the thermometer at the number you wish the bar to indicate (or
drag the bar to the appropriate number). There is a similar thermometer in each edit event window, (see"Recurring
Event Masters" on page 40 for specifics) you can use these two thermometers to form a system of customizable
prerequisites.
Find Dupes
You’ll notice that we have given you many opportunities to prevent duplicates within Book’em! Here is yet another,
just click the button after you have name, address, zip code, and telephone (phone 1) entered into the record and a
complete find duplicates search will be initiated. The search takes just a second, if duplicates are found a screen
showing the possible duplicate records will appear. If no duplicates are found, your system beep will be heard.
Print Label
This button launches the print driver for one-at-a-time, individual mailing labels. At this time this functions works
only for MacOS. If you have an individual label printer, see “Preferences” page 28 for instructions on selecting your
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printer.
Spool Label
The Spool Label button will send the complete address information from this record to the Label Spool, where you
can then print labels, send mail merge letters and more. For more information see"Label Spool" on page 161).
Apply Mailing
Click the ‘Apply Mailing’ button to open a list of your brochures, promotions, etc.

If you haven’t entered any mailings yet, the list will be empty. Click the ‘New’ button if you’d like to add a mailing.

The creation date may be modified. When you apply the mailing to a customer, the date that the mailing was applied
is also saved. Check the Spool Mailing Labels box to automatically send the customer’s label information to the Label
Spool (see page 161).
You can search for customers who have received a particular mailing using the left popup at the Customers List
Screen. See “Search Tools” on page 91.New Invoice
New Invoice
Click here to open a new invoice that is not connected to an event (don’t use for charges relating to an event).
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Event Quote Estimator
Prepare Quote
This button launches a powerful Event Quote Estimator.The New Quote setup screen is the first to launch.

The fields are relatively self-explanatory, you may tab through the fields, leaving blank any fields that are not
applicable. You are not permitted to leave the Participants or Hours (for one day events) blank for obvious reasons.
After you have entered as much information as you feel necessary, click Continue. The Estimator window will open.

Many of the above values are calculated from the default values assigned in the Estimator Default window (see
below). Regardless of the defaults, you can always change any value in the this window.
It is recommended that actual normal costs be entered for each category, and any mark-ups be reflected in the Profit
Margin field. These are active fields--when a value is changed the other fields are updated instantly.
In the Staff field, per hour wages are used for one-day events. If you want the per-day wage to be used for a one-day
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events, change the per-hour wage to “0”. The Equipment field works the same way.
The Administration field supplies you with a way to calculate indirect costs. You may enter it either as a percentage of
all other costs (before profit) or as a fixed dollar amount per person, per day.
Use the Profit Margin field to calculate your free-and-clear profit. You may enter either a percentage or a fixed total
dollar amount.
Click “Done” to view the Event Quote Estimator Summary window.

Here all details from the previous detail screen are organized in an easily read summary. A per-person total is
calculated, a note field available, and you are presented with the ability to create the event from this screen.
Just add the Event Date, Start and End Time, Location and Departure and click the “Create Event” button to create
the event you just prepared the quote for. Or, leave these fields blank to create the trip at a later date (or not all).
Click the Calculator icon to round the per-person calculated amount to the next round number. Notice that the
program will update the per-person quoted and the Quoted Total fields. To change the amount in any of fields
summarized on the left, click on the “Edit Details” button on the far left to return to the quote detail window.
Use the Note field to track specific information about this quote. In the top right corner you will see that the date and
user that prepared the quote is listed. In addition, the last user and date the quote was modified will be listed.
Click the “Revert to Defaults” button to eliminate any changes you have made and return to your defaults costs. Click
“Save” to exit the Quote Estimator and return to the Customer Record.
Each quote you prepare and save will be stored in the Customer Record, click on the “Prepare Quote” button from
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the Customer record and if previous quotes have been saved, you will see the following screen.

Existing quotes are listed and you can choose to create a new quote, clone or open an existing quote.
Quote Estimator Defaults are entered and modified in the following window. You find this window in the Financial
menu from the Home screen.

It is recommended that actual costs be entered for each category and that mark-ups should be reflected in the Profit
Margin field.
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Contact History
Click the History tab on the Customers Record screen to view the complete contact history you’ve had with this
customer: mailings, phone log, letters, and events.

Customer Notes
This screen is simply a larger, easier to read view of the small notes window on the main Customer Record.

Customers
Customer Detail Window
This is a powerful window for maintaining important customer records that you are generally not accessing on a daily
basis but want to keep with the customer none-the-less.

All of the fields on the far left are not able to be edited, they are calculated by the customers history. The rest of the
fields you are able to tab through and enter information. PFD Size indicates life jacket sizing (specific to the water
sports markets--although you could use this field to represent something else), Reach, Special Diet, Smoker,
Handicapped, and Medical will all print out on the Rosters (page 70 for details) if there is an entry in their field. In
addition, the Smoker and Handicapped fields will print on the Destinations Roster (see "Destinations" on page 100).
The “Registrations” button will bring up a list of all Destinations (page 100). When you select a destination from the
list, you will be prompted to enter a code. This Registration Code will print on the Destination Roster.
The Interests window works in the same way as Keywords (page 79), and is yet another way to quickly sort, find and
organize customers.
“Pick-Up Point” is popup menu designed to work with a pick-up itinerary, you can learn more about this function on
page 112. You can either choose a Pick-up point from the popup menu or enter a new one.
The Customers List
The List Screen for the Customers Table contains many useful functions for managing many records at once. The key
to using these tools is to first create a selection with the search tools, then apply the desired function. The records on
the list at any given time comprise the “Current Selection.”
Suppose, for example, you want to send a letter or mailing to everybody within a certain zip code range who has been
mailed the Annual Catalog but has not been on any events. Or you want to find everyone tagged with a “Baja 2000
interest” keyword.
See "List Screens" on page 35 for information on how to use list screens to their full potential.

Search Tools
At the bottom of the Customers List Screen are three popup menus.
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The left popup lists all of your mailings, if you’ve entered any into the database. Select a mailing and Book’em! will

show all customers who have been tagged with that mailing. Hold down the Shift key while making your selection to
find only those within the current selection who have received this mailing. Hold down the Alt./Option key while
selecting to show all who have NOT received this mailing. Hold down Shift and Alt./Option while selecting to find
people within the current selection who have not received the mailing.
Once you have made your selection and the search has begun you may release the Option or Shift keys. Depending on
the size of your customer list and the number who have been tagged with the selected mailing, this search may take
some time. You may work in other areas of the database while the search is performed.
The center popup lists all of your recurring events, plus Keywords, One-Time Events, Interests, and Sources.

If an event type is chosen, everybody who is reserved into a future event of that type is found. Hold down the
Command/Control key while selecting the event type to find all who have taken the event in the past. Use the Shift
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key to search within the current selection, use the Option/Alt. key to find all who have not taken the event.
The modifier keys may be used in combinations. Hold down Command/Control, Option/Alt, and Shift while
making your choice to find all those within the current selection who have not taken an event in the past.
The right popup is empty until something is chosen from the center. If ‘Keywords’ is chosen, the right popup will list
all of the keywords you’ve entered for this table (the same holds true for Sources and Interests). If an event type is
selected, the right popup will list all occurrences of that event.

The list will be identified by specific event such as the window to the right. The number in
brackets is the number of reservations for that event. Or, the list will be sorted by month if the
specific number of events was large enough to be clumsy. The number of customers found if one
of these events is selected may differ from the number of actual reservations if any of the people
reserved into the selected event has been deleted from the database.
The far right popup will quickly search on the total number of events a customer has been on. For
example, if you select the number 5 from the popup, only those customers that have been on 5
events or greater. Hold down the Command/Control key while selecting this popup will search
on all customers with a skill level of 5 or greater (see page 91 for information on skill level).

Postal Return Handler
You’ve sent out a large mailing and more than 10% have been returned as undeliverable.
Hundreds or thousands of customer records with old or incorrect addresses need to be dealt with.
Book’em! has a tool designed to make this tedious process as quick and easy as possible.
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From the Customer List choose Postal Return Handler from the File menu.

Marking the Show Events checkbox will cause the searches to execute somewhat slower, since a search of the
Reservations table will be done for each found record, but the information might be valuable in determining whether
to delete the person’s record or mark it No Mail.
Enter a name in the usual Book’em! way: anything from partial last name to last name space first name, then TAB.
Find the person on the list. If you want to check the record, double-click or option-click the line to open it.
The lower list contains the ‘Action Set.’ To move a record to the Action Set, select the line and click the Add to
Action Set button, or Command/Control-click the line. Enter the next name (the entry area is already selected, just
start typing) and TAB. Repeat the process as many times as you like. Once you get the hang of it, it takes just seconds
to locate a record and send it to the lower list.
If one record is selected from the Action Set, the No Mail and Delete buttons will act on that record only. If no
records are selected, these buttons act on the entire list. Remember, it may be good strategy to simply mark these
records as No Mail, especially if the person has an event history; the addresses can be corrected when the person calls
to reserve an event.
Click the Send to List button to move selected action records to a list where other things may be done to them.
When a record has been marked No Mail or is deleted it disappears from the list.
If one record is selected the Remove button is activated, and the selected record will be removed from the list with no
action. The Clear button will clear the list with no action taken on any of the records.
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Staff
The Staff table is an important part of Book’em! It is here you can store all of the valuable data on the
people that keep your business running. Instructors, guides and other employees will be available for
scheduling based on the information that is entered into their record. For example, when you call the list of
staff for assignment to an event, only employees who are not marked ‘Inactive’ and who are tagged as
being an Instructor will be listed.
Creating a New Employee Record
To create a record for a new staff member, select ‘Staff ’ (or Guides -- whatever you have chosen to call them, see page
28 to change how staff are referred to) from the Databases menu (you can also access staff through the Address Book,
see page 99 for details). Choose New from the QuickSearch screen. Book’em! automatically assigns an internal staff
ID number in the top left hand corner. If you wish to enter your own employee or ADP number, enter this
information in the box below marked Payroll Nº. This is the number that the payroll report will sort on if that option
has been selected in Preferences.

Enter all relevant personal data. Refer to "In-Common Features" on page 77, for info on data entry techniques.The
Default Pay is the normal per event day rate this employee is paid. It will be inserted as the default, multiplied by the
number of days in the event when this employee is assigned, and may be modified for each assignment.
You can quickly get the total year-to-date monies paid to this staff person by clicking the “YTD Pay” button.
An inactivate employee is not available for scheduling. They will appear neither on scheduling pick lists nor in the
List screen of the Staff table when Staff is chosen from the Databases menu (assuming you have the “Active Only”
button checked). This allows you to keep their record and all of the essential related information, but keeps it out of
the way of your daily work.
“Instructor” is a broad designation you could use (for example) to separate the actual event leaders from the set-up
and clean-up staff. Make sure this box is checked if you want the staff person to appear when assigning staff to an
event. Those without this box checked will not appear in the staff assignment
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Click on the “Certifications” button to see and manage a list of...you guessed it, certifications.

You can add or modify certifications here by clicking the corresponding buttons. When a certification expires, it will
show “EXPIRED” next to the certification in most staff related screens.
Clicking on “Profile” will take you to an area perfect for staff biographies and/or photos. Use Cut and Paste to paste a
photo directly into the photo window where it will now be attached to that Staff record.
To view a list of all upcoming events this staff member is scheduled on click the “Upcoming Assignments” button.

Leaving the Employee’s Record
Click Save to record all changes made. If you would like to exit the employee table without saving changes, click
Cancel.
Do not click Delete unless you permanently want to remove this record and all related data from your database. Even
if you know this person will never work at your company again, marking the record Inactive will keep the name off
the assignment lists, but will maintain old payroll records. Please see "Deletions" on page 27for more information.
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The Companies and Customers table have a very close relationship with one another. A Customer can be
accessed both through the Customers database and through the Company’s (assuming that customer is
connected to a Company record). Likewise you can access Company information from the Customer record
that is linked to the Company. But for the majority of applications you will greater tools if you access the
Company records through the Customer database.

Please see "In-Common Features" on page 77 for instructions and tips regarding basic data entry technique for this
table.The “Sponsored Events” button will bring up a list of any events this company has sponsored (see page 105 for
details on sponsorship). You can open specific events (within sponsor window) by double-clicking a selected event.
Within the Contact window of the Company Record you will see all Customers that are linked to this company.
Select and double-click the person’s name to open a smaller version of the standard Customer Record.

See "Customers" on page 83 for specifics on this record. If there is an address within the Company record, that
address will be used as the default for printing, mail merging, etc. and will appear in the address portion of the
customer’s record. If there is no address in the company record, the Customer’s address will be used. The “Transfer
Address to Company” button will move the customer’s address into the company address fields.
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Contacts
The Contacts table is a place for you to store business or personal contacts. It can be accessed from the
Databases menu at the Home Screen or from the Address Book (see page 99). Here you will recognize some
of the powerful tools from other databases such as the appointment scheduler, mail merge, label spool, and
keywords support (see "In-Common Features" on page 77 for instructions and tips).
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Address Book
The Address Book pulls data from the Contacts and Staff tables (see previous section for more info.). To access the
Address Book, go to the File menu at the Home Screen and select “Address Book” (or Command/Control ‘B’). This
is an easy way to access Contact and Staff records.

Click on a letter on the left to search the tables, or use Shift+ the letter. Matching entries from both Staff and
Contacts tables are found, although the keywords popup menu refers only to the Contacts table. If a Contact table
record contains both a company name and a person, both will be listed. Click an entry once to get info on the person
or company. Double-click the selection (or click the “Modify” button) to open the record for modification. Click on
the “New Contact” button to create a new record within the Contacts database.
Either Contacts or Staff tables may be searched using the Search buttons. If the Command/Control key is pressed
while clicking either search button, all records in that table will be shown.
Be careful that you don’t use the Contacts table for companies or people that are likely to be customers. These records
will need the full range of functions that the Customers table offers, and the Contacts table does not.
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Destinations
This database is designed to handle information relating to destinations your clients will be going to as
part of your event but utilizing an outside resource. The Destinations database is often used for hotels,
restaurants, campgrounds, theaters, and other service providers that need to know the who, what, when
and where for your customers. Before you can assign a Destination to an event you need to create a record
for that Destination.
Create a new record by selecting Destinations from the Databases menu and clicking “New Record”.

Within the destination record you can add all necessary information. You need to enter a unique two to three digit
(numeric or alpha character) code for each destination. If you would like (or your destination requires it) you can use
a reference number for this Destination. The “Hotel” checkbox indicates whether this destination is for an Overnight
Stay (you are required to have a multiple day event to have overnight stay). The Contact window will enable you to
add multiple contact people, phone numbers, titles, and notes for this destination. To add a contact, just click on the
small “+” symbol next to the contact window, to remove a contact, select them from the list and click the “-” symbol.
Just double-click a selected name to open the record. Note: These contact names do not relate to any other table
(Customer, Contact or Company). Click “Save” and you can now add this destination to any event.
You can add a Destination to either a single event or all Recurring Master events. The process is the same for either
situation (see below).
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To add or modify a Destination for an event, click the “Destinations” button from the Edit event screen (see page 48
for details on modifying events).

If there are any Destinations assigned to the event they will appear. You can modify the arrival and departure times,
etc. by double-clicking the destination or selecting it and clicking “Edit”. If you need to add a Destination to the
event click the “Add” button, and choose from the list of Destinations on the left.

If Overnight Stay is selected on a Destination assigned to an event, a room assignment screen will automatically
appear prior to confirmation of a new reservation (see page 54 for details on reservations). If Overnight Stay is not
selected and a Destination is assigned to an event, it is assumed that all participants on the event will be going to the
Destination.
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From the Event window you can now print the Destinations Roster. Choose Destination Roster from the Report
Menu.

You can then supply your Destination with this report for their information. In addition to name and address the
report indicates date of birth, whether the customer is a smoker or handicapped, and a registration code if you and
your destination use one.
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Events
Events are the heart of this software program. Because of this you are able to access events through dozens
of different conduits. The Events Database is direct access to all of your events in a single, easy to use and
powerful list. To access this Database, select Events from the Databases menu on the Home screen.

From this List you are able to sort, create reports, modify, print, and more relating to events. For details on List
Screens see page 35. By clicking on the “Open” popup menu you can choose either Event Details (Edit Event
window, see "Events" on page 103) or Event Reservations (the Event window, see"Reservations" on page 29) to open
when you double-click on a selected event. Below we will go into detail regarding the Edit Event window. See page
48 for information on how to modify Event Definitions.
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Edit Event Window

For the sake of example we are going to use to Edit a single event, but the window will look almost identical for Event
Masters, One-Time Events, or Recurring Events (see page 43 for more information).
Choose an Event Name that will be descriptive and appropriate to be sent out to customers in the form of
confirmation letters, etc. You can change the name at any point, so meeting the needs of your ever-changing business
will not be a problem.
Choosing and entering a Location and Departure is covered in detail on page 42.
You can design a Pick-Up Itinerary for each event. Please see "Creating Pick-Up Points" on page 112 for information
on how to select, add or modify a Pick-up Itinerary.
If the size, cost, or duration of this event varies, use the most frequently used information as you can always change
this information within specific events. You may choose to create more than one master for this event type if it has
two or three frequent definitions. If you do this, use different names.
Check the “Not Currently Offered” if the event was used in the past but is no longer. This will retain event history,
but reduce the clutter in the Recurring Events window at the Home Screen.
Book’em! automatically counts “User Days”, the number of reservations (people) per location per day in any given
date range. Read more about User Days on page 107. If you do not want user days counted for this event, click on the
box.
It is within this screen that you can set which mail merged Confirmation Letter you would like to be set as the
default. You can always change this within a specific event or even for a specific printing but set up the default here.
For more on mail merge letters see page 153.
The Difficulty Thermometer is a tool designed to match a customer’s ability with the difficulty of the event. The
customer record has a Skill Level thermometer and using the two together gives you a customizable system of
matching customers with appropriate events.
Clicking on the Destinations button will launch a window that will take you into the Destinations table. This is where
you may add hotels, restaurants or other specific places your event will visit. For more information on the
Destinations table see "Destinations" on page 100.
The Description button is a place to store brief event highlights, descriptions and details. Think of it as a location for
event ”crib notes”.
You can clone any event from within its edit event window by clicking the “Clone” button. All times, names,
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destinations, costs, size limits, etc. will copied to a new event. When you click “Clone” you will be asked to enter the
start date for the new event. The new edit event window will open and you can make any additional changes that are
necessary.
Assigning a Sponsor
Often an event will be sponsored by an organization, business or person that may or may not be going on the event.
Often the sponsor is paying a fixed amount for the entire event or paying per reservation. Instead of creating a
reservation for the payer on the event we will create a sponsorship. Clicking on the “Assign Sponsor” button will
launch the Quick Search screen so that you can search for the Customer or Company you wish to assign as a Sponsor
to the event (for info. on the Quick Search see"Reservations" on page 29).
After selecting a current Customer or Company (or creating a new record), you will be asked to confirm the
sponsorship and then the Event Sponsorship window opens.

This screen allows you to determine the financial parameters for the sponsorship. You can choose to bill the sponsor
either a flat rate for the entire event or per reservation (and indicate how much). If you chose a company you will be
asked if the Company or the Customer the Company is connected with is billed.
Selecting Use Declared Size Limit causes the sponsor’s invoice to immediately bill the Per Reservation amount for
the entire declared event size. If it is not marked, the sponsor’s invoice will be calculated as reservations are added.
The sponsor is thus billed only for seats used. Once the sponsorship has been saved, “Use Declared Size Limit” can’t
be turned off. You may open the invoice and change the line quantity, but subsequent reservations taken will not
automatically increment the quantity.
You may still book individuals on this event and you may choose to bill each participant a specific amount for the
sponsored event in addition to any amounts listed on the sponsor’s invoice.Even if you have established a sponsor as
paying for an entire event, all participant reservations will have an invoice where they can be billed, make payments,
etc.
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Event Window
Double-clicking on an event from any of the Event Launchers opens the record and shows all of the event details.
Title Bar Button

Sponsor Invoice
Alpahbetical List

User Day Button

Res. Indicators

Event Notes
To-Do List
Res. List
Info Window

Staff Window

Clicking on the title bar button (the event name will appear blue on your monitor), will take you to the Edit Event
window (see page 104).
Below the title, the event location, date and time are listed for quick reference.
The row of icons are (in order left to right): Event Notes (page 63), To Do List (page 61), and User Days (page 107).
Below these buttons is an info. window designed to give you quick reference to availability, payment status, and wait
list totals.
The staff window lists any scheduled staff for this event, you can learn more about staff scheduling on page 64. Click
once on a Staff person to enable the Remove button, twice to open their record. Click the “Staff ” button to launch the
staff assignment window.
The reservations list shows the customers’ names and how many spots they’ve reserved. The list is sorted in the order
in which the reservations were entered into the database. By clicking on the Alphabetical Customer List popup
menu, you can view an Alphabetized list of customers, select a name on the popup and it will be selected within the
event window.
Kingpins are shown with the number in their party in the left column; Stooges are indented under their Kingpins.
Some things never change. Read more about "Kingpins and Stooges" on page 54.
Click once on a reservation to enable the Invoice, Reschedule, Add to Party, Cancel Reservation, Enter Payment, and
Roster Note buttons. Many of the features of this screen are described in detail in "Events and Reservations" on page
40. All of the buttons at the bottom of the Event window are covered in detail on the following pages:
Invoice page 121, Reschedule page 59, Add to Party page 54, Cancel Res page 60, Hotel page 54, Verify page 66,
Send to list page 66, Payment page 58, Roster Note page 63, Waitlist page 56.
Reservation Indicators are described in detail on page 66. The Print button is described on page 73.
Click on the Sponsor’s Invoice button to review the Sponsor Invoice. This function is explained on page 105.
Set Window Position
You are able to set the default position for single or multiple events to open. Move the Event window to the location
you would like to establish as the default, go to the File menu and select Set Window Position. All single events will
open to this location. Multiple events will start tiling from this location, see page 38 for more information.
Delete Event button
You may delete any event only when there are no customers reserved on the event. In addition, if there are any other
users logged on to the network you will not be able to delete the event until they have all logged off.
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User Days
One User Day is equal to one participant at a single Location per day. In other words, if Smith, party of six is
registered for a one day event on the American River you will have six user days for that location that day. If the event
is three days in length you will have 18 user days at that location for that date range.
It is important to note that User Days are tracked by event Location (not Departure Location). Your User Day
reports will by much more valuable if you use specific and accurate Locations for your events. For example, if your
company is located in San Francisco and you list San Francisco as your location for all events, your User Day will only
show the total User Days for all of your events. Instead, use more specific and descriptive Locations, such as “San
Francisco - East Building #4”.
User days tracking is often required by insurance companies, land owners, government entities and land management
organizations. Even if none of the above apply to you, User Days are a valuable tool in the tracking of numbers of
reservations at specific locations.
There are two places to access your User Day totals. When you are within an event window, click the User Day
button.
This will give you a quick total number of User days at this location for this day.
The other method is to select “User Days” in the Events menu from the Home Screen.

The Locations in your database will be listed on the left, check marks indicating which will be printed and total user
days for the date range indicated to the right. Single-click to toggle a location (to determine whether or not it will
print), double click to view a detailed list of dates, events, number of days and reservations.
Choose a pre-formatted date-range or choose your own dates using the popup menu in the upper left portion of the
window.
Click print to generate and print a User Day report. This report details dates, events, number of days, reservations and
total user days for each location.
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Delete Old Empty Events
This command, found in the “Events” menu from the Home screen does exactly what you would expect. Choosing
“Delete Old Empties” will permanently remove any empty (no reservations) events older than the day you initiate the
command. This function cannot be undone.

You will then get a dialog indicating the success of the operation

If any events were not able to be deleted, it is usually that there is an active record still attached to them. There also
might be a staff person scheduled for the event or a Sponsor still assigned.
Delete All Old ‘To Do” Records
Again, this command, found in the “Events” menu on the Home screen, does exactly what it says. For information on
“To Do Records” see "The To Do List" on page 61.
Close All Event Windows
Simply a time-saving tool, choose “Close All Event Windows” from the “Events” menu (at the Home screen) to close
all event windows that are currently open. If none are open, the program will let you know.
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Locations
Quite simply, locations are where events take place. The Locations database is where all of the particulars
regarding each location are stored. Directions to the location, maps of the location, even tax districts are
found within this database. Like so much of Book’em! you are able to access Locations from a variety of
places within the program. We will begin by choosing “Locations” from the “Databases” menu at the Home
screen.

You’ll first see the familiar QuickSearch screen (page 137), where you can either search on a particular Location(s) or
select “All” to see your entire list of Locations. The Location list screen (above) shows the name, number of events
using each location, Directions (if any), and an indication of whether or not maps are stored for that location (check
marks for Macintosh, Asterisks for Windows).
It is important to note that there are two Locations for each event. One is the strictly the Location; where the event
takes place. User Days (page 107) are tracked by this Location. The second is the Departure Location; where the
event departs from or begins, this is the location that will be used for confirmation letters (see page 73 for more
information on letters) and maps, and directions (see "Locations" on page 109 for more info.).
For example, the Location for the event might be San Francisco, the Departure Location would be Lombard Street
(the starting place for the event). The more specific and accurate your Locations are, the more ability you will have to
create useful searches and reports.
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Double-click a location to open the Edit Location screen.

Clicking on Change Location Name will allow you to update the location name for all events currently at this
location. You can choose a Tax District (if applicable) by choosing a district from the popup menu. Learn how to
setup Tax Districts on page 30.
The map and directions may be included in the confirmations that are printed for people reserving space in events.
When creating your locations records, consider that locations are used to track User Days as well (see page 107).
Because of the relationship between User Days and Locations, it is recommended that you are as specific as possible
when adding and assigning Locations. For example, if all of your events take place on the Snake River, but you need
User Days totals that give you greater detail than “Snake River”, be more specific with your locations; i.e. “Snake
River - South Run”, “Snake River - North Run”, etc.
To select a map from a library of images used by other locations, click “Select from Library”. This allows you to use a
single map for multiple Locations. To add a new map simply copy it from your image editing software and paste it
into the map window. It will automatically be added to the image library.
The best format to use for a map is EPS with a PICT header. EPS images without a PICT header cannot be pasted
into Book’em!. You may experiment with different graphic formats--but most often best results are obtained when a
professional graphic designer provides you with the graphics file. Simply cut and paste the graphic file into the map
window. Often a 72 dpi graphic sized to approximately 6.5” x 6.5” pasted into the logo window works well. Book’em!
will automatically scale the graphic to the appropriate size for your letterhead, etc.
If you don’t have a scanner, Outside Technology can scan your maps and graphics for you and optimize them for
Book’em! (additional service charge), or you may have a local service bureau do it. You can always go back and finish
this later, but the location record will still need to be saved even if no map or directions are available.
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Click on the “Events Button” to see a list of all events at this Location.

Be sure to click “Save” to save any changes when you are finished with the Locations screen.
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Pick-Up Points
The Pick-Up Points database is a tool designed to coordinate the transportation needs for customers
taking part in an event. In just a few steps you will be able to create a detailed itinerary for drivers, staff
or sub-contracted transportation service providers. Below, we’ll create Pick-Up Points, learn how to
assign them to events and Customers and print the Bus Manifest.
Creating Pick-Up Points
Start by creating a new Pick-Up point. Select Pick-Up Points from the Databases menu at the Home screen. At the
QuickSearch screen click “New Record”.

Enter a descriptive name, and appropriate directions to this Pick-Up point. Click “Save” and you will be taken to the
Pick-Up Points list screen. See "In-Common Features" on page 77 for details on list screens.
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Assigning and Creating Itineraries
Now that you have created one or more Pick-Up Points we can assign them to itineraries and then to events. You can
assign Pick-Up Points to either a single event or Recurring Masters. To assign Pick-Up Points go to the Edit Event
screen (single event) or Edit Recurring Event screen (see page 104 for details on editing events).

You may select a preset itinerary by choosing it from the popup menu next to Pick-Up Itinerary. Or, type the name of
a new itinerary into the name field to create a new record. When finished entering the new itinerary name, type Tab
or click into another field. Book’em! will ask if you would like to create a new entry, choose “Yes”.

If necessary, make changes to the Pick-Up Itinerary name and then begin to create the itinerary.
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Click the “Add” button and choose one of the Pick-Up Points you have already created or enter the name of a new
location and Tab (see page 112 for info. on creating new Pick-Up Points).

After choosing a Pick-Up Point you will be asked to enter the minutes this point is from home.

“Home” in this case is the Departure Location (see page 109) for the event. When you are entering minutes from
home, be sure to include time to load/unload in your calculations (you can always change this later, see below).

The buttons along the bottom of the Itinerary window allow you to modify any Pick-Up Point or the Itinerary itself.
Click “Save” when you are finished making changes. This Itinerary now is attached to the event (or all Recurring
Events).
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Assigning Pick-Up Points to Customers
Now that a Pick-Up Itinerary is assigned to an event, as each new reservation is confirmed for this event you will
prompted to select a Pick-Up Point.

Select the Point where this Customer will be picked up. To assign a Pick-Up Point after a reservation had been
confirmed, or to change a previously assigned Pick-Up; from the Event Window, hold down the Alt. key (Windows)
or Option key (Macintosh) while double-clicking the Customers name.The following screen will open.

Clicking on the Pick-Up Point popup menu will bring up a list of your Pick-Up Points, select one and save the
record. This will be saved with the Customers record for this event. If no Pick-Up Point is assigned it will be assumed
that the Customer’s Pick-Up Point is the Departure Location. Here is another opportunity to read (and confirm that
it was read) your cancellation/liability information (see page 18 for more details).
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Printing the Bus Manifest
From the Event Window select “Bus Manifest” from the “Record” menu. If there is a disparity between the number
of reservations and the number of names listed you will get a confirmation dialog.

Choose “Print” (or “Cancel” and make necessary changes). The Edit Manifest Header window will appear.

This is the header scheduled to print on the Bus Manifest. If you would like to make changes to the text of this
header, simply type them into this window now. If you had staff assigned as Drivers or Escorts (see page 64 to learn
how to assign jobs to staff ), they will appear under those headings here (and the Bus Manifest). You can also
manually input their names at this time. Check “Print with Grid” if you prefer the document be printed with grid
lines. In the following example it is not printed with grids.
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Bus Manifest

Your company name, contact information and logo are printed in the upper left corner. The upper right corner
contains summary data on the event. The Departure Location (page 109) is indicated by “Departs...” followed by the
departure time. “Arrival...” indicates the Destination (page 100) listed for this event. If a Driver and/or Escort are not
assigned for this event within the Staff window (page 95), blank lines will print to the right of the Driver and Escort
fields, so that you may manually write staff names on to the manifest.
You may also manually write in a bus number in the space indicated.
The “Home” departure location is listed first with the customers that will be meeting there are listed below the
location. Following the Departure Location are the specific Pick-Up Points listed in chronological order. Customers
are listed under their corresponding Pick-Up Points.
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Equipment and Sale Items
The Equipment and Sale Items database is designed to handle several different but valuable functions.
First, retail and for sale items can be recorded, tax calculated and the transaction tied to the Customer’s
Record. Second, important equipment to be used for an event can be assigned here, linked to a Customer,
sorted by type and printed for use. Third, rental equipment inventory may be stored here, assigned to
customers as they make reservations for other events, or simply for the rental itself.

You may access the Equipment and Sale Items list screen the same way you reach the other database lists. Select
“Equipment & Sales Items” in the “Databases” menu from the Home screen. Choose “All Records” (or search for a
specific item) from the QuickSearch dialog (see "In-Common Features" starting on page 77). In the example above
“All Records” was selected, showing all Items in the database. See page 35 for information on list screens.
Creating a New Equipment or Sale Item Record
To create a new item from the Home screen; select “Equipment & Sale Items” from the Databases menu, at the
QuickSearch dialog click the “New Record” button.
To create a new item from the Equipment and Sale Item list screen; select “Record” from the “New” menu.
In the List screen, the Items’ name, Type, Description, Taxable and Exclude Status are all indicated.
Double clicking on an Item will open the Equipment and Sale Item Record.
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The Item Name, Type and Description fields are self-explanatory, just try to be as specific as possible. The more
specific the Item Name, the more information will appear in other reports and screens. Sell/Use price is where you
will enter either the retail price or the rental fee, etc. Check “Taxable” if you are going to charge sales tax on this item
(see page 30). Check “Exclude from Items Needed Report” if you DO NOT want this item to print on the Items
Needed Report (see page 120).
Adding Equipment or Sale Items to an Invoice
Now that you have entered your Equipment and Sale Items into the database you may add them to Customer’s
Invoice.

Click the “New Item” button at the center of a customer’s invoice. The Choose Item list will appear. Select the item
you want add to the invoice and click “OK” (or double click the selected item).
A new line item will be created on the invoice.

Payment
Window

If the “Tax” box was selected within the item record the “Tax” box on the invoice will automatically be selected, tax
calculated, indicated in the subtotals, and be added to the “Sales Tax Totals Report” (see page 136). You can always
add tax to an item at any time by clicking the “Tax” checkbox. To change tax rates see page 30. If you add tax to an
item from the invoice and then add a discount to this item, be sure to check the tax box for the discount as well to
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calculate the correct totals.
You can add as many items to the invoice as you need, in whatever quantities. Be aware that if you select the line item
in the invoice and change the name etc. of the item, it will appear changed on the invoice but all reports will show it
as the original item. You can delete an item by selecting it and clicking the “Delete” button. For specific information
on the Invoice see page 121.
Sale Items Vs. Items Needed
You can add both retail sale items and specific items you want to be sure are brought to an event for a customer. We
will go over a couple of scenarios below, but how you use this part of the program will vary dramatically depending on
your operation.
Retail Sale Items
Add items a customer purchases to their invoice. This allows Book’em! to handle any Customers transactions you may
encounter. You will be able to calculate sales tax totals, invoice amounts, etc. Just add the appropriate item to the
Customer’s invoice.
If your business handles retail sales that you don’t necessarily want to attach to a customer’s record, create a Recurring
Event titled “Retail Store” ("Recurring Event Masters" on page 40) and a Customer named “The Store” ("Customers"
on page 83). Reserve “The Store” on the “Retail Store” event any time you have unconnected (to a customer) sales.
Items Needed
In addition to retail sale items, Book’em has a valuable tool for rental or any other equipment that needs to be
furnished for a customer on an event. When you are creating the item (page 118) be sure to leave the “Exclude from
Items Needed Report” check box unchecked.
After confirming the Customer’s reservation, choose the item you are providing for the event (see above).
This item (and any others for this event) will be available for printing from the “Items Needed Report”.

The Items Needed Report is found under the Report menu from the Event window. Print this report simply by
clicking the Print button or by printing the To-Do List (page 175). Click done if you are finished viewing the report.
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5. Financial
Book’em! is designed to be a full service financial management database for all monies related to
Customers or Events. Powerful features include: flexible invoicing, receivable tracking, customer
accounts, discounts, staff payroll, sales tax, and more.
Following are detailed instructions for the financial features built into this program.

Invoices
Customer Info.
Invoice Due Date

Line Items
Tax Checkbox

Payment Window

You can access the Invoice from many locations within Book’em! The most obvious one is while in the process of
taking a reservation--the invoice is automatically launched (as long as a default cost is entered for the event). You may
also access any invoice relating to a customer scheduled on an event by selecting their name while within the event
window and clicking the Invoice Button (see "Event Windows" on page 38). You may access all invoices from the
Receivables database (see below). And yet another location to access invoices is from within the customer record.
Clicking on the Accounts Button from within the customer record will open a list of all invoices assigned to that
customer. Double-clicking on a line item will open the corresponding invoice.
You may also create a new invoice (not connected to an event) from within a customer’s record. Simply click on the
“New Invoice” button (see page 86 for details).
Much of the Invoice window is self-explanatory, we will go in to some detail on areas that may not be.
The Customer Info. window enables you to see limited, important information regarding the customer this invoice is
attached to.
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Line Items
Line Items are all the items listed on an invoice. This includes reservations, sale and equipment items, discounts, etc.
You may add a line to an invoice by clicking on the appropriate button. If you would like to add a new customer to
this party, on this invoice, click the New Reservation Button. The reservation process will begin ("Taking a
Reservation" on page 18). To add an Equipment or Sale Item to this invoice, just click the New Item button (see
"Equipment and Sale Items" on page 118). To add a discount, click the Add Discount popup menu.
Modify line items by clicking the corresponding item on the line: description, cost, quantity, tax, or extension.
Double clicking anywhere on a line item or clicking on it once and clicking the Modify button will open the Line
Item Detail Window.

The Detail window gives you tax and cost breakdown information, as well as a chance to modify the text description.
The Delete button will delete any line items. If clicked while a person’s reservation is selected, the cancellation dialog
will be launched and the cancellation process begun. Note: you cannot cancel Kingpin reservation that have stooges as
part of the reservation in this manner. See "Cancellations" on page 60, and "Kingpins and Stooges" on page 54 for
details.
Payment Window
Listed here will be all payments, refunds, gift certificates, etc. associated with this invoice. Double click on a selection
within this window to view the payment detail (see "Payments" on page 58 for more info.).
Invoice Dates
The Invoice Date and Invoice Due date may be changed at any time, simply by clicking within (or tabbing to) the
date field. You can set the default Invoice Due date for the within Preferences, see page 30 for instructions.
Tax Checkbox
If you have a tax district established for the location ("Locations" on page 109) where the event is scheduled, the tax
checkbox will be checked and tax calculated. The same is true with Equipment and Sale items, if they were set up to
have sales tax ("Equipment and Sale Items" on page 118), the checkbox should automatically be checked when you
add the item to the invoice. Any discounts on events or items will have the tax checkbox checked as well. This is
necessary for the discount to be taken off of the before-tax price.
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Edit Message
Click on this button to change the message that will print on the bottom of this invoice.

To set the default message for all invoices, go to the Invoice tab under Preferences. See page 30 for instructions.
The print button will launch your printer dialog and produce an eye-pleasing printed invoice (not to scale).
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Receivables
The Receivables database is not limited to just past due payments. This powerful database lists all unpaid
invoices, current, future and past due.

For general information on list screens see"List Screens" on page 35.
Each record on the Receivables list indicates Customer name, total amount due, Event name, Invoice date, Payment
total, Balance due, and the Invoice due date. An asterisk in the record on the far right indicates that the invoice is past
due.
Select a record by clicking on it once to hightlight it. Double-click a selected record to open the customer’s invoice.
You may sort the records by selecting; event, Date Ascending, Date Descending, or Customers from the Sort footer
popup menu.
Double click on the line item to open the corresponding payment.
Past Due Invoices
Often you may want to only find past due invoices, to accomplish this, click the “Past Due” checkbox. The list will
rebuild, showing only past due invoices.
Apply Payment
Click the Payment button to go directly to the payment screen of the customer’s invoice. As you enter payments the
balance will update on the Receivables List. For a complete refresh of the list see Recalculate, below.
Recalculate
You may refresh the list, update balances and recalculate totals (all and past due), just click on the Recalc button.
For information on creating custom searches within receivables see "Searching" on page 137.
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Customer Accounts
Credit Accounts List

Access the Customer Account List by choosing “Customer Accounts” from the “Financials” menu. All existing
customer accounts will be listed. Credits (you owe the customer) appear as positive numbers in black. If a customer
owes you, the amount will appear in red and are preceded by a “-” symbol.
The net total of all accounts is listed at the bottom of the window.
Select an item by single-clicking it, open the customer’s credit account by double clicking an line item.
Customer Credit Account Window

This window shows exactly when and for what credits and uses (debits) this customer has had. The credits are listed
in the upper portion of the window and contain (left to right): the issue date, the event (and date), the user that
issued, and the amount issued.
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Double click on an entry to open a screen allowing you to edit a credit account entry.

It is here that you can modify a previously entered credit or debit within the Customer account. The event name and
date (if any), the credit is tied to is listed to right of the amount field.
Click within the date field to modify the date. Click in the Amount field name while holding down the Command/
Control key to change the value amount. To help prevent mistakes, this feature is only available to Administrative
level users. It is often better to enter an additional credit/debit to balance an erroneous entry.
Use the note field to track reasons for the credit and to log any changes in the credit account.
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Account Info
There is another way to view customer account information and to quickly access any invoices that exist. Click on the
“Account” button from any Customer record:

The Account Info. screen will show you a list of any invoices this customer has, the balance owed on these invoices, a
summary of Invoice Balance, Account Credits, and Account Debits. The net total will be also be listed.
Double-click on a line item to open the corresponding invoice.
Holding down the Command/Control key while clicking the “Account” from within the Customer record will open
the Customer Account Credit Window (see page 125).
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Discount Editor
The Discount Editor manages any discounts your organization offers. You have the ability to create an
unlimited number pre-determined, automatically or manually applied discounts. From the Financials
menu at the Home screen, select Discount Editor.

The Discount Name, Type and dollar or percentage off are listed. You will also see a checkmark if the discount is setup to be automatically applied (see below). To toggle the Auto Apply feature on or off from this window, select the
discount and click to “Auto” button. To perform an action on a Discount, click it once to select (or double click) it.
Then choose to either delete, create new, or edit. When you are finished with the Discount Editor, click the Done
button.
Click “New” to create a new Discount.

Give the discount a name that all users will recognize easily. You may choose whether you want the discount to be a
fixed dollar amount or a percentage.
The Discount Editor provides numerous criteria that will cause the discount to be automatically applied to an invoice.

128 Book’em! User Guide

Discount Editor
Clicking on “Based On” criterion will provide you with qualifying conditions to identify the auto-apply parameters.

Individual “Based On” criteria have different qualifiers that will activate when the criteria is select. After choosing the
auto-apply qualifiers, you may select which trips to apply the discount to by clicking the Set Apply List.

Checked events will have the discount automatically applied. Click the event once to toggle auto-apply on or off.
Click the “All” button to toggle all events to auto-apply, the “None” button will turn auto-apply off for all events.
Click “Save” to save your changes, “Cancel” to cancel your changes.
NOTE: Discounts are automatically calculated based on the default cost set in the Price field of the event. If the cost
is changed on an individual invoice, you will need to manually adjust the amount of the discount.
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Payroll
Book’em! contains powerful features to help you manage staff payroll and commissions. Working in
conjunction with your current payroll service or system, the Book’em! payroll function can greatly simplify
the process of verifying employee wages and events worked.
The first step is to set-up your payroll system. You do this in the Payroll section of Preferences (see page 31 for
details). Of course, you also need to have staff assigned to events with pay and/or commission amounts established.
See page 95 for information on assigning staff to events.
Then it is just a matter of Running your Payroll. Select Run Payroll from the Financial menu from the Home screen.
If this is the first time you have run payroll, you will be prompted to enter the start and end date of this pay period.
Remember that “31” represents the last day of the month for all months (Book’em! will automatically designate the
correct number of days for the month). For more on this see page 31.

Run Payroll.

9/14/2000

If this is the first time you are running payroll, you will be asked to identify the start and end date of this pay period.
If this is not the first time you have run payroll, you will see the above screen upon choosing “Run Payroll”. Previous
payroll end dates will be listed in the window on the left. You can choose a previous payroll from this list to run or rerun. Select Current Pay Period to run, well...the current pay period.
Rebuild Files from Work Events
Check here to have the program build the payroll by checking current staff assignments from that pay period. This is
helpful if you have made changes to staff assignments after a previous payroll was run. This option is not available for
current pay periods, as all staff assignments will be up-to-date.
Ignore Empty Events
Book’em! will check to see if there are any events without staff assigned before it completes payroll. Check here if you
do not want this list to included empty (no reservations) events.
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Edit Pay Slips
Click the Edit Pay slips button to see a list of all current pay period staff assignments and pay amounts.

Double click on a line item to view detailed information or to make changes.

You may make changes to the Commission or Pay amount prior to printing the pay slip.
When you are ready to run the payroll, click the “OK” button in the Payroll Setup window (above).
The program will check to see if there are any events within the payroll period that do not have staff assigned. If you
do not want it to notify you of empty events (no reservations) without staff see page 130. If Book’em! locates events
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without staff assigned, you will given several options.

You may stop running payroll, recheck for events without staff assigned, continue with payroll (knowing that there are
events without staff ) or select an event for staff assignment. To select and event, click on it once, and then press the
“Select” button (which will activate when an event is clicked on once).
A window allowing you to assign staff to specific events along with pay amounts, job titles, etc.
Continue until you are satisfied with staff assignments and then click the “Continue” button.
The Payroll Report will be printed.

20

30
20

10

10
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Payroll Records
If at any time you need to access payroll records they are stored in the Payroll Records list.

Clicking on the left popup menu will list all active staff, select a staff member from the list to view only their payroll
records. The right popup menu lists all pay periods, listed by their ending date. This list works much the same as the
other lists within Book’em! Go to page 35 for more information on searching, sorting, and navigating in List Screens.
Double click a payroll record to open the detail view.

The detail view will list all events this staff member received payment for within this pay period.
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Transactions
From the Financial menu at the home screen, select Transactions. It is here that all Book’em! transactions
are stored in a list that is easy to search, sort and access. Customer payments and refunds, staff payroll etc.
will all be listed here.

The transaction date, staff name (for payroll transactions), customer name (for customer transaction), the item (event,
retail sale, payroll, etc.), amount of money in and out are listed within this database. Clicking the popup menu at the
footer of the screen brings up a list of Quick Searches.
The Period Shown fields on the left indicate the current date range displayed. You cannot enter dates into those fields.
To enter a date range, click on the popup arrow and select Choose Dates. You then will be able to enter a start and
end date for your search. “Date” refers to the payment date, not the event date.
For more complex searches, use the Search Editor. See "Searching" on page 137 for details. For more information on
list screens in general see"List Screens" on page 35. For sorting options see "The Sort Editor" on page 141.
Once the desired selection is shown, choose Print from the File menu. Or use the Report Editor (see page 176) to
create a custom report. You may also choose Export from the File menu to send the data to a spreadsheet or
accounting program. Before exporting, be sure to learn the file formats that the software will accept. See "Exporting"
on page 143 for details.
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To view the details on a listed transaction, double click on the desired transaction.

You may make changes to the Payment Date, Payment By, Notes and CC validation fields. This is generally done to
correct errors. Editing the Money In and Money Out fields is not recommended. It is better to create a new payment
(or refund) to balance out any errors made to these two fields. If it is necessary to change either of these fields,
administrative level users may activate the field by holding down the Control/Command keys while clicking on the
field name. Changes may be made to these fields but the program will not save the record with a zero balance within
the transaction.
If a credit card was used as the method of payment, the credit card number will automatically be added to the Notes
field within the transaction.
In the interest of maintaining accounting integrity, payments cannot be deleted. Instead of deleting, add a
counterbalancing payment containing an explanation of the reasons for the entry.
The Invoice, Customer, and Event ID numbers are listed in the bottom left of the window. These ID numbers can be
helpful when performing searches within the Transactions table well as others).
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Sales Tax Totals

Selecting Sales Tax Totals from the Financials menu at the Home screen will bring up the following window. Select
the Tax District and date range (using the popup lists or enter manually) you would like to obtain totals for and click
the “Calculate” button. Following some calculation time the sales and tax totals for all three tax categories will be
listed. You will also receive a total for all categories. For information on setting up sales tax functions see page 30.
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6. Program Tools

Searching
A core function of any database is the Search. Your database may contain thousands or even millions of
records and without powerful search tools would be unmanageable. The next section will help to
familiarize yourself with many of the built-in search tools. Creativity and a logical thought process will
go a long way towards developing powerful and useful searches.
QuickSearch
One way to get right to a specific record is the Quick Search built into the access commands in the Databases Menu
at the Home screen. Choose All Customers (or other table) or any similar command and what is entered in entry field
determines how specific the search will be. All of the records that match your entry will be found. It is fine to use
partial entries (i.e. instead of “Jones” enter “Jon”, all records beginning with “Jon” will be found.

Click the “New” to create a new record. See "In-Common Features" on page 77 for details on the QuickSearch
dialog.
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Reservation Finder
The fastest way to find a specific Customer, enter a new record, or go to the reservation on an event is the Reservation
Finder.

For details on the Reservation Finder see "Finding Reservations" on page 67.

Searching Basics
The term “searching” refers to finding a group of records in the database based on the contents of one or more fields.
You perform a search by specifying a search condition. A search condition is a set of instructions that tells Book’em!
which records to include in the new current selection.
A search condition always has three elements: field name, comparison operator, and value. The field name is from the
current table or a related table. The comparison operator tells Book’em! how to compare the contents of the field to
the value you specify (equal to, greater than, less than, and so forth). The value specifies the number, string, or other
value to which each record is compared.
Suppose you want to see all the records for customers who have done more than 3 events. The search condition you
would use is “Events is greater than 3.” “Events” is the field in the Customers table, “is greater than” is the comparison
operator, and “3” is the value.
When you do a search, Book’em! compares the contents of the field in the search condition to the value you specify.
The new current selection is made up of records that meet the search conditions. The new current selection can be no
records, one record, a group of records, or all the records in the table.
Comparison Operators
When you write a search condition, you tell Book’em! how to compare the value you specify to the contents of the
database. For example, the search condition, “Last Name equals ‘Smith’” uses the “is equal to” comparison operator. It
tells 4th Dimension to compare the values in the Last Name field to the string “Smith.”
Comparisons involving alphanumeric values are not case-sensitive. A search on the last name “Smith” will find
records containing “smith,” “SMITH,” “sMith,” and so on.
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The following comparison operators are available:
•
•
•
•
•
•
•
•

Is equal to,
Is not equal to,
Is greater than,
Is greater than or equal to,
Is less than,
Is less than or equal to,
Contains,
Does not contain.

Searches using the Contains and Does Not Contain operators are always sequential searches and will take longer to
execute.
Conjunction Operators
You can search on one or more fields. A search on one field is called a simple search. For example, the search “Last
name equals ‘Smith’” is a simple search. When you do a simple search, 4 th Dimension examines the contents of one
field when searching the database.
A search on two or more fields is called a compound search. When you perform a compound search, you combine
separate search conditions using a conjunction operator. The conjunction operator tells 4 th Dimension how to
combine the results of the individual searches. There are three conjunction operators:
• And: This operator finds all the records that meet two conditions simultaneously. For example, the
search condition “Find all the employees who work in the engineering department and who make over
$50,000” will find the records of only those engineering employees who make over $50,000.
• Or: This operator finds all the records that meet either of two conditions. For example, the search
condition “Find all the employees who work in the engineering department or who make over $50,000”
will find the records of all the people in the engineering department, as well as all the people who make
over $50,000 regardless of the department in which they work.
• Except: This operator is the equivalent of “not.” The search condition “Find all the engineers except
those who make over $50,000” will exclude the engineers making more than $50,000.

The conjunction operators let you create compound search conditions such as “Find the customers with zip code
greater than 94000 and less than 95000.”

The Search Editor
The Search Editor is a general-purpose editor that can be used to create simple or compound search conditions. The
Search Editor lets you create compound searches linked with the And, Or, or Except conjunctions. For example, you
can perform a search for all prospects who live within a range of zip codes who have not received a certain mailing. Or
customers who have done more than 2 events whose last event was greater than six months ago.
The Search Editor lets you save search conditions to disk. Use the Search folder in your Book’em! folder to save into.
You can open search conditions when you want to repeat the search. The saved search conditions will then operate
based on the records currently selected.
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The Search Editor:

Criteria

Field Area
Operator

Value
Conjuction

• Criteria area: This area displays the search conditions as you create them or after you load them from
a disk file.
• Field area: Displays the names of the fields in the current table. Indexed fields are shown in boldface.
• Operator area: Displays a list of comparison operators.
• Conjunction area: Contains three buttons that correspond to conjunction operators you can use to
join several search conditions into a compound condition.
• Value area: Enter values for which you want to search in this area.
• Search Editor buttons: Use this area to save your search conditions, load other search conditions
from disk, cancel the search, search within your selection (instead of entire list) or execute the search.

To create a search condition, follow these steps:
1. Choose “Search” from the Tools menu (or Command/Control-S) of the List Screen of the table you want to search.
The Search Editor is displayed, with a blinking marquee around the Field area.
2. Click a field name to use in the search condition. The field name appears in the Criteria area and the marquee
moves to the Operator area. Expand the field name list when necessary: on Windows click the small “+” sign to the
left of the field name, on Macintosh click the arrow symbol to the left of the field name.
3. Click a comparison operator.
4. Type the value for which you want to search.
5. If you want to create a compound search condition, click one of the conjunction buttons (And, Or, Except) and
repeat steps 2-4.
Compound search conditions are evaluated in the order in which they appear (from top to bottom.) The order in
which conditions are entered can affect the results of the search. You can modify existing parts of the condition by
clicking the area you want to change and selecting or typing a new entry. In a compound search you can remove one
line by clicking on the Delete Line button.You can remove search conditions by choosing Clear from the Edit menu,
or by using the Clear All button.
If you want to search only the records in the current selection, click the Search in Selection button.
6. To save the search condition as a disk file, click the Save button and enter a filename in the Create File dialog box.
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Anytime the saved search is used, it will be performed on your current data. You do not need to save the search
condition to perform the search.
7. Click the Search button to perform the search or click Cancel to quit the Search Editor.
8. To load a saved search:
• Click the Load button.
• Locate the search file you saved and open it.

Sorting
A list of records yields different meanings based on how it’s sorted. It is common to sort records for screen
viewing, before printing reports and lists, and before graphing.
Sorting Basics
You can sort records on up to 30 different fields or formulas. Each field you sort on is referred to as a sort level. The
first field or formula is the primary sort field or formula. The others are secondary. Thus, if you sort customers by last
name and first name, last name is the primary sort field and last name is the secondary.
You can specify either ascending or descending order for each field or formula that you are sorting on. Sorting from
A-Z, smallest to largest, earliest to latest, is an ascending sort. Sorting in the reverse order is a descending sort.
The Opening Sort
Records are stored by the program in the order in which you enter or import them, but every table is sorted
automatically when it is first opened. All people tables are sorted by last name, first name.

The Sort Editor
To sort all records in a table, choose Sort All from the Tools menu of the table’s list screen. To sort only the records in
the current selection choose Sort Selection. You might want to do a search to narrow the selection before sorting.
Command/Control-T will open the Sort Editor to sort the selection.
The Sort Editor contains the following areas:
• Fields List: Displays the names of the fields in the current table. Indexed fields, which are the fastest
to sort by, are shown in boldface.
• Criteria Area: Displays the sort fields or formulas and the order of the sort. The field or formula in the
first row of the Criteria area is the primary sort field or formula. The arrows on the right of this area are
used to specify an ascending or descending sort. Click the arrow to change its direction.
• Edit Formula and Add Formula buttons: Use these buttons to write or edit a formula as one of the
sort levels. Use a formula when you want to sort on something that is not a field, such as a calculated
value or a portion of a field. Experiment here if you like, but unless you have experience with 4th
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Dimension language this feature will probably be more hassle than it’s worth.

Criteria
irection
Fields list

Built Sorts
At the bottom of most List Screens is a popup containing several useful pre-built sorts and searches. Some items
combine searches and sorts. See "The Popup" on page 36 and "Search Tools" on page 91.
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Import/Export
Book’em!’s Import and Export Editors allow you to bring data in and send data out. This is a great tool
for such tasks as adding records from external sources like purchased mailing lists or other databases,
sending a disk file of customer records to a mailing service, or sending financial records to a spreadsheet or
accounting program.
The import and export editors have been developed to have a consistent interface with each other so that
the import/export process is a simple one. The import editor provides for the preview of data before the
import process, to ensure proper field alignment.
Exporting
To access the Export Editor you must be at the list screen of the table you want to export. Select the records to be
exported. See "Selection Methods" on page 35. Then choose Export... from the File menu.
There are eight primary sections in the Export Editor.
1. Field List
The list on the left represents all the fields which are available for the export process.

Field List

Selected Fields

Format Menu

2. Selected Field List
The list on the right will contain the fields which you have selected to be exported. The order of the list determines
the order of the export, and this is important information when the data is finally used.
There are four different methods for filling this list.
• Select the All >> button. This will move all the fields in the Field List to the Selected Field List.
• Select field in Field List and click Append >>. This will add the selected item in the Field List to the
bottom of the Selected field list.
• Select field in Field List and click Insert >>. This will insert the selected field before the highlighted
field in the Selected field list.
• Double click a field to send it to the Selected Field List.

To remove a field from the Selected Field List, select it and click the Remove button.
Selecting Clear will clear the Selected Field List.
3. Field Length Entry Object
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This is where you enter the maximum column length for the selected field in the Selected Field List. This entry object
is only available when you have selected Fixed Length in the format popup.
4. Format Popup
Allows the configuration of the various Import formats supported. There are six (6) formats supported by The
Import/Export Editor:
•
•
•
•
•
•

Standard Format (Most common format for exchanging data with other applications)
Fixed Length (Common format used on Mainframe and some PC based systems)
DIF (Data Interchange Format)
SYLK (SYmbolic LinK format)
DBF (DBASE Format) (Standard DBASE formatted data — including FoxBase)
Internal Format (Internal Database format - 4D format)

If you have selected to export the data in PC format; an additional character (ASCII 10) will be added to the record
delimiter.
5. Field and Record Delimiters
Allows the configuration of Field and Record delimiters to be used when exporting the data. See "More on
Delimiters" on page 147 for more information.
6. Save Script
Provides the ability to save the current Export parameters defined in the export editor to disk for later retrieval.
7. Load Script
Provides the ability to load a previously saved Export script.
8. The Export button
This is where the actual export process begins. When you have properly configured the export editor this item will
become enabled. When you select Export, you will be presented with the standard save dialog where you can define
the name of the file you are exporting.

When you have defined the name of the file you wish to export, clicking the “Save” button will begin the export
process. During exporting, you are presented with a progress message as to the current status of the export. You may
work in other areas of Book’em! while the records are being exported.

Importing
To access the Import Editor you must be at the list screen of the table into which you want to import. Choose
Import... from the File menu. IMPORTANT: Always Back-Up your datafile before you begin any importation
process! See "Backups" on page 193 for details.
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There are twelve primary sections in the Import Editor.

1. Field List
The list on the left represents all the fields which are available for the import process. If a field exists in the import file
which you do not want to import, select <Skip> for the corresponding line.
2. Selected Field List
The list on the right will contain the fields which you have selected to be imported. The order of the list determines
the order of the import, and the order must match the file being imported.
There are several different methods for filling this list.
• Select the All >> button. This will move all the fields in the Field List to the Selected Field List.
• Double-click the field name to move it to the Selected Field List.
• Select field in Field List and click Append >>. This will add the selected item in the Field List to the
bottom of the Selected field list.
• Select field in Field List and click Insert >>. This will insert the selected field before the highlighted field
in the Selected field list.

To remove a field from the Selected Field List, select it and click the Remove button.
Selecting Clear will clear the Selected Field List.
Selecting Info will display detailed information about the currently selected field in the Field List.
3. Preview
This button looks like a magnifying glass and is located in the upper right hand corner of the window. It provides the
ability to preview data before beginning the import process. When the preview button is selected, you will be
presented with the Preview Editor, page 147.
4. Field Length Column
This column will show the maximum column length for the selected field when you are importing data in Fixed
Length format.
5. Field Length Entry Object
This is where you enter the maximum column length for the selected field in the Selected Field List. This entry object
is only available when you have selected Fixed Length in the format popup.
6. Format Popup
Allows the configuration of the various Import formats supported. There are six (6) formats supported by The
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Import/Export Editor:
•
•
•
•
•
•

Standard Format (Most common format for exchanging data with other applications)
Fixed Length (Common format used on Mainframe and some PC based systems)
DIF (Data Interchange Format)
SYLK (SYmbolic LinK format)
DBF (DBASE Format) (Standard DBASE formatted data — including FoxBase)
Internal Format (Internal Database format - 4D format)

If you have selected to export the data in PC format; an additional character (ASCII 10) will be added to the record
delimiter.
7. Add Keyword Checkbox
Allows a keyword (see page 79) to be entered for all records being imported. The keyword does not have to exist
before entering it here.
8. Add Notes Checkbox
Allows you to enter text which will be saved to the Notes field of all records being imported.
9. Field and Record Delimiters
Allows the configuration of Field and Record delimiters to be used when exporting the data. See “More on
Delimiters” on page 147.
10. Save Script
Provides the ability to save the current Import parameters defined in the export editor to disk for later retrieval.
11. Load Script
Provides the ability to load a previously saved Import script (see section #8).
12. The Import button
This is where the actual import process begins. When you have properly configured the export editor this item will
become enabled. When you click Import, you will be presented with the standard get dialog where you can select the
file you are importing.
Before you start the actual import open the Preview Editor (described below), to be sure your import fields match the
field of the data you are importing. The magnifying glass icon in the upper right of the import screen opens the
Preview Editor.
Once the importing begins, a thermometer will indicate progress. You may work in areas of the database other than
the file being imported into while the records are being imported.
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Preview Editor
There are seven primary sections in the Preview Editor.

1. Import File Format
File format you have selected in the Import editor.
2. Preview File Information
Detailed information about the file you have selected for preview. The following information is provided:
• Filename contains the full pathname to the file you are importing. If this file pathname is too long to fit
in the defined area, it will be reduced to the drive name and the actual filename.
• File Size in bytes

3. Import Field List
Popup used to define the associated import field for the selected line. This popup list is the same which is displayed in
the Import Editor field list. If you wish to skip a field during the import process; select <Skip> for the desired line.
4. Data Preview
Contains a row for each field in the file you are previewing. This provides a visual look at the actual data you are
previewing. This makes deciding which import field to associate a simple process.
5. Current Record and Total Record Count
This will display the current record and the total records in the file you are previewing. If you are importing a file
where the total number of records to be imported is unknown (usually Standard Formatted files as they typically don’t
have a record header), the Total Record Count will be estimated (symbolized by ≈).
6. Next and back arrow buttons
Reads the next or previous record for the file you are previewing. There will be times when data is missing from a
particular record. By providing the ability to see the next record, you may be able to better determine what type of
data is stored in the selected field.
7. Copy
This will copy the current configuration of “Import Fields” to the Import Editor to make the import process easier.
Take note that in the above screen shot, the selected data address corresponds to the Import Field, Address field. If
these did not correspond, simply select the incorrect item in the Preview Data and use the popup menu (labeled Select
Field) to identify the correct Import Field. Changes you make will apply to the remainder of the import.
More on Delimiters
Any program that imports data needs to know when to move to the next field and when to create a new record.
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Therefore, programs that export data place “delimiter” characters in between each field and each record.
When you are exporting from Book’em! it is important to know which delimiters are supported by the intended
destination; when you are importing you must know which delimiters have been used in the file to be imported.
The Macintosh standard is TAB (ASCII character 9) for the field delimiter and RETURN (ASCII character 13) for
the record delimiter. This presents a problem if the file contains text fields (like the Notes field in Book’em!) which
may contain embedded carriage returns. These will be interpreted as a signal to create a new record.
There are some work-arounds for this problem. If you are exporting and can also control the delimiters on the
destination end, substitute another character for the record delimiter--23 is a safe choice. If the file will be sent to a
mailing service or other person or business, be sure you tell them that the delimiter is not standard. If you are
importing, you can open a copy of the original file in a word processor, choose the ‘Show Hidden Characters’ or
‘Show ¶’ mode, and use Search and Replace to tweak the file. This method is particularly useful if importing a
download from an online service. Work only on a copy; keep the original intact in case you need to start over.
If a problem file is being imported it is useful to use the Add Keyword option (see "Add Keyword Checkbox" on page
146) so that the records may be found and checked easily when the import is complete.
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The List Editor
The List Editor contains the diet, calender activities, staff certifications, staff jobs, salutations and sources
lists. Here you can add, modify, reorder, or create new items within the lists.

In the above example, the Diet list is selected from the popup menu. This lists all diets currently entered in this list.
By double clicking on a list item it will appear in the modification box to the right. Once in this box, you can change
the name or delete that item. Click the Modify button to save any changes (not necessary for deletions). With an
empty modification box, click the Add button to add a new list item.
By default, the list items are sorted by initial creation date. Check the Sort Alphabetically box to well, sort the list
alphabetically. Or, option (Macintosh)/Alt (Windows) drag a list item to re-order how items will appear in the list.
You will notice that with the Source and Diet lists you are given the option to “Rebuild from Data”. Both of these lists
allow entry of new list items from the Customer record (see page 91). Occasionally, you may want to update your
master list to indicate list items that have been entered from the Customer record, but not added to the list.
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Find Duplicates
Even with rigorous checking before creating new records, your database will probably contain some
duplicates after a while. Imported mailing lists, misspellings, and hurried entry are likely causes. Once in
a while it is a good maintenance practice to use Book’em!’s Find Duplicate utility to weed them out.
Choose Find Duplicates from the File menu of any of the people table list screens.

The small scrolling list on the left shows the checkable fields for the current table. Indexed fields are shown in
boldface Macintosh) or are preceded by an asterisk (Windows); non-indexed fields will take more time to search if
the table contains more than a couple thousand records.
Normally you would want to filter out empty values; finding people with no address entered, for example, will not
help in finding dupes. But if you do want empty values to be included you may mark the Show Empties checkbox.
The All and Mail List Only radio buttons allow you to determine whether to filter out records that are marked No
Mail.
Select the field to check for duplicates and click the Find Duplicates button. If there are more than 2,000 records in
the table Book’em! will ask if you’d like to restrict the search.

This feature allows you to bite off the chore in manageable chunks; deal with a batch now and come back to it later.
During the search the Progress Thermometer is shown. You may work in other areas of the program while this is
executing.

Analysis
When either the specified number of duplicates have been found or the entire table has been searched, the results are
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shown.

If any duplicate values exist, all records (unless the No Mails are filtered out) matching the value are shown.
Searches on different fields will reveal different sets of duplicates if there are misspellings or other entry differences. If
the Address field is searched, for example, 25 Elm St. #4 and 25 Elm St. Apt. 4 will not be caught. A Last Name
search, though, would likely catch it.
In the example above we can see several records that need to be dealt with.

Strategy
The recommended method of handling duplicates is to open each record and examine the history. Select the record
and click the Open Record button.
It is likely that only one of the records has an event history; this is the one to keep. Check the Initial Contact field to
see which record is more recent. Any valuable information from the other record may be copied over to the keeper
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before it is deleted.

Once you have determined which records need to be deleted, they may be selected from the list by Command/
Control-clicking on each record to be deleted and clicking the Delete button. You may also use the Delete button on
the individual record during inspection.
It is up to you whether to send mailings to different members of the same household. If you decide to send only one
mailing, you may select other members and click the No Mail button.
Once a record has been deleted or marked No Mail using the buttons on the Find Duplicates layout it disappears
from the list.
Remember that if the All radio button is selected, people who are already marked No Mail may appear on the list and there is
the danger of marking all members of the household No Mail. It is, however, still valuable to do the ‘All’ search to find
actual duplicates.
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Mail Merge
Book’em! includes a word processor which you may use to send personalized letters to anyone in your database.
There are two mail merge locations within Book’em!, one is described below and is best used when you are sending a
letter not related to an event. The other is from the event window and is best used when the letter relates specifically
to an customer registered on an event. This feature is described in detail in "Confirmation Letters" on page 73.
From the List Screen of any of the people tables, select the people you want to send the letter to and choose “Send
Letter...” from the File menu. To select multiple records directly, hold down the Shift key and click for continuous
selection, or Command/Control to add individuals. Command/Control-A will select all records shown. Command/
Control-G will show all records if the selection is reduced.
Or, if you are in an individual record, click the “Mail Merge” button.
The Select Letter Dialog opens.

Select a letter from the list to enable the Edit and Merge buttons. If you are just starting to use Book’em! the list is
empty.
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Creating a New Letter
Click the New button (or Command/Control-N) to create a new letter.

Name the letter. Every letter must have a name before it can be saved. TAB once so the cursor is active in the text
area.

154 Book’em! User Guide

Mail Merge
Look in the Merge menu and popup to locate available merge items.

Each table has its own set of available variables. For this example we’ll use the Customers table. NT preceding the
field name indicates Next Trip, LT indicates Last Trip.
Select Heading from the Merge menu and release the mouse. The Heading variable will print the date the letter is
printed and the person’s return address.
Now press Return twice and select Dear... from the Merge menu. How this line reads depends on whether you have
selected a salutation for the person written to. See "Entering Personal Information" on page 84 for details.
Press Return once again and begin composing the letter. The more general the letter, the more reusable it will be in
the future. For example, instead of referring to a specific event by name, insert the variable Last Trip or Next Trip,
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depending on the context.

When Book’em! prints the letter, it will insert the correct values based on the person’s record and reservations status.
The font, font size, and font style may be set (for the entire document) by selecting text and applying the
characteristics from menu commands.

Saving/Save As
When you are finished writing the letter, click Save. You’ll return to the Select Letter dialog and be able to merge it.
If you have opened an existing letter for modification, saving the letter with the original name will replace the old
letter with the new one. Changing the name will cause the new letter to be saved while leaving the original intact.
This is equivalent to the familiar “Save As...” menu command.

Printing the Letter
From the Select Letter dialog, select the letter and click the Merge button. The letter will be printed for each record
in the current selection, with the variables replaced by data specific to the person. Remember that not all variables will
be meaningful to all records. For example, if the Next Trip variable is included in a letter to a person who has no
upcoming reservations, the variable will print as an empty space.
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The Calendar
The Calendar is one of Book’em!’s four Event Launchers. The other three are the Home screen, the OneTime Events list, and the Reservation Finder. The Calendar may be opened with Command/Control-K
from anywhere, or by selecting Calendar from the File menu. You may also tell Book’em! to automatically
open the Calendar at startup by checking the box in the Preferences dialog.
The Calendar gives a substantially different view of your events than the Home screen because all events,
including one-time events, are shown together without regard for type.
The Calendar can remain open while you work in other areas of the program. Using the window’s close
box (Command/Control-W) will hide the Calendar but hold it in memory so it opens instantly when you
select it from the floating Windows menu or press Command/Control-K.
The Calendar opens to the current month. There are two Calendar views available. You can select your preferred view
by opening the File menu, selecting Administration and clicking the “Modify” button for the user you wish to change
the view for.
This is the “Emphasize Events and Reservations” view.

In general, this view is most often preferred for users whose primary job centers around events and reservations as
opposed to contact management.
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This is the “Emphasize Contact Management” view.

In general, this view is preferred for users whose primary responsibilities center around sales and contact
management.
For the sake of consistency, we will use the first (Emphasize Events & Reservations) view for the following
description of features.
Navigating
Days that contain at least one event or one appointment are shown with a blue background.
Clicking on a day will cause any events which begin on the selected day and any appointments for that day to be
listed.
Clicking the arrows will move the selected month forward and backward, and will change the year if moving forward
from December or backward from January. The month indicator is a popup menu; you may go directly to any month
by selecting it. You may change the year by direct entry followed by a TAB. Two digits will suffice: entering 96 will
access 1996. Entering 02 will access 2002.
Near the top of the screen is the current day and date. Clicking the “Go to Today” button will return you to the
current day from anywhere in the calendar.
Making Reservations & Launching Events
If an event is selected from the list, the New Reservation button is activated. Click it to begin the sequence described
from page 50 through page 58.
The event’s record may be opened by either selecting it and clicking the Modify button, or by double-clicking it.
Creating New Events
To create a new event from the Calendar, first select the day you wish to add the event to and then go to the Create
New Event popup menu and select the event you want to add. The corresponding Edit Event window will open,
allowing you to make any necessary modifications. The new event will appear on the Calendar.
Appointments
Book’em! provides appointment handling as a contact management and sales tool. It should not be used to track things
that could be handled through the Events table. For example, if you offer private lessons, individual consulting, etc.,
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either create a recurring event master of that type, or enter them as one-time events. The Appointments table does
not make the relational connections with the entire program that the Events table does. For more details on
appointments see page 81.
Be sure that the user popup is displaying the appointments for the proper user (it will continue to show the last name
selected.
New Appointments
Appointments are most frequently created from the Record Screen of the person the appointment is with, but a new
one may be created at the Calendar if the person’s record already exists in the database or for general, unconnected
appointments. Click the New button below the Appointments Area.
Choose the database the person’s record is in (Contacts, Staff or Customers). Or, select General (unconnected) if
there is no person in the database relating to the appointment.

Type in all or part of the person’s last name and TAB. Either click the line of the person and click the Select button or
double-click the line. The Make Appointment window opens with the currently selected calendar date entered. It
may be changed. Enter the times and any notes about the meeting. The notes are accessed only with the appointment
and are not saved to the person’s main record. Save the appointment. See page 81 for more information on
Appointments.
Manipulations
If an appointment is selected from its window on the Calendar, the Cut, Copy, Recurring, and Modify buttons are
enabled. The Copy button copies the appointment information to Book’em!’s internal clipboard. The Cut button
deletes the appointment and copies the information. If there is appointment information on the internal clipboard the
Paste button is enabled. Select the new date and click Paste.The Modify button opens the appointment.
The standard Command/Control keys, X (cut), C (copy), and V (paste) will work, but selecting them from the Edit
menu will not. Unfortunately, 4th Dimension does not allow any developer control of the Edit menu.
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You may use the Recurring button to duplicate an appointment at any interval you choose.

The interval refers to the radio button selection. The figure shows the appointment being repeated once every day for
a total of 12 appointments. If the date is the last day of the month and the radio button selection is Months, it will be
created for the last day of each designated month regardless of the day number. If the date is the 29th or 30th and is
not the last day of the currently selected month and the button selection is Month, the calculation is impossible and
no records can be created.
Printing
The currently selected month can be printed by choosing Print from the File menu, or Command/Control-P. Events
will show in their appropriate days, along with the number of reservations at the time of printing. See "Events
Listing" on page 170 for more information on printing the Calendar.
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Label Spool
Records in any of the people tables may be sent to the Label Spool by clicking the Spool Label button in a
record screen or by selecting records from a list screen and choosing Spool Labels from the File menu. There
are Spool Label checkboxes in the Mail Merge and Apply Mailing dialogs. If the Preferences option is
taken, new reservations will be automatically sent to the spool. Also, you may manually add people to the
spool that do not have records elsewhere in the database.
The concept behind the Label Spool is to allow you to accumulate records of people that you need labels
printed for as you work, and also to consolidate all of the label printing tools in one place. If you are
running Book’em! with 4D Server, labels from all users are sent to one spool so that one user may print all
accumulated labels.
To access the Label Spool, select it from the File menu.

Any names you have saved while working in other areas of the program are shown. You may convert any selection of
records to ALL CAPS or Upper and Lowercase (Title Case) by choosing the appropriate command from the Tools
menu.
Double-click a line to see how the formatted label will look.

Click the Modify button if you’d like to change anything.

Permanent/Temporary
The Label Spool is intended to be a temporary file. After printing, the records should be deleted at once so they are
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not reprinted in error.
But there may be some people that you need labels for on a continuing basis: a business contact, insurance agent,
landlord, rep., etc. You may mark them permanent by selecting them and choosing Make Permanent from the Label
Spool menu. Among the printing options are Print Temporary, which will not print any records marked permanent,
and Print Permanent, which will print only the records marked permanent.
When Delete Temporary is chosen from the Label Spool menu, only the records not marked permanent will be
deleted.

Printing Formats
Choose the printing format from the popup menu in the footer area of the Label Spool list.

• 3x10 will print to the standard Avery 5160 laser labels, 3 across by 10 down.
• 2x3 prints shipping labels using Avery 5164 format. To use this format, after clicking the first printer
dialog, select the 2X3 layout Label Editor and click OK (see below). No other changes need to be made
to the Label Editor.
• Continuous prints to a continuous feed dedicated label printer like the CoStar or Seiko. Be sure the
appropriate printer is selected as the default printer. If the spacing is not correct for the label/printer
combination you use, you may use the Label Editor (see below) to customize.
• Envelopes prints a standard business envelope. When you make this selection you may set your
printer’s envelope feed: left, center, or right.
• Custom and Open Saved allow you full access to the 4D Label Editor. Instructions are in the next
section.

If the Return Address checkbox is marked and you are using the 3x10 format, any unused labels on the sheet except
for the last one will print with your return address.
When the Format Popup and Return Address Checkbox are set to the options you use most frequently, choose Save
Settings from the File menu and these settings will be the default whenever you open the Label Spool.
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The Label Editor
4th Dimension's Label editor provides a convenient way to print a wide variety of labels.
Using the Label editor, you can do the following:
•
•
•
•
•
•

Design labels for mailing, for file folders and file cards, and for many other needs
Specify the font, font size, and style to be used for the labels
Specify the number of labels across and down on each page
Specify the label page margins
Load and save label designs
Print labels to a printer or Direct ASCII driver

The Label editor contains facilities for designing labels to display fields in a label format. For instance, when
producing mailing labels, you want a label design that includes the person's first and last name on the first line, his or
her street address on the second line, and so on.
As part of the design, the Label editor allows you to specify the number of labels on the page and margins of the label
paper so that the label text appears centered within the labels.
When you create a label design with which you are satisfied, you can save the design to disk so that you can reuse it at
a later time.
To open the Label editor, follow these steps:
1. Open Label Spool, select the records you want to print labels for, choose “Custom” from the popup menu at the
bottom of the screen, and Print Selected.
2. Click the settings that apply to the labels you will be using and click the OK button.
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Label Editor Window

The Label editor contains the following:
• Fields lists: This list displays the names of fields in the current table.
• Toolbar: Tools to add shapes, borders, etc. to your label design.
• Label layout: This layout area is used to preview your label format.
• Form to Use: This popup menu lets you bypass the Label editor and use the output layout to print
your labels. If you are using the Label editor to create the label, do not select the Use Layout check box.
Use this to access the layout for 2x3 shipping labels.
• Static Text Box: Enter text here that you wish to print on all labels. This text has no relationship with
any record data.
• Object Look: It is here that you may change the Border, Fill, and Line Width of your labels.
• Font, Font Size, Style and Justification: These controls allow you to specify the font, font size, style
and justification in which your labels are printed. When you first open the Label editor, the default font is
set to Geneva, the font size is set to 9-point, and font style is set to plain.
• File buttons: These buttons provide options for printing, saving, and loading label designs.

Creating a Label Design
This section describes the process of creating a label.
To create a label, follow these steps:
1. If you creating a label with the standard fields (Name, Address, Address 2, City, State, Zip) just drag the Label
field on to the label layout. Resize the field box to fill your label layout.
2. Or, if you have other fields you would like to print, select the field from the list and drag it to the label layout.
label. Position the first field to where you want it.
Add fields to the same line by holding down the Alt (Windows) or Option (Macintosh) button while dragging the
desired field to the label layout.
A “+” between field names in the Label layout indicates that the fields are joined on a single line. When the label is
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printed, it will concatenate the fields, inserting a space between two fields on the same line.
3. When you are ready to place a field on a new line hold the Shift key down while dragging the new field to the label
layout. Drag the new field on top of the previous field. The label editor will automatically create a new line for this
field.
4. As you add fields and lines to the label design, the program automatically adjusts the position of the lines on the
label so that the entire label text is centered. The figure below shows a completed mailing label.

How the Label Editor Handles Blank Fields
Some records in your database may not contain entries for every field. When printing labels, the Label editor handles
blank fields intelligently. Instead of leaving gaps where the data should be, the Label editor concatenates the data.
If a field in a line contains no data for a particular record, 4th Dimension concatenates the remaining fields in the line
without leaving a blank line.
The program automatically centers the text of the label inside the layout.
Clearing Fields
If you make a mistake, you can remove one or more fields from the label.
Click on the field you wish to clear, click the delete button on the keyboard.
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Specifying the Label Layout

To specify the layout of the label paper you are using, follow these steps:
1. Select the proper paper orientation and label order.
2. Enter the number of labels in each row of your label sheet in the Labels Across box and the number of labels in
each column in the Labels Down box.
The Label Preview area adjusts to display the appearance of the labels on a printed page.
3. Click the appropriate radio button indicating whether you want to adjust label size or page size.
4. If desired, click the unit of measurement to use for adjusting sizes and margins.
5. Enter values to reflect the margins on your label paper or your label size.
• Automatic Resizing: The size of the individual labels in the label page preview will adjust to
accommodate the margins of the paper. For example, if you increase the size of your margins to two
inches, top and bottom, the size of the individual labels will shrink to maintain the same number of
labels that you specified earlier.
Margin boxes: These boxes are used to specify the size of the label paper margins. Margin settings also affect the
dimensions of the label. You can specify margins in pixels, centimeters, or inches. After you have entered the margins
of your label paper, you may need to make some additional adjustments so that the label text is centered in the labels.
You can use both positive and negative numbers in these fields.
Because some printers use portions of the margin to hold the label sheet in place, the printer may not take the full
margins into account when printing your labels. In this case, you may need to adjust the margin settings so the label
text is properly centered in the label. Since the printer uses part of the margins, the printer begins measuring the
margins from a point that is not precisely at the edge of the label paper. When the labels are printed, the label text
may appear skewed to the right or to the bottom of the label paper.
To compensate for this lost margin space, you can use negative numbers in some of the margin boxes. When placed in
the Right margin box, negative numbers pull the label text to the right. When entered in the Top margin box,
negative numbers pull the label text toward the top of the page.
As a rule, using a negative number in a margin box moves the label text toward the margin you are setting.
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Saving and Loading Label Designs
Book’em! lets you save each label design as a file that you can open from the Label editor. By saving label designs, you
can maintain a library of labels that you can use according to your needs.
To save a label design, click the Save button. The program displays a Create File dialog box where you can enter a
filename for the label design.
Type a filename and click the Save button. You can load the label design whenever the Label editor is active.
To load a label design, click the Load button.
The program displays an Open File dialog box where you can select the name of a label design file. Choose a filename
and click the Open button.
The current label design is replaced with the design you selected.

Printing Labels
After you have completed the label design, you can preview or print the labels. You may want to print first on regular
paper so that you can check the placement of text before you use the more expensive label paper.
Click the Print button.
If you are printing to a normal printer, the Printer dialog box appears for the printer you selected as the default. If you
select the Print Preview check box before clicking the OK button, the labels are previewed to screen.
If you are printing to a Direct ASCII driver, the labels are printed when you click the OK button. You cannot preview
labels being printed to a Direct ASCII driver.
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The Cities Glossary
A small tool to speed data entry, handy if you have not purchased the Zip Center option. When entering a city in any
record, type the 2-character reference for the city. If the reference is in the database the city and state will be entered
automatically. If it is not found you’ll have the chance to enter it.

Choose ‘Edit Cities’ from the File menu at the Home screen to open the list of cities. From here you may add, delete,
and change the codes, and print out a list for reference.

Zip Center
Available as an optional module is Zip Center, an external database of postal codes, telephone area codes, latitude &
longitude, etc. If the module is installed, entering simply the zip code in any city field will automatically enter the city,
state, and area codes. It really speeds up data entry.
Additionally, clicking on the field header of the city field will show a list of the cities nearest to the entered zip code.
Contact Outside Technology for purchase and pricing information.

168 Book’em! User Guide

7. Reporting
Your database knows everything about the current state of your business. This chapter tells you how to get
that information out of the computer and onto paper.
Besides the numerous built-in reports, Book’em! provides tools for you to create your own custom reports.
The 4th Dimension Report Editor makes it easy to design formatted lists from any of the major tables, as
well as building complex reports complete with subtotals and break areas.
Also, information may be exported to disk so you may use it in other programs. See “Exporting” on page
143.

Built-in Reports
You may access many built-in reports by opening the File menu from the Home screen and selecting Print.
Print-from the File Menu

By clicking on the corresponding radio button, you may select a specific report to print. When you select a report
more options for clarifying the parameters of the report will appear. Most (like the above example) ask you to specify
a date range.

Reporting
Events Listing
The Event Listing report gives you many details of all events within the specified date range.

The report is sorted by date and grouped by month. It shows the location, standard cost, availability, and assigned
employees for all events falling in the designated date range.
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Daily Receipts
For a quick report showing incoming monies by day for a given date range select Daily Receipts from the Print Menu.

Rosters
Print multiple rosters from multiple events for a selected date range from here. This is a good shortcut for printing
rosters in bulk. This eliminates the need to print rosters by opening each individual event. For more information on
Rosters see page 70.
Income Summary
A straight-forward report detailing Money In, Money Out and Gift Certificates for the selected date range.
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Income By Event
Select a date range to receive a print-out of all income listed by event for the specified period.

User Day Report
See "User Days" on page 107 for details on this report.
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Staff Assignments
This report will print for each staff person that is scheduled to work an event within the specified date range.

Listed on this report are: the event name/date/location/times/size limit, the number of reservations sold at the time of
printing, and the staff person’s assigned job.

People Lists
See "List Screens" on page 35 for a full description of features within List screens.
You may print a list from the Customers, Staff, or Contacts tables by choosing Print from the File menu at the Table’s
List Screen. The records printed will be the records in selection, sorted as they are on screen. Use the search and sort
tools (See “Searching by Keyword” on page 80., "List Screens" on page 78, "Search Tools" on page 91, "Searching" on
page 137, and "Sorting" on page 141) to build and sort your selection.
If you need to print a list that includes more than the standard list data, create your selection as above and use one of
the Built-In Reports (page 169) or the Report Editor (described later in this chapter).
Full-page reports for individual records in any of the people records may be printed by choosing Print from the File
menu in the record’s main entry screen.

Payment Status
A Payment Status Report may be printed for any event. Open the event’s record and select Payment Status from the
Report menu.

The report lists all people with reservations on the event, the cost, payments, and any balance due.

Flight Manifest
Book’em! will print a flight manifest that lists all people reserved for an event. From the event’s record, choose Flight
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Manifest from the Report menu. You may build the header using the pre-built format

or click the Custom button and build a header from scratch.
The Manifest differs from other customer lists from the events table in that people are not grouped by party, they are
all sorted alphabetically and numbered sequentially.

The Manifest resizes itself based on the number of reservations and can handle up to 300 people on a single page.

Bus Manifest
The Bus Manifest is discussed in detail on page 117.

Room List
When Room Lists is chosen from the Report menu at an event, Book’em! will print a rooming list for the hotel that
has people from the current event assigned to it. The report is two-tiered, keeping parties together even when
assigned to different rooms, sorted by party Kingpins.
Roster notes are printed for each person that notes have been entered for. Bed preferences are listed for anyone with a
bed preference indicated.
Book’em! counts the reservations per room, notes it as a single, double, triple, or quad; and subtotals each room type.
First you will have the opportunity to change the print header.

174 Book’em! User Guide

Built-in Reports
Then the Rooming List will print.

Destination Roster

You can find this roster in the Report menu from the event window. It is designed to show the arrival and departure
times, list all customers with date of birth, smoker and handicapped status and a registration code if you and the
destination use one. You can enter date of birth, smoker and handicapped status and more in the detail tab of the
Customer record, for more information see page 83.

To Do List
The To Do List is discussed in detail on page 61.
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The Report Editor
One of the most important tasks in data management is the generation of reports. You can use the Quick
Report editor to create a wide variety of columnar reports.
Using the Quick Report editor you can do the following:
•
•
•
•

Produce lists of records
Create break areas
Compute summary calculations
Use fonts and styles in the report

The Quick Report editor is accessed from the List Screen of all the major tables and produces reports from the
current selection of records. Select the records you want included, either through a search or by direct selection, and
choose Report from the File menu.
4th Dimension's Quick Report editor lets you create and print tabular reports.
When you create a quick report, you can specify the following:
•
•
•
•
•
•
•
•

Columns that display fields or formulas, either from the current table or from related tables
Sort levels and order
Break levels
Summary calculations
Text for labels
Formats for numeric and Boolean data
Font, font size, style, and justification for labels, summary calculations, and data
Page headers and footers

A quick report can be printed:
• On the standard printer selected in the Chooser
• To disk
• To a graph

These options are discussed in the section “Selecting an Output Device” later in this chapter.

Creating a New Quick Report
To create quick report design, open the List Screen of the table you want to report on and choose Report Editor from
the Report menu.
4th Dimension displays the Quick Report editor. If an existing design is displayed, choose New from the File menu
to begin a new Quick Report design.
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The Quick Report Editor
This section describes the main features of the Quick Report editor.
The Quick Report editor is shown below.

Summary Calculation

Field List
Sort Direction Arrow
Sort List
Column Values

Column Header
Row Label Bars

Hidden Row

Cell

Quick Report Layout
Column Indicator

The Quick Report editor contains the following:
• Field list: This list displays fields in the current table. You can view the names of fields in other tables
by clicking the cycle arrows at the top of this list.
• Sort direction arrows: These indicate whether the selected sort item will sort in ascending or
descending order.
• Sort list: This list displays the sort order assigned to the report and whether each sort level is
ascending or descending. It also contains the <<Add Sort>> marker that you use to set sort levels. If
your report will contain summary calculations from groups of records, you must sort the current
selection on one or more fields.
• Column header: The column header displays the names of fields or formulas added to the report.
• Row label bar: This bar shows the different areas of the report: the Header, Detail, Break, and Total
rows.
• Quick Report layout: You use this area to design the report by dragging fields, adjusting column
widths, and adding or deleting breaks.
• Summary calculations: You use these check boxes to place summary calculations in the Break and
Total areas of the report.
• Column indicators: These lines indicate the boundaries between columns of the report.
• Column Values: You use these items to request that the Quick Report editor: 1. Sorts the report
according to the Sort List. 2. Tell the Quick Report editor to repeat the values in a Break column. If you
do not select the Repeated Values check box, the Break value is displayed only once. 3. Have the editor
compute the width of a column individually. The check box does not refer to the entire report. If the Auto
Column Width check box is not checked, you can modify column widths by dragging column indicators.
• Hidden Row: The grey background shading indicates that the
• Right margin marker (not shown): This marker indicates the right margin of the report. The right
margin marker is meaningful only when no columns have the Auto Column Width check box selected.
On a 9-inch monitor, you must scroll the quick report layout to the right to view the Right margin marker.
• Header row: This row contains information that appears in the printed report above the records. The
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Quick Report editor automatically places field names in the Header row, but you can modify its contents.
• Detail row: This row prints information from individual records and will be repeated in the printed
report for each break.
• Break and totals rows: These rows display summary calculations and any associated labeling. The
Break row displays summary calculations for each subgroup in the report and the Totals row displays
summary calculations obtained from all records in the current selection.
• Cells: Cells are the intersection of a row and a column.
• Scroll bars: You use the scroll bars to view parts of the quick report design that extend beyond the
area of the quick report layout.

The figure below shows a completed quick report design and the relationship between the specifications in the design
and the printed output.

Selecting Rows, Columns, and Cells
When designing a quick report, you need to select rows, columns, and cells in the quick report layout. A cell is the
intersection of a row and a column.
To select a row, click on the Header, Detail, Break, or Total markers on the row label bar to the left of the Quick
Report layout. Or, click in a row to the right of all columns in the Quick Report layout.
To select a column, click above the Header row of a column.
To select a cell, click the cell.

Adding and Modifying Text
You can add or modify text in the quick report layout. Text can be used to label parts of the report. For example, if you
requested summary calculations, you can add text to other cells in the Break and Total rows to label the summary
calculations.
You can do the following:
•
•
•
•

Edit the text that 4th Dimension automatically adds to the Header row of the report
Insert text in empty cells of the Break and Totals rows
Insert the value of a Break field in the Break rows
Specify the font, font size, justification, and style for any text that appears in the report

Adding Text
To add text, click twice on an empty cell in the quick report layout. A text insertion point appears in the cell.
If you are entering a label for a summary calculation, select a cell in the same row as the cell containing the calculation
icons. You cannot enter text into the same cell that contains summary calculations.
Type the text in the cell.
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Modifying Text
To modify text, drag across the text in the cell you want to modify. 4th Dimension highlights the selected text. Type
the new text in the cell.

Specifying Font, Font Size, Justification, and Style
While designing your quick report, you can specify different fonts, font sizes, justification, and styles. You can apply
these specifications to rows, columns, or cells in the quick report. These specifications can be applied to text, data, and
summary calculations.
If you assign specifications to the Detail row of the report, you will not see the results until you preview or print the
report. To specify a font, font size, style, or justification:, select the column, row, or cell where you want to apply the
font.
Choose a font from the Font menu or choose a font size, style, or justification from the Style menu.
The changes are applied to any text, data, or summary calculations that appear in the selected area.

Adding Columns to the Report
You create columns by dragging field names from the Field Selection box to the quick report layout. Use the cycle
arrows in the Field Selection box to display field names from related tables in the database. You can add fields from
related tables, provided the relationship is automatic.
To add a column, drag the name of a field to the right of existing columns in the Quick Report layout and release the
mouse button.
4th Dimension creates a column for the field and places the field name in both the column header and the cell in the
Header row.
The figure below shows the Date field being added as a column to a quick report layout from the Transactions table.

By default, 4th Dimension prints the field names as column heads at the top of each page in the quick report.
If you use a subfield in a quick report design, the report will list all values of the subfield for each parent record. You
cannot sort on a subfield.
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Inserting Columns
You can insert a column in a quick report.
To insert a column, select a column and choose Insert Column from the Edit menu.
A blank column is inserted to the left of the column you selected. You can then assign a field to the empty column by
dragging a field name to it. Or, you can choose to assign a formula to the column. For information on assigning a
formula to a column, see the section “Adding Formulas to the Report” later in this chapter.
Deleting Columns
As you specify fields for your quick report, you may want to remove some columns so that they can be placed
elsewhere. You also might want to delete the column from the report.
To delete a column, select the column you want to delete. Choose Delete Column from the Edit menu.
Replacing Columns
You can replace a column in the quick report by dragging another field over it. You can also replace a field with a
formula.
To replace a column, drag a field from the Field Selection box to the column you want to replace. Or, select the
column you want to replace and choose Edit a Formula from the Other menu.
When you print the quick report, 4th Dimension prints the results of the formula for each record that appears in the
Detail row.
See the section “Adding Formulas to the Report” for information on adding a formula to a quick report.
Sizing Columns
By default, the Quick Report editor sizes columns automatically. It sizes each column based on the maximum length
of data displayed in the column and any labels typed into the column. The Quick Report editor sizes columns at the
time the report is printed.
To view the widths of each column, preview the report to the screen. See “Printing the Quick Report” later in this
chapter for more information about previewing the report.
Because the Auto Column Width check box will change the width of a column based on the maximum width of data
in the records being printed, selecting different records can change the size of the columns.
You can resize a column manually after turning off the Auto Column Width check box. When a column is set
manually, text in the column wraps within the specified area.
To resize a column manually, select the column you want to resize. Deselect the Auto Column Width check box.
Move the pointer over the column indicator in the column header to change the pointer into a column width cursor.
Drag the column indicator to the left or right to size the column.
Adding Formulas to a Quick Report
If you are familiar with the 4th Dimension language, you can add a formula to a column in a quick report. For
example, you can add a formula that computes employees' monthly salaries from an Annual Salary field.
To add a formula, follow these steps:
1. Insert an empty column or click an existing column and choose Edit a Formula from the Other menu.
4th Dimension displays the Formula editor where you can build a formula. If you selected an existing column, the
formula you create will replace the previous contents of the column.
2. Build the formula by clicking fields, keywords, and commands and entering values.
To save the formula as a file that you can recall and use in another column or in another report, click the Save button
and enter a filename in the Create File dialog box.
3. Click the OK button to assign the formula to the column.
4th Dimension adds a new label to the column that identifies it as a formula. You can relabel the column by typing a
label into the header cell for that column.
Formulas are labeled C1 through Cn. The labels are the names of variables that contain the column's value. You can
use these variables in other formulas.
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Sorting Records and Creating Breaks
An important feature of the Quick Report editor is the ability to sort the records in your report. You sort records for
two reasons:
• To view records in a particular order
• To create groups of records and Break areas in the report for the purpose of reporting summary
calculations for groups.

See the section “Setting Break Levels” later in this chapter for information on summary calculations.
Specifying a Sort Order
After you specify the columns for your report, you can specify a sort order. You set a sort order by dragging the
appropriate field from the field list into the Sort window in the order that you want to sort on.
To specify the sort order, follow these steps:
1. Drag the Field Name from the field from the field list into the Sort window in the order you wish to sort on.

When you release the mouse button, 4th Dimension displays the name of the field in the Sort box. To the right of the
name is a small arrow, indicating an ascending sort order. By default, all sorts are performed in ascending sort order.
2. If necessary, click the sort direction arrow to sort the column in descending order.
3. If desired, drag additional fields to specify secondary sort levels.
You can specify ascending or descending sort order for any additional fields or formulas you specify.If the field is not
already in the quick report design, 4th Dimension adds it as the last field in the design.
When you specify multiple sort levels, 4th Dimension sorts the records on the first field in the Sort field list, then on
other fields in the order that they appear in the list. For example, if you specify the Last Name field as the primary sort
field and Zip as the secondary sort field, your design will list Customers by their zip code and then by last name.
Deleting a Field or Formula from the Sort Order
You can delete the last field or formula from the Sort list. To specify a new sort order, you can delete all the fields from
the Sort list and build a new list.
To delete Sort fields, simply highlight the item in the Sort window and type Delete on your keyboard.
Setting Break Levels
In a quick report, you set break levels to separate or “break” records into groups according to values in one or more
sort fields. At each break level a Break area is printed. You can print summary calculations in the Break area. The
summary calculations - sum, average, minimum, maximum, and count - are computed for each group of records.
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Break levels are determined by the sort levels and Break rows. For example, if you tell 4th Dimension to sort records
by Sales Region and create a Break row, 4th Dimension inserts a break between each group of records that have the
same sales region.
After you add a Break row to the quick report, you can request summary calculations on each break. For example, you
can insert a summary calculation in a Break row to display subtotals for sales from each state in a marketing region.
Refer to “Adding Summary Calculations” later in this chapter for more information on adding summary calculations
to Break and Total rows.
1. Choose Add Break from the Edit menu.
OR
Hold down the mouse button on the Total row label in the Row label bar and choose the Duplicate Break menu
command.
4th Dimension adds a Break row. The figure shows a Break row in a quick report design.
2. If desired, add additional Break rows by repeating step 1.There should be at least as many sort levels as break levels.
4th Dimension adds a sequential number to each new break label in the row label bar, for example, Break1, Break2,
Break3, and so forth.
After you have created a Break row, you can also display the Quick Report popup menu by holding down the mouse
button on the new Break row label.
Using the Values of Break Fields in Labels
You can improve the appearance and comprehensibility of your reports by labeling each Break row using the value of
the Break field.
To request that the value of a Break field be printed in a label placed in the Break area, use the number sign (#) in the
label. For example, the text “Total salaries for department #” will insert the department name (in this case, the value of
the Department field) in place of the number sign when the report is printed.
The number sign does not need to be placed in the same column as the Break field. It will display the value of the
Break field in any cell in the Break row.
.
4. If desired, add additional Break rows by selecting an existing Break row and choosing Insert Break from the Edit
menu.
There should be at least as many sort levels as break levels.
4th Dimension adds a sequential number to each new break label in the row label bar, for example, B1, B2, B3, and so
forth.
Using the Values of Break Fields in Labels
You can improve the appearance and comprehensibility of your reports by labeling each Break row using the value of
the Break field.
To request that the value of a Break field be printed in a label placed in the Break area, use the number sign (#), in the
label. For example, the text “Total salaries for department #” will insert the department name (in this case, the value of
the Department field) in place of the number sign when the report is printed.
The number sign does not need to be placed in the same column as the Break field. It will display the value of the
Break field in any cell in the Break row.

Adding Summary Calculations
Summary calculations on the contents of fields and formulas can be added to each Break row and the to the Totals
row.
The check boxes at the bottom of the Quick Report editor identify the summary calculation options available for
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quick reports. The following types of summary calculations are available.
•
•
•
•
•

Sum: This totals the values in the report or break.
Minimum: This displays the lowest value in the report or break.
Maximum: This displays the highest value in the report or break.
Average: This calculates the average of the values in the report or break.
Count: This calculates the number of records in the report or break.

When you place a summary calculation in the totals row, the calculation is done for all records in the report. If you
place the summary calculation in a Break row, the calculation is done for the records in the break.
To add a summary calculation, select a cell - the intersection between a row and a column - in a Break row or in the
Totals row where you want to insert the summary calculation.
The Sum, Minimum, Maximum, and Average calculations work only on a numeric field or formula.
Click as many summary calculation check boxes as you like.
4th Dimension displays a calculation icon in the selected cell for each type of summary calculation you request. The
figure below shows a sum icon in the break (subtotals) row.

If you add more than one summary calculation to a cell, 4th Dimension stacks the calculation icons on top of each
other.
Displaying Repeated Values for Break Columns
In a report with breaks, the columns which are used to group records so that summary calculations can be done are
called Break columns. In the report shown above, the Event field is a Break column since the records in the report are
grouped by events.
When a report like this is printed, the values for the Break column are printed only once per break. In other words, an
event name is printed only for the first record in the group and is not repeated until the event changes.
In some cases you may want to repeat the values for the Break columns so that they appear for every record in the
Break area.
To display repeated values for fields in Break columns, select the Break column by clicking above the Header row for
that column. The column appears highlighted. Select the Repeated Values check box.
When the report is printed, values for the Break column are repeated for every record.
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Setting Display Formats
You can specify display formats for columns that contain numeric, alphanumeric, or Boolean data. For example, if you
are displaying salaries in a column, you can add a numeric format to the Detail cell for the Salary field. If your report
includes Alpha fields such as a telephone number of Social Security number, you can use an Alpha format. If your
report displays values for a Boolean field such as male/female or yes/no, you can use a Boolean format.
This section explains how to use numeric, Alpha, and Boolean formats. It then shows you how to specify a format for
a particular field by entering the format into the quick report layout.
Numeric Formats
The following format places a dollar sign to the left of the number and allows up to 6 digits:
$###,###
This format can display dollar amounts up to $999,999.
Up to three formats are allowed in a cell for numeric fields: positive, negative, and zero. Use a semicolon to separate
the formats. Thus,
$###,###;($###,###)
will format negative numbers in parentheses. Since the Transactions table never contains negative numbers (a separate
field is used for Money Out and Money In), a format of $###,###; with two semicolons, will print blank for fields
which contain zero or null value.
Alpha Formats
You can use an Alpha format for fields that contain string information. For example, social security number or
telephone number fields can be formatted with an Alpha format.
The following format would be used to format Social Security numbers:
###-##-####
And
(###) ###-####
would be used for telephone numbers.
Boolean Formats
You can specify a Boolean format for fields that contain information which can be evaluated as either TRUE or
FALSE or as only one of two values (e.g. male or female).
If you do not apply a display format to a Boolean field, the values are displayed as either TRUE or FALSE.
To substitute different values for TRUE and FALSE, separate the two values you want to display with a semicolon.
Entering the Display Format
To set a display format for a numeric, Alpha, or Boolean field, hold down the Control Key (Mac) or right click
(Windows) in the Detail cell for a numeric, Alpha, or Boolean column. Select the display format that you want to
use.
If you have also requested summary calculations for that column, the format specified in the Detail cell will
automatically be applied to the summary calculations. The count is always displayed as an integer without formatting
symbols such as the dollar sign.
Different formats can be applied to different columns in the report.

Hiding Rows and Columns
4th Dimension lets you hide rows or columns when printing a quick report. Hiding rows is useful, for example, when
you want the report to include only summary calculations. Hide the Detail row if you want to display only the
summary calculations that appear in the Totals and Break rows. You can also use this feature to hide a Break row or
the Totals row.
You can hide a column, for example, if you need to use the column as a sort column, but do not want the report to
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display the column.
To hide a row, select the row you want to hide and choose Hide Line from the Edit menu.
4th Dimension displays the row or column in gray to remind you that the row will not appear when you print or
preview the quick report.

To hide a row or column, select the row or column you want to hide and choose Hide from the Edit menu - right
click (Windows)/Control+click (Mac)on the row or column. 4th Dimension displays the row or column in gray to
remind you that it will not appear in the printed report.

Adding Page Headers and Footers
Before printing a quick report, you can add page headers and footers. You specify page headers and footers in the
Headers & Footers dialog box from the File menu. Use this dialog box to do the following:
•
•
•
•

Add page header and footer text
Specify the size of the page header and footer areas
Specify fonts, font sizes, and font styles for page header and footer text
Insert codes that add page numbers and the date and time to your reports

Page headers can only be specified when printing to a normal or Direct ASCII printer. See the section, “Selecting an
Output Device” later in this chapter for more information about alternate output devices.
To add page headers and footers, follow these steps:
1. Choose Headers & Footer from the File menu.
If you have chosen Normal printer in the Print To dialog box, the standard Page Setup dialog box is displayed. If you
have chosen Direct ASCII, the Printer Setup dialog box is displayed.
2. Select any printing options you want and click OK.
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The Quick Report Format dialog box is displayed.

3. Enter the header and footer height in the Header size and Footer size areas.
When you first enter the dialog box, the header and footer are set to 25 pixels each. You can change values for the
header and footer height and can use the measurement scale radio buttons to enter values in inches or centimeters.
As you enter the header and footer height, the dotted lines on the page preview area change to indicate the size of the
header and footer as they will appear on the printed report.
4. Select one of the Header and Footer entry areas and type the header or footer text.
Specifying Font, Font Size, Justification, and Style
You can specify different fonts, font sizes, justification, and styles for page headers and footers.
To apply these specifications, select the header or footer area in the Page Preview area.
Apply the fonts, font sizes, justification, and styles by choosing items from the Font and Style menus.
Adding Page Numbers, Time, and Date
Add page numbers and the time and date to the quick report by clicking the small arrow next to each Header or
Footer areas.
You can embed these codes within header or footer text. For example, you can enter the label “Page #P” in a Header
or Footer area.

Loading and Saving a Quick Report Design
You can save a quick report design as a file that you can open from the Quick Report editor. The quick report design
includes all your specifications, but not the data. By saving report designs, you can maintain a library of quick reports
that you can use depending on your needs.
NOTE: If you do not save your design, it is displayed the next time you open the Quick Report editor in that work
session.
Saving a Quick Report Design
To save a quick report design, choose Save from the File menu. 4th Dimension displays a Create File dialog box.
Enter a filename for the quick report and click the Save button. 4th Dimension saves the report as a file that you can
open with the Quick Report editor. You can save the file to any hard disk available to you.
If you are saving a report previously saved or loaded, it replaces the old report.
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Loading a Quick Report Design
When the Quick Report editor is open, you can load a saved design and use it to print a new report. The same quick
report design can be used repeatedly to print different selections of records.
To load a report design, choose Open from the File menu. 4th Dimension displays an Open File dialog box
displaying a list of available quick report designs. Select a file from the list and click the Open button. 4th Dimension
replaces the current report design with the design you opened.

Selecting an Output Device
4th Dimension supports four types of output devices for quick reports.
To select a print option, choose Print To from the File Menu.
4th Dimension displays the Print To dialog box.

The following options are available in the Print To dialog box:
• Normal printer: This option uses the printer you have chosen in the Chooser.
• Disk File: This option sends your quick report to a disk file that you can open and modify with other
applications, including text editors and spreadsheets. Using this option essentially exports the records in
the quick report to another file.
• Graph: This option directs the report to the Graph editor. The Graph editor uses the data in the Break
row. You can use this option to graph the contents of the report using any of eight graph types. Your
graph can then be printed using the Graph editor.

When you choose the Graph option in the Print To dialog box, your report is graphed rather than presented in
tabular form. The Graph editor uses only the summary calculations and labels in the Break row. It uses the left-most
non-numeric column for the x-axis.
To use this feature, your report should do the following:
• Include from one to five numeric fields of formulas. These columns will be assigned to the y-axis in the
graph.
• Use one type of summary calculation per numeric field.

For example, if you want to graph average salary be department, you should create a quick report with two columns,
Department Name and Salary. Use the Average summary calculation for Salary.

Printing a Quick Report
After you have completed your report design, you can print the quick report. If you are printing to a normal printer,
you can preview the report before printing it.
Normal Printer
To print to a normal printer, choose Print from the File menu or click the Print button. Click the OK button.
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Disk File
To print to a disk file, choose the Print button from the File menu.
4th Dimension displays the standard Create File dialog box and asks you to enter a filename. Enter a filename and
click the OK button.
4th Dimension displays a dialog box that keeps you informed of the progress of the operation. Click the Stop Printing
button to cancel the operation.
After the report is printed to a file, 4th Dimension returns you to the Quick Report editor. Remember to change the
output device if you want to resume sending a quick report to a standard printer.
Print to Graph
To print to a graph, choose Print from the File menu.
4th Dimension graphs your data as a column graph. For more information on printing to the Graph editor, refer to
“Select an Output Device” earlier in this chapter.
You can use the Graph editor to select another graph type and to print or preview the graphed data. For more
information about the options available in the Graph editor, see page 189.
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The Graph editor is used to design and print a wide variety of standard business graphs. Using the Graph editor, you
can plot your data without having to export the data to a graphics package.
You can print your graphs or copy them to the Clipboard and paste them into another application.
The Graph editor can produce the following types of graphs:
• Column graphs: This type represents values as columns.
• Proportional column graphs: This type represents values as stacked columns.
• Stacked column graphs: This type represents values as stacked columns.
• Line graphs: This type represents values as points and connects the points with a line.
• Area graphs: This type represents values as the shaded area below a line.
• Scatter graphs: This type displays values as points on an x-y grid.
• Pie charts: This type displays data in a circular chart where each value is represented by a slice of a
pie.
• Picture graphs: This type represents each value with a picture. You can specify the picture to be used.

You can modify the graph's scale and change the pattern and color of each element of the graph.
The Graph editor produces two-dimensional graphs. The horizontal axis is referred to as the x-axis and vertical axis
referred to as the y-axis. A graph is created by assigning a field to the x-axis and one or more numeric fields to the yaxis.
The field assigned to the x-axis can be alphanumeric, numeric, date, or time. 4th Dimension automatically groups
like x-axis values. For example, in an Employees database you can assign the Department field to the x-axis. 4th
Dimension would automatically sum all the values of each y-axis field for each department. This feature is referred to
as grouping on the x-axis and can be disabled when necessary. When the Group on x-axis check box is deselected,
each record is treated as a separate group.
Up to 100 groups can be plotted on the x-axis. There is no limit to the number of records that can be graphed.
In all graph types, the fields assigned to the y-axis must be numeric. Up to five fields can be assigned to the y-axis. For
example, if you are graphing data in personnel records, the x-axis field could be Department and y-axis fields could be
Salary, Expenditures, and so forth.
Data for a graph can be generated from a quick report. When you use this option, you use the Quick Report editor to
do preliminary data processing prior to graphing data. If you direct a quick report to the Graph editor, the columns in
the quick report are treated as fields in the Graph editor. For more information on designing a quick report for the
Graph editor, see “Selecting an Output Device” in Chapter 7.

Creating a Graph
The Graph editor graphs the records in the current selection. Before graphing data, select the records you want to
graph. Methods of selecting records are discussed in Chapter 3.
To create a graph, follow these steps:
1. Choose Print to Graph from the File Menu within the Report Editor.
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4th Dimension displays the Graph editor in default columnar layout.

Choose Chart Type from the Chart Menu to select different layouts.

For pie charts, the x-axis field is used to label slices of the pie.
If you want the graph to display values from low to high or from high to low on the x-axis, sort the current selection
by the x-axis field before displaying the Graph editor or use the proportional x-axis option. For information on the
proportional x-axis option, see the section “Viewing the Graph” later in this chapter.
4th Dimension displays the field names in the y-axis listing. For all graph types except pie charts, you can assign up to
five numeric fields to the y-axis. The figure below shows the graph editor after fields have been assigned to the x- and
y-axes.
Viewing the Graph
You can change graph types, assign colors or patterns to elements of the graph, add pictures, and choose scaling
options.
When you display a graph, 4th Dimension replaces the current menu bar with the Graph editor menus: File, Edit,

190 Book’em! User Guide

Graphing
Chart, Object, Database. To change graph types, choose another graph type from the Graph Type menu.

If you switch to a pie chart from a type of graph that displays more than one y-axis field, 4th Dimension graphs only
the first field assigned to the y-axis.
Changing the Color or Pattern of an Element
Each element in a graph that is represented in the legend can be assigned a pattern and color. The color option is
available only on monitors that support gray scale or color. All options are available for column, proportional column,
stacked column, area and pie graphs. The line and scatter plot graphs use foreground color only.
To change the color or pattern of an element in the graph, right/control click on the item in the graph that
corresponds to the element to be assigned a pattern or color.
Go to the Object Menu and select the new pattern or color you wish to assign.
Select a pattern from the scrollable list of patterns and colors from the Foreground and Background color palettes.
Click the Select button.
If you have a color or gray-scale monitor, you can select foreground and background colors or gray scales.
Colors and patterns set for one graph type affect all graph types. These specifications are saved with the database.

Printing a Graph
After you are satisfied with your graph design, you can print it. The procedure for printing a graph is the same as the
procedure for printing quick reports or labels.
While the graph is displayed, choose Print from the File menu.
The standard Print Quality dialog box for your selected printer is displayed. Select the Preview on Screen check box if
you want to preview the graph before printing. Choose any desired options and click the OK button.
If you select the Preview on Screen check box, you can print the report when you preview it by clicking the Print
button.

Copying a Graph
You can copy a graph to the Clipboard and paste it into another document. When the graph is displayed, choose
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Reporting
Copy from the Edit menu. The graph has been copied to the Clipboard.
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Backups

8. Maintenance

Backups
After you have used Book’em! for a while, the data file may be the single most important thing your
business has. Except for you, of course. If the computer breaks or is stolen you can buy another. But think of
how difficult it would be to get back up to speed if all of the data were lost!
The Program regularly saves changes to disk (that’s what that little blue picture that pops up in the lower
left of your screen indicates) so a power failure or computer crash will cause minimal entry time lost.
But the program’s data file, which contains all of your business records, can, like any computer file, get
corrupted or damaged. Although 4D Tools, discussed later in this chapter, can often recover a datafile,
regular backups are necessary insurance. See page 26 for a discussion of the data file.
Also consider that your data file is continually changing as you create and delete records. Archived data
files provide a snapshot of your business at the time they were saved and can be of value as a reference
source.
Windows Note: It is important for Windows users to make two changes to the way folders and files are
viewed on their computers. With any folder open, select View from the menu and select Folder Options.
On the General Tab click Custom and then the Settings button, select Open Each folder in its own
window, then click OK. Now click on the View Tab, open the Hidden Files folder and select Show All
Files. Now make sure that “Hide file extensions for known file types” is NOT selected. Apply your changes
and then close this window, you are ready to go!
A Time and a Place
It is recommended that data file backups be saved to removable media such as zip disks or a writable CD-R disk.
The frequency with which you should backup is determined by how much you use the Program. Always backup after
significant data entry and before significant deletions. A program of regularly scheduled backups, like the following
example, ensures recovery after a disaster.
Make a backup (see the next section) at the end of each day of substantial entry. KEEP ONLY ONE DATA FILE ON
YOUR HARDRIVE- THE ONE BEING USED! If there was any confusion over which copy was last used, data may
be lost.
Macintosh Client/Server:
1. Make sure that all Clients are logged off of the server, quit 4D Server.
2. Open the Book’em!/4D Server folder within the hard drive.
3. Click on the Book’em!.data file and select Duplicate from the File menu.
4. Rename “Book’em!.data copy” to today’s date + “.data” i.e. “10.30.00.data”.
5. Move this new file to your zip or CD-R disk.
6. You are done!
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Macintosh Single User:
1. Quit Book’em!
2. Open the Book’em! folder in the hard drive.
3. Follow steps #3-6 above.
Windows Client/Server
1.Make sure that all Clients are logged off of the server, quit 4D Server.
2. Open the Book’em! Server Folder in My Computer.
3. Right-click on the Book’em!.4DD file and choose Copy.
4. Paste the file into your zip disk or write it to a recordable CD-R.
5. Rename the file “todaysdate.4DD”, use periods to format the date. I.e. “11.1.00”
6. You are done!
Windows Singe User
1. Quit Book’em!
2. Open the Book’em_3 folder in My Computer.
3. Follow steps #3-6 above.
One approach is to use five separate disks, one for each day of the work week. At the end of the week (or more often)
store the last backup permanently in a safe place, such as a safety deposit box, etc. The office could burn down, so
store it off-site.
Reuse the first four disks from the past week for next week’s backups.
Develop a system of backing up appropriate to your work load. If you don’t…

4D Tools
The primary function of 4D Tools is to allow you to analyze and repair a damaged database. Data files
can become damaged when, for instance, there is a power failure while 4th Dimension is writing to disk,
or when the disk containing the database becomes damaged.
4D Tools also offers a Sort File option. Do not ever use the Sort File option!
Starting 4D Tools
Macintosh - Double click on the 4D Tools application icon from the Extras folder, within the Book’em! folder on
your hard drive. Windows - Go to the Start Menu and select Recovery Tools from the Book’em! sub-menu within the
Start Menu. A standard Open File dialog appears. Select the Book’em! application (Mac) or the Book’em!.4DC file
(Windows).

Check & Recover...
Use this item from the Utilities menu to analyze and repair damage in a database. The Check and Recover dialog box
is displayed.
Recover by Tags: This is the only option you should ever need to select. Be sure to make a backup copy before using this
option. 4D Tools uses “tags,” markers stored with each record when it is created, to recover records. When you use this
option, a new data file is created. It is possible that a data file that has been recovered by tags may contain records that
were deleted.
You must have enough free disk space on your harddrive to duplicate your existing data file before performing Recover by Tags.

Compact
Don’t confuse this with Compression.
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4D Tools
4D Tools can be used to compact your data file. A data file can develop unused space (“holes”) when records are
modified and deleted. This should only be necessary after a large number of records have been deleted.
To compact your program:
• Be sure you have enough space on your disk for another copy of the structure and data files. The
process of compacting creates new copies of both files, leaving the originals unchanged.
• Choose Compact from the Utilities menu. A Save File dialog box is displayed.
• Use the default name for the new copy, which is the name of the Program plus a 2.
• Click Save.

This process takes time, from 5 minutes to several hours, based on the size of your data file and the speed of your
computer.
Unfortunately, 4D Tools does not tell you when it is finished. If it looks like it’s stopped, wait a minute or two before
doing anything, it may just be taking a breath.
• When you’re convinced it is finished, quit 4D Tools. If 4D Tools still has your program open you will get
an “Error...database cannot be used” warning if you try to open the program. This warning looks serious,
but all you need to do is quit 4D Tools
• Open the new program, the one with the “2.” Poke around in various areas of the program to see if
everything is okay. If it is, trash the old structure and data files and remove the “2” from the name of the
new ones. Be sure that the new copies are in your Book’em! Folder so they can access the auxiliary
files.

Sort File...
This option should never be used.
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9. Appendix

Keyboard Shortcuts
Many tasks in Book’em! may be done directly from the keyboard, without using the mouse. The most
notable exception is choosing items from lists.
If a button on a layout has a double border it may be executed with the ENTER key, not to be confused with the
RETURN key which on some keyboards may be labelled Enter. On an extended keyboard the ENTER key is usually
on the front far right hand corner. This double-bordered button is usually the Save or Done button and will usually
exit the layout and save changes.
In Windows interface (page 28) you may Tab through to activate buttons as well as fields, you are not able to do this
in Macintosh interface.
Command-period (Macintosh) or Control-period (Windows) is the keyboard equivalent of clicking a Cancel
button. In some cases Escape will also work. It will exit the layout and not save changes. Command/Control-period
or Escape will also stop many lengthy operations from continuing.
Use the TAB key to move forward from field to field. In Windows interface (see Preferences on page 28 to change the
interface) you may Tab to activate buttons as well as fields, you are not able to do this in Macintosh interface.
Use Shift-TAB to back up one field.
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Windows

Macintosh

Action

Control-K

Command-K

Open Calendar

Control-B

Command-B

Open Address Book

Control-L

Command-L

Open Label Spool

Control-H

Command-H

Help

Control-N

Command-N

Add a New Record

Control-X

Command-X

Cut

Control-C

Command-C

Copy

Control-V

Command-V

Paste

Control-F

Command-F

Find Reservation

Control-P

Command-P

Print

Control-W

Command-W

Hide the front-most window

Control-Q

Command-Q

Quit Book’em!

Keyboard Shortcuts
From List Screens
Command/Control-N ... Add New Records
Command/Control-A ... Select All
Command/Control-G ... Show All
Command/Control-S ... Search Editor
Command/Control-T ... Sort Editor
Command/Control-Y ... Apply Keyword
Command/Control-M ... Apply Mailing (Customers only)
Command/Control-F ... Find Reservation
Command/Control-P ... Print

From Kingpin’s record while taking a reservation
Command/Control-E ... Set Pays For equal to number in party, mark Paid in Full with check as pay type
Command/Control-R ... Assign hotel (if Kingpin) or New Room (if Stooge)

From Event WIndow
Command/Control-I...Get Info. on the reservation you have selected, will indicate who took the reservation & more.

Many other keyboard equivalents are available in various parts of the program. They are shown in the menus.
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Troubleshooting
Use this reference to answer some common questions.
Problem: When I try to open the Program, the computer tells me there’s not enough memory.
Solution: If you get this message specifically, click Cancel and save any work in the other open programs, quit them,
and reopen Book’em!.
Explanation: The number of programs your computer can run simultaneously is limited by how much RAM it has.

Problem: The button I want to use is dimmed and won’t work
Solution: Select the item you want the button to act on.
Explanation: Select the object to be operated on before identifying the operation itself. In other words, if no event is selected
Book’em! has no way of knowing which event to apply the New Reservation button to.
- or Solution: If it’s the Save button that’s dimmed, see if you’ve forgotten to enter a necessary piece of information.
Explanation: Some information is so important that a record cannot be saved without it. A payment cannot be saved without
an amount. A letter can’t be saved without a name.

Problem: The field I want to enter data into can’t be entered.
Solution: In some cases, Command/control-clicking the field title will allow entry.
Explanation: Some fields are made non-enterable because it was anticipated that direct entry would seldom, if ever, be needed.
Making them non-enterable takes them out of the TAB order, which speeds data entry and reduces the risk of user
error. These fields will open with the Command/control-click method. In other cases, fields are used to display
information which has been gathered from other parts of the Program or which are essential to the Program’s record
keeping mechanism. These fields cannot be modified.

Problem: The cursor looks like

and nothing works.

Solution: Hold down the Command/control key and type a period.
Explanation: A new window was about to open, but before it did you accidentally clicked within the last window. This sent
the new window behind the last one. Command/control-period will bring the current window to the front.
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Problem: The screen is frozen. Nothing works.
Solution: Macintosh -Try holding down the Command and Option keys and press the Escape key. Click the Force
Quit button. Windows -Try holding down the Control and Alt. keys and press the Delete key. If this works,
immediately save all work from any other open programs and restart the computer. If it doesn’t work you’ll
have to manually turn the computer off and restart.
Explanation: The computer has crashed. It happens.

Problem: After a crash the above message appears when I try to open the Program.
Solution: See “4D Tools” on page 194. A recovery may be possible.
Explanation: If you don’t have a recent backup, this will teach you. 4D Tools can often recover damaged Data Files, although
the process can be arduous. On occasion the Data File can be damaged beyond repair. Please back up your Data File
after every day of substantial data entry.

Problem: Print layouts don’t look right; some of the fonts are bit mapped.
Solution: Make sure you have Helvetica and Times properly installed. Macintosh users will find an “Emergency
Fonts” folder located in the ‘Extras” folder. These are the versions that Book’em! was created with, and
should produce good looking print documents for you.
Explanation: Book’em! uses these fonts in every print layout because nearly everybody has them. They’re included with current
System Software versions and are built into the memory of most printers. Please refer to your Mac’s System
documentation for instructions on correct font installation. Different versions of System Software have different
ways of installing and accessing fonts.

Problem: Print layouts are boring; I have better fonts than these!
Solution: Contact KAT Business Systems for custom print layouts using your fonts.

Problem: My logo doesn’t print right.
Solution: Contact your desktop publisher for your logo in EPS format with a PICT header. Keep borders tight.
Roughly square dimensions work best. Another good strategy is to save the logo at 72 dpi, but with very
large (8 inches or so) dimensions. Book’em! will scale it properly for printing.
- or Solution: Contact Outside Technology for custom print layouts.
Explanation: For a nominal fee we can digitize your logo so your print layouts look terrific. For an exorbitant fee we can
design one for you.
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Capitalization

Index

changing case in label spool

161

Carryover Address
checkbox while taking reservation
setting in preferences 29

A

CC 52, 66
CC validation 135
Change Location Name 110
Change User Name 24
Chart

Action Set 94
Add a new map 110
Add Event 44
Add Master button 40
Add to base selection 35
Add to Party Button 54
Add Until Cancel
setting preference

different layouts

32

edit list 168
print list 168
using the glossary

32

Address 2 84
Address Book 99
open at startup

Administrative Functions 25
ALL CAPS 161
Appointments 81

hiding open windows

composing 73
example 76
setting default 41,

Archiving a datafile 193
Area code, default 52
Arrow Buttons 79
Assigning a Sponsor 105
Assigning and Creating Itineraries 113
Auto-Apply Discounts

printing lists

173

Cost
adjusting for individual events 48
if a recurring event definition is modified 43
modifying for an individual reservation 53
setting default cost of recurring event 41, 104
setting for one-time events 49
shown on event listing report 170

Automatic Capitalization 31
AutoSort 28

B

Create New Event 44, 158
Create Weekly Schedules 15,
Credit

Base Selection 66
Base selection 35
Bed preference 174
Beep on Alert 28
Book’em! Files 26
Bus number 117
Button is dimmed 198

customer accounts
how to issue 61

46

125

Credit Accounts List 125
Credit card
formatting 52
reservations list indicator 66
reservations list marker 52

C
Calendar 157

cancellation charge 61
cancellation policy 52

104

Contacts 98

128

Cancellations 60

38

Companies 97
Confirmation Letters

from the calendar 158
set recurring 160

appointments 158
creating new events 158
making reservations & launching events
navigating 158
open at startup 29
printing 160

52

Clarify List Selection 28
Close All Event Windows 108
Close box

29

see also discounts

190

Check Status 30
Checkbox Roster 71
Cities 168

Adding records
turning continuous entry on and off

54

158

Critical entries 27
Current Pay Period 130
Current selection 35, 91,

138, 176
140

search in selection checkbox

Cursor is weird 198
Customer Accounts 125
credit account window
edit credit entry 126

125

Customer Detail Window 91
Customer Notes
large view

90
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Customers 84–94

DIF

adding 83
adding while taking a reservation
change table reference 28
contact history 90
database, general info 83
handling postal returns 93
list screen 91
list screen popup menus 91
making appointments 81
printing lists 173
rapid entry technique 83
record screen 83
search by event 92
search by keyword 93

exporting 144
importing 146

51

different 190
Difficulty Thermometer 41,
Directions 109
Directions to locations
entering
see also Locations

104

110
73

printing on confirmations

Discount Editor 128
Discounts
discount editor
adding and modifying discounts

entering in invoice

53

128

Duplicate records

D

avoiding entry of 83
find duplicates utility

Damaged datafile
4d tools 194
hope you have a recent backup!

E

193

Datafile
backing up 193
compressing an archive 193
explanation 26
opening book’em! (windows platform)

13

Date fields 34
Date Print Formats 28
Datestamp Button 79
dBASE files
exporting 144
importing 146

DBF

strongly discouraged 27, 79
the ’inactive’ alternative for the staff file
using the find duplicate utility 152
using the postal return handler 93

104

118

Estimator 87
Estimator Defaults 89
Event Leaders

Default Area Code 32
Default Confirmation Letter 73
Default Payment Type 30
Delete All Old ‘To Do” Records 108
Delete Old Empty Events 108
Deleting an Event 106
Deletions

add to event 101
button within edit event window
change table reference 28
code 100
contacts 100
create new 100
database, general info 100
reference number 100

Edit Event Window 104
Edit Invoice Message 123
Edit Manifest Header 116
Edit Pay Slips 131
Edit Return 23
Edit Return Address 23
Editing Money In & Out Fields 135
Efficient Memory Mode 28
Emphasize Contact Management 158
Emphasize Events and Reservations 157
Equipment & Sale Items 53, 118
create new record
record 118

exporting 144
importing 146

Departure location 41, 42, 109
Destination Roster 102, 175
Destinations 100

150–152

change table reference

96

28

Event Letters 73
Event List 103
Event Name 104
Event Notes 63
Event Quote Estimator 87
Events 40–76
assigning staff 64
daily receipts 171
income report 172
income summary 171
list of events report 170
modifying 48
new reservations button 50
notes 63
one-time 49
payment status report 173
quote estimator 87
rescheduling 49
rosters, print in-bulk 171
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scheduling 15, 44, 46
search customers by 92
see also recurring event masters, reservations, cost,
locations 53
setting window position 38
special 49
user day report 172

Events Listing Report 170
Exporting 143

H
Handicapped 91
Hold 50
Home Screen 14
Home Screen Picture 29
Hotel checkbox 100
Hotels
assigning to existing reservations
assigning while reserving 54
rooming list 174

delimiters 144, 147
file formats 144

Hotels & Room Assignments 54

F

I

4D Server 32

Ignore Empty Events 130
Importing 144–148

11
4D Tools 194–195
compact 194
recover by tags 194
installation

adding a note 146
applying a keyword 146
delimiters 146, 147
file formats 146
preview editor 145, 147

Field can’t be modified 198
Fields
definition

33

Income By Event 172
Income Summary 171
Installation 10

Files
definition

55

33

Financial
daily receipts

171

4d server

Find Duplicate Records
within customer record

85

Find Duplicates Utility 150–152
Find Reservation 67
using for rapid customer entry

adding equipment or sale items
dates 122
general info 121
preferences 30
set footer 30

83

Fixed Length record format
exporting 144
importing 146

Fonts
printing problems 199
specifying in quick reports

179

11

Interests 91
Interruption occurred 199
Invoice 20, 121

119

Item Sales 21
Items Needed 120
Items Needed Report 120

Footer Popups
introduction

78

K

Formats
credit card numbers 52
file formats for exporting 144
file formats for importing 146
in quick reports 184
phone numbers 52

Keyboard Shortcuts 196–197
Keywords 79–81
applying 80
applying during import 146
creating new 79
search customers by 93
searching by 80
searching contacts at the address book

G
Get Info 66
Graph
different layouts

Kingpins 54,

190

Graphs 189–192
color & pattern 191
creating new 189
from quick reports 187
printing 191
types available 189

99

106

L
Label Editor 163–167
creating a design 164
opening 163
printing 167
saving to and loading from disk files

167
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Label Spool 161–162
autospool new reservations 30
from the print event window 73
permanent and temporary entries 161
printing 162
sending records from list screens 36

Memory Efficient Mode 39
Minimize Record Locking 28
Money
see specific chapter
reservation hold

Label Writer Driver
setup

29

Networking 11, 32
New Invoice 86
New Record 32
New Record, creating 77
New Reservation

detail window 122
within an invoice 122

List Screen 78
List Screens 35

80

within the invoice

directions 109
entering 42
modifying 48
modifying for one-time events
tax districts 110

setting defaults 30
using the find duplicate utility 152
using the postal return handler 93

49

Locations Database 109
Locked records 39
Log-In 14
Logo

Not Currently Offered 41, 104
Not Currently Offered Checkbox 49
Notes
applying to imported records
datestamp button 79
for events 63
for reservations 63
in people file records 84
payment 58, 60
reservations 174

199

M

Number in party 54

Mail List Only 78, 150
Mail Merge 153–156

O
open at startup

93

macintosh settings 11
minimum required 9
with 4d server 12

P
Passwords 24
administration

26

Past Due Invoices 124
Payment By 135
Payment Date 135
Payment Window

Manifest 173
Map
Master Events 14
Medical 91
Memory 9, 198

29

Opening the Preview Editor 146
Overbooking 56
Overnight Stay 100, 101

Mailing List see Customers, Mail Merge, Mailings,
Postal Return Handler, No Mail
Mailings 86–90

entering 42, 110
printing on confirmations

146

One-Time Events 49

creating a new letter 154
effect of salutation on 84
event confirmations 73
printing 156
salutation pop-up 52
save as... 156

handling returns
search by 92

53

New Reservations Button 50
No Mail 85

Locations

formatting 23
printing problems

50

N

Letters see Mail Merge
Line Items

apply keyword command
customers 91
search tools 91

79

Multi-user

73

122
53, 58, 59
from invoices 21
others in party 54
partial 21
status report 173
within invoice

Payments 21,

while confirming a reservation

53

Payroll 130
custom employee numbers

95
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payroll date, setting during assignment
preferences setup 31
records 133
report 132
setting rates 64

PD 66
Pelican 14
Performance issues 38
PFD Size 91
Pick-Up Points 91, 112
assign to customers
creating new 112
itinerary 113

QuickSearch 77
Quote Estimator 87

apply payment 124
recalc button 124
view within event window

31

65

Record navigation buttons 79
Record Screens 33
moving through the selection with arrow buttons 79

Records
definition

33

Recurring Event Masters 14,

Prepare Quote 87
Print with Grid 116
Printing

40–43

modifying 43
new location 33
not currently offered 41
not currently offered checkbox 49
setting date range preference 29

Recurring Events
listed at the home screen 45
not currently offered 104

Refunds
how to issue

61

Registrations button 91
Remove from base selection 35
Rentals
see equipment & sale items

21

Replace base selection 36
Report Editor 176–188

23

Printing Labels
from the event print window
one-a-time labels 85

Q

Reach 91
Real Datafile 23
Rebuild Files from Work Events 130
Rebuild from Data button 149
Receivables 58, 124

115

bus manifest 116
calendar 160
checkbox rosters 71
confirmations 73
event letters 73
flight manifest 173
from the label editor 167
graphs 191
labels 162
list of cities in glossary 168
logo formats 23
people lists 173
personalized letters 156
quick reports 187
rooming list 174
rosters 70
setting up headers & footers

Processes 38
Prospects 83

R

Postal Return Handler 93–94
PR 66
Preferences
auto capitalization
data entry 31
general 28
invoice 30
payroll 31
reservations 29
setting 27

64

73

adding and modifying text 178
adding columns 179
automatic calculations 182
column headers 179
creating a new report 176
deleting columns 180
diagram 177
example 178
fonts 179
hiding rows & columns 184
loading & saving 186
page headers & footers 185
printing 187
setting display formats 184
sizing columns 180
sorts & break levels 181
using various output devices 187

Book’em! User Guide205

Scheduling Events 44

Reports
daily receipts 171
destination roster 175
destination roster 102
event listing 170
flight manifest 173
income by event 172
income summary 171
payment status 173
people lists 173
rooming list 174
rosters, print in-bulk 171
user day 172

create weekly schedules

definition

59

Reservation Finder 138
Reservations 40–76
cancellations 60
confirm 53
default size of party 29
expect others 29
finding 67
get info 66
holding with a credit card
indicators 66
notes 63
placing a hold 50
rescheduling 59
responsible payer 53
taking new 18
viewing info 65–66

52

Retail Sale Items 120
Return 23
Return address
entering

23

Room Assignment 54
Room Assignments & Hotels 54
Rooming List 174
also see hotels

139

saving conditions to disk

140

Searching
comparison operators 138
conjunction operators 139
name+zip code 51
quick search at file access 137
search editor 139
using the list screen popups 91

Second address line 84
Select Bed Type(s)’ Button 56
Select from Library 110
Send Letters see Mail Merge
Send Selection 66
Set Apply List 129
Set Policy Info 30
Set Window Position 38, 106
Show Empties 150
Show Payroll Amount 31
Skill Level Thermometer 85
Smoker 91
Sort Editor 141
Sorting
clients by company name
opening sort 141
sort editor 141

28

Source 84
Special Diet 91
Speeding up data entry 52
Sponsored Events
list from company record

97

Spool Label
from customer screen

86

Staff 95

Roster Notes 63
Rosters
checkbox roster 71
preferences 30
printing 91
printing in bulk 171

Running Payroll 130

adding new records 95
assigning to an event 64
printing lists 173

Staff Profile 96
Stooges 54, 106
SYLK
exporting 144
importing 146

S
Sale Items Vs. Items Needed 120
Sales Tax Totals 136
Salutation Pop-up Menu 52, 84
Save & Cancel 33, 83
Schedule by Calendar 44
Scheduling
schedule by calendar

33

Search Editor 77,

Rescheduling
events 49
reservations

15, 46

Screen is frozen 199
Screens

44

T
Table Reference 28
Tax Checkbox 122
Tax District 30
Telephone 52
phone log

90
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The List Editor 149
Time fields 34
Title Bar Button 106
Title Case 161
To Do List 61
TP 66
Transactions 134
Travel agent 84
Turning preference on/off 28

U
Upcoming Assignments 96
Use Declared Size Limit 105
User Day Report 172
User Days 107
button in event window
report 107

106

User Name
entering

24

V
Verify Button 66

W
Waiting List 56–58
adding to 56
filling from 57

Window System 36–39
calendar 157
performance issues 38
setting event window position

38

Windows menu 28
Word Processor see Mail Merge

Z
Zero-Dollar Items Printed on Invoice 30
Zip Center 168
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